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SPECIAL:	FREE	SHIPPING	on	your	entire	cart	if	you	buy	any	Scubapro	product	>$75.	The	Divesoft	Professional	Flow	Limiter	offers	is	high	off	the	mark	when	it	comes	to	reliable		solutions	for	gas	flow	regulation.	Equipped	with	a	reduction	valve,	the	Professional	Flow	Limiter	conveniently	allows	for	removal	of	gas	from	analysed	cylinders	at	constant
flow,	independent	of	the	tank	pressure.		Designed	also	to	allow	for	easy	sampling	of	gas	from	tanks	with	a	very	low	pressure,	the	Divesoft	Professional	Flow	Limiter	has	your	back	when	you	want	to	analyse	residual	gas	before	blending	a	new	mixture.		The	Divesoft	Professional	Flow	Limiter	offers	you	a	reliable	and	industry	professional	solution	for
setting	low	enough	gas	flow	even	on	those	valves	which	it	seemed	almost	impossible	to	do!		(Don’t	forget	to	order	the	#8009	Connection	hose	so	you	can	get	going	with	your	new	kit	fresh	out	the	box!)		Features:		Professional	solution	for	limiting	gas	flow	Sample	gas	from	low	pressure	tanks		Robust	and	lightweight	DIN	fitting		Constant	flow:	0.2
L/min		Follow	Online	Dive	Gear	&	Diving	Adelaide	JavaScript	seems	to	be	disabled	in	your	browser.	For	the	best	experience	on	our	site,	be	sure	to	turn	on	Javascript	in	your	browser.	Australia	JavaScript	seems	to	be	disabled	in	your	browser.	For	the	best	experience	on	our	site,	be	sure	to	turn	on	Javascript	in	your	browser.	If	you	own	a	Professional
Flow	Limiter	from	this	series,	please	stop	using	it	and	carefully	read	the	message	below.	Divesoft	has	been	made	aware	by	two	clients	of	a	possible	safety	issue	concerning	a	particular	batch	of	Professional	Flow	Limiters.	The	issue	occurs	when	the	unit	is	pressurized	and	can	cause	the	front	cap	to	separate	from	the	body	and	potentially	cause	minor
injuries.	Because	we	prioritize	the	safety	of	our	customers,	we	have	decided	to	recall	this	batch	of	Professional	Flow	Limiter	(product	#8021/	#8023	/	#8065)	that	ranges	from8021-4189	to	8021-43488023-1024	to	8023-10418065-0531for	a	factory	inspection,	repair,	or	replacement.	This	batch	was	produced	in	May	2021	and	entered	the	market	in	the
following	months.What	will	happen	with	my	Flow	Limiter?Your	flow	limiter	will	be	inspected	by	our	service	technicians	as	soon	as	it	arrives	to	our	factory	for	a	quick	turnaround.	The	maintenance	will	be	performed	free	of	charge.	In	case	your	Professional	Flow	Limiter	was	not	affected,	we	will	service	your	flow	limiter	and	send	it	back	to	you	with	a
small	gift.	If	your	Flow	Limiter	was	affected,	we	will	replace	it	with	a	brand-new	Flow	Limiter	and	send	it	back	to	you	with	a	small	gift	as	well.	How	to	proceed	with	your	return?Check	the	serial	number	of	your	Professional	Flow	Limiter	Your	Divesoft	analyzer	needs	a	way	to	get	gas	to	the	cells.	Check	out	these	common	flow	limiters	to	make	your	gas
analysis	easier	and	more	efficient.	No	one	likes	wasting	helium!	Sort	by	Price,	low	to	high	Price,	high	to	low	Alphabetically,	A-Z	Alphabetically,	Z-A	Date,	old	to	new	Date,	new	to	old	Best	Selling	Product	added	to	wishlist	Product	added	to	compare.	iqitcookielaw	-	module,	put	here	your	own	cookie	law	text	Manual	authors:	Willem	Ferguson,	Jacco	van
Koll,	Dirk	Hohndel,	Reinout	Hoornweg,	Linus	Torvalds,	Miika	Turkia,	Amit	Chaudhuri,	Jan	Schubert,	Salvador	Cuñat,	Pedro	Neves,	Stefan	FuchsVersion	5.0,	February	2021Welcome	as	a	user	of	Subsurface,	an	advanced	dive	logging	program	with	extensive	infrastructure	to	describe,	organize,	interpret	and	print	scuba	and	free	dives.	Subsurface
binaries	are	available	for	Windows	PCs	(Win	7	or	later	from	version	4.6	of	Subsurface	onwards),	Intel	based	Macs	(OS/X)	and	many	Linux	distributions.	Subsurface	can	be	built	for	many	more	hardware	platforms	and	software	environments	where	Qt	and	libdivecomputer	are	available.This	manual	explains	how	to	use	the	Subsurface	program.	To	install
the	software,	consult	the	Downloads	page	on	the	Subsurface	web	site.	Please	discuss	issues	with	this	program	by	sending	an	email	to	our	mailing	list	and	report	bugs	at	our	bugtracker.	For	instructions	on	how	to	build	the	software	and	(if	needed)	its	dependencies	please	consult	the	INSTALL	file	included	with	the	source	code.Audience:	Recreational
Scuba	Divers,	Free	Divers,	Tec	Divers,	Professional	DiversWhen	opened	from	within	Subsurface,	this	manual	does	not	have	external	controls	for	paging	or	selecting	previous	pages.	However,	two	facilities	are	provided:The	SEARCH	function	is	activated	by	pressing	control-F	or	command-F	on	the	keyboard.	A	text	box	appears	at	the	bottom	right-hand
of	the	window	(see	image	below).	For	instance,	typing	the	word	"weights"	into	the	search	text	box,	searches	throughout	the	user	manual.	To	the	right	of	the	search	text	box	are	two	arrows	pointing	up	and	down.	These	find	the	previous	and	the	next	occurrence	of	the	search	term.PREVIOUS/NEXT	LINK.	Move	between	links	(underlined	words	that
jump	to	specific	sections	in	the	user	manual)	by	right-clicking	on	the	text	of	the	manual.	This	brings	up	a	context	menu	to	PREVIOUS	links	selected.	(see	image	below).	For	instance	if	a	link	has	been	selected,	then	the	option	to	Go	Back	shows	the	text	at	the	previous	link	selected	(similar	to	the	Previous	Page	button	in	a	browser).	Conversely	the	Go
Forward	option	jumps	to	the	text	seen	before	selecting	the	Go	Back	option.	The	Reload	option	reloads	the	complete	user	manual	into	the	window.The	Subsurface	window	is	usually	divided	into	four	panels	with	a	Main	Menu	(File	Edit	Import	Log	View	Help)	at	the	top	of	the	window	(for	Windows	and	Linux)	or	the	top	of	the	screen	(for	Mac	and	Ubuntu
Unity).	The	four	panels	are:The	Dive	List	on	the	bottom	left,	showing	all	the	dives	in	the	user’s	dive	log.	A	dive	can	be	selected	and	highlighted	on	the	dive	list	by	clicking	on	it.	In	most	situations	the	up/down	keys	can	be	used	to	switch	between	dives.	The	Dive	List	is	an	important	tool	for	manipulating	a	dive	log.The	Dive	Map	on	the	bottom	right,
showing	the	user’s	dive	sites	on	a	world	map	and	centered	on	the	site	of	the	last	dive	selected	in	the	Dive	List.	The	map	scale	can	be	increased	or	decreased.The	Info	on	the	top	left,	giving	more	detailed	information	on	the	dive	selected	in	the	Dive	List,	including	some	statistics	for	the	selected	dive	or	for	all	highlighted	dive(s).The	Dive	Profile	on	the
top	right,	showing	a	graphical	dive	profile	of	the	selected	dive	in	the	Dive	List.	You	can	zoom	into	the	dive	profile	for	a	more	detailed	view.The	dividers	between	panels	can	be	dragged	to	change	the	size	of	any	of	the	panels.	Subsurface	remembers	the	position	of	the	dividers,	so	the	next	time	Subsurface	starts	it	uses	the	positions	of	the	dividers	from
the	last	time	the	program	was	used.If	a	single	dive	is	selected	in	the	Dive	List,	the	dive	location,	detailed	information	and	profile	of	the	selected	dive	are	shown	in	the	respective	panels.	If	several	dives	are	selected,	the	last	highlighted	dive	is	the	selected	dive,	but	summary	data	of	all	highlighted	dives	is	shown	in	the	Summary	tab	of	the	Info	panel
(maximum,	minimum	and	average	depths,	durations,	water	temperatures	and	SAC;	total	time	and	number	of	dives	selected).Decide	which	of	the	four	panels	are	displayed	by	selecting	the	View	option	on	the	main	menu.	This	feature	has	several	choices	of	display:All:	show	all	four	of	the	panels	as	in	the	screenshot	above.Divelist:	Show	only	the	Dive
List.Profile:	Show	only	the	Dive	Profile	of	the	selected	dive.Info:	Show	only	the	Notes	about	the	last	selected	dive	and	statistics	for	all	highlighted	dives.Map:	Show	only	the	world	map,	centered	on	the	last	selected	dive.Like	other	functions	that	can	be	accessed	via	the	Main	Menu,	these	options	can	also	be	triggered	using	keyboard	shortcuts.	The
shortcuts	are	shown	with	an	underline	in	the	main	menu	entries,	with	the	Alt-key	pressed,	or	are	denoted	after	the	menu	item.When	the	program	is	started	for	the	first	time,	it	shows	no	information	at	all,	because	it	does	not	have	any	dive	information	available.	In	the	following	sections,	the	procedures	to	create	a	new	logbook	will	be	explained.Select
File	→	New	Logbook	from	the	main	menu.	All	existing	dive	data	are	cleared	so	new	information	can	be	added.	If	there	are	unsaved	data	in	an	open	logbook,	the	user	is	asked	whether	the	open	logbook	should	be	saved	before	a	new	logbook	is	created.Now	that	a	new	logbook	is	created,	it	is	simple	to	add	dive	data	it.	Subsurface	allows	several	ways	of
adding	dive	data	to	a	logbook.1)	If	the	user	has	a	handwritten	divelog,	a	spreadsheet	or	another	form	of	manually	maintained	divelog,	dive	data	can	be	added	to	the	logbook	using	one	of	these	approaches:2)	If	a	dive	is	recorded	using	a	dive	computer,	the	depth	profile	and	a	large	amount	of	additional	information	can	be	accessed.	These	dives	can	be
imported	from:This	is	usually	the	approach	for	dives	without	a	dive	computer.	The	basic	record	of	information	within	Subsurface	is	a	dive.	The	most	important	information	in	a	simple	dive	logbook	usually	includes	dive	type,	date,	time,	duration,	depth,	the	names	of	your	dive	buddy	and	the	divemaster	or	dive	guide,	and	some	remarks	about	the	dive.
Subsurface	can	store	much	more	information	for	each	dive.	To	add	a	dive	to	a	dive	log,	select	Log	→	Add	Dive	from	the	Main	Menu.	The	program	then	shows	three	panels	on	which	to	enter	information	for	a	dive:	three	tabs	in	the	Info	panel	(Notes,	Equipment	and	Information),	as	well	as	the	Dive	Profile	panel	that	displays	a	graphical	profile	of	each
dive.	These	panels	are	respectively	marked	A,	B,	C	and	D	in	the	figure	below.	Each	of	these	tabs	will	now	be	explained	for	data	entry.Most	actions	when	editing	a	new	dive	can	be	individually	undone,	as	described	in	the	section	on	undoing	edits,	but	changes	in	the	Profile	panel	are	not	yet	included	in	that	in-depth	undo	implementations,	and	therefore
Subsurface	enters	Editing	Mode	when	changes	are	made	in	this	panel.	This	is	indicated	by	the	message	in	the	blue	box	at	the	top	of	the	panels	(see	the	image	below).The	Apply	changes	button	should	be	selected	after	all	the	profile	segments	for	a	dive	has	been	entered.If	this	hand-entered	dive	was	not	in	the	sea	but	at	altitude	away	from	the	sea,	you
may	wish	to	edit	the	altitude	setting	in	the	Information	tab	because	dives	at	altitude	need	special	calculations.In	addition,	the	water	type	of	this	dive	(e.g.	sea	water;	fresh	water)	can	be	entered	in	the	water	type	setting	in	the	Information	tab.	In	order	to	do	this,	enable	editing	of	water	type	in	the	Dive	log	Preferences	(File→Preferences→Dive	log).All
edits	to	a	new	dive,	including	changes	to	the	equipment	after	selecting	the	Apply	changes	button,	are	saved	in	memory	but	NOT	written	to	storage.	If	you	don’t	manually	save	them	before	closing	Subsurface,	the	program	will	ask	again,	this	time	whether	the	complete	dive	log	should	be	saved	to	storage	or	not.The	Dive	Profile	(a	graphical
representation	of	the	depth	of	the	dive	as	a	function	of	time)	is	shown	in	the	panel	on	the	top	right	hand	of	the	Subsurface	window.	When	a	dive	is	manually	added	to	a	logbook,	Subsurface	presents	a	default	dive	profile	that	needs	to	be	modified	to	best	represent	the	dive	described:Modifying	the	dive	profile:	When	the	cursor	is	moved	around	the	dive
profile,	its	position	is	shown	by	two	right-angled	red	lines	as	seen	below.	The	time	and	depth	represented	by	the	cursor	are	indicated	at	the	top	of	the	black	information	box	(@	and	D).	The	units	(metric/imperial)	on	the	axes	are	determined	by	the	Preference	settings.	The	dive	profile	itself	comprises	several	line	segments	demarcated	by	waypoints
(white	dots	on	the	profile,	as	shown	above).	The	default	dive	depth	is	15	m.	If	the	dive	depth	was	20	m	then	you	need	to	drag	the	appropriate	waypoints	downward	to	20	m.	To	add	a	waypoint,	double-click	on	any	line	segment.	To	move	an	additional	waypoint,	drag	it.	Moving	can	also	be	done	by	selecting	the	waypoint	and	using	the	arrow	keys.	To
remove	a	waypoint,	right-click	on	it	and	choose	"Remove	this	point"	from	the	context	menu.	Drag	the	waypoints	to	represent	an	accurate	time	duration	for	the	dive.	Below	is	a	dive	profile	for	a	dive	to	20	m	for	30	min,	followed	by	a	5	minute	safety	stop	at	5	m.Specifying	the	gas	composition:	The	gas	composition	used	is	indicated	along	the	line
segments	of	the	dive	profile.	This	defaults	to	the	first	gas	mixture	specified	in	the	Equipment	tab,	which	was	air	in	the	case	of	the	profile	above.	The	gas	mixtures	of	segments	of	the	dive	profile	can	be	changed	by	right-clicking	on	the	particular	waypoint	and	selecting	the	appropriate	gas	from	the	context	menu.	Changing	the	gas	for	a	waypoint	affects
the	gas	shown	in	the	segment	to	the	right	of	that	waypoint.	Note	that	only	the	gases	defined	in	the	Equipment	tab	appear	in	the	context	menu	(see	image	below).With	the	profile	now	defined,	more	details	must	be	added	to	have	a	fuller	record	of	the	dive.	To	do	this,	the	Notes	and	the	Equipment	tabs	on	the	top	left	hand	of	the	Subsurface	window
should	be	used.	Click	on	this	link	for	instructions	on	how	to	use	these	tabs.The	use	of	dive	computers	allows	the	collection	of	a	large	amount	of	information	about	each	dive,	e.g.	a	detailed	record	of	depth,	duration,	rates	of	ascent/descent	and	of	gas	partial	pressures.	Subsurface	can	capture	this	information,	using	dive	details	from	a	wide	range	of	dive
computers.	The	latest	list	of	supported	dive	computers	can	be	found	at:	Supported	dive	computers.Several	dive	computers	consume	more	power	when	they	are	in	PC-Communication	mode.	This	could	drain	the	dive	computer’s	battery.	We	recommend	the	user	checks	to	be	sure	the	dive	computer	is	charged	when	connected	to	the	USB	port	of	a	PC.
For	example,	several	Suunto	and	Mares	dive	computers	do	not	recharge	through	the	USB	connection.	Users	should	refer	to	the	dive	computer’s	manual	if	they	are	unsure	whether	the	dive	computer	recharges	its	batteries	while	connected	to	the	USB	port.To	import	dive	information	from	a	dive	computer	to	a	computer	with	Subsurface,	the	two	pieces
of	equipment	must	communicate	with	one	another.	This	involves	setting	up	the	communications	port	(or	mount	point)	of	the	computer	with	Subsurface	that	communicates	with	the	dive	computer.	To	set	up	this	communication,	users	need	to	find	the	appropriate	information	to	instruct	Subsurface	where	and	how	to	import	the	dive	information.
Appendix	A	provides	the	technical	information	to	help	the	user	achieve	this	for	different	operating	systems	and	Appendix	B	has	dive	computer	specific	information.After	this,	the	dive	computer	can	be	hooked	up	to	the	user’s	PC	using	these	steps:The	interface	cable	should	be	connected	to	a	free	USB	port	(or	the	Infra-red	or	Bluetooth	connection	set
up	as	described	later	in	this	manual)The	dive	computer	should	be	placed	into	PC	Communication	mode.	(Refer	to	the	manual	of	the	specific	dive	computer)In	Subsurface,	from	the	Main	Menu,	select	Import	→	Import	From	Dive	Computer.	dialog	A	in	the	figure	below	appears:Dive	computers	tend	to	keep	a	certain	number	of	dives	in	memory,	even
though	these	dives	have	already	been	imported	to	Subsurface.	For	that	reason,	if	the	dive	computer	allows	this,	Subsurface	only	imports	dives	that	have	not	been	downloaded	before.	This	makes	the	download	process	faster	on	most	dive	computers	and	also	saves	battery	power	of	the	dive	computer	(at	least	for	those	not	charging	while	connected	via
USB).The	dialog	has	two	drop-down	lists,	Vendor	and	Dive	Computer.	On	the	vendor	drop-down	list	select	the	make	of	the	computer,	e.g.	Suunto,	Oceanic,	Uwatec,	Mares.	On	the	Dive	Computer	drop-down	list,	the	model	name	of	the	dive	computer	must	be	selected,	e.g.	D4	(Suunto),	Veo200	(Oceanic),	or	Puck	(Mares).The	Device	or	Mount	Point	drop-
down	list	contains	the	USB	or	Bluetooth	port	name	that	Subsurface	needs	in	order	to	communicate	with	the	dive	computer.	The	appropriate	port	name	must	be	selected.	Consult	Appendix	A	and	Appendix	B	for	technical	details	on	how	to	find	the	appropriate	port	information	for	a	specific	dive	computer	and,	in	some	cases,	how	to	do	the	correct
settings	to	the	operating	system	of	the	computer	on	which	Subsurface	is	running.	Some	dive	computers	disable	this	drop-down	as	they	use	other	means	to	find	and	connect	to	the	device.	For	some	dive	computers	the	data	entered	here	is	actually	the	mount	point	of	the	USB	storage	device	as	which	the	dive	computer	identifies	itself.Below	the	three
drop	downs	are	up	to	four	shortcut	buttons	that	allow	you	to	easily	switch	between	multiple	dive	computers	that	you	are	frequently	downloading	from.	These	buttons	only	appear	once	you	have	downloaded	from	different	dive	computers.If	all	the	dives	on	the	dive	computer	need	to	be	downloaded,	check	the	checkbox	Force	download	of	all	dives.
Normally,	Subsurface	only	downloads	dives	after	the	date-time	of	the	last	dive	in	the	Dive	List	panel.	If	one	or	more	of	your	dives	in	Subsurface	has	been	accidentally	deleted	or	if	there	are	older	dives	that	still	need	to	be	downloaded	from	the	dive	computer,	this	box	needs	to	be	checked.	Some	dive	computers	(e.g.	Mares	Puck)	do	not	provide	a
contents	list	to	Subsurface	before	the	download	in	order	to	select	only	new	dives.	Consequently,	for	these	dive	computers,	all	dives	are	downloaded	irrespective	of	the	status	of	this	check	box.If	the	checkbox	Always	prefer	downloaded	dives	has	been	checked	and,	during	download,	dives	with	identical	date-times	exist	on	the	dive	computer	and	on	the
Subsurface	Dive	List	panel,	the	dive	in	the	Subsurface	divelog	will	be	overwritten	by	the	dive	record	from	the	computer.The	checkbox	marked	Download	into	new	trip	ensures	that,	after	upload,	the	downloaded	dives	are	grouped	together	as	a	new	trip(s)	in	the	Dive	List.Do	not	check	the	checkboxes	labelled	Save	libdivecomputer	logfile	and	Save
libdivecomputer	dumpfile.	These	are	only	used	as	diagnostic	tools	when	there	are	problems	with	downloads(see	below).Then	select	the	Download	button.	With	communication	established,	you	can	see	how	the	data	are	retrieved	from	the	dive	computer.	Depending	on	the	make	of	the	dive	computer	and/or	number	of	recorded	dives,	this	could	take	some
time.	Be	patient.	The	Download	dialog	shows	a	progress	bar	at	the	bottom	of	the	dialog.	Remember	for	some	dive	computers	progress	information	could	be	inaccurate	since	Subsurface	doesn’t	know	how	much	downloadable	data	there	are	until	the	download	is	complete.	After	the	dives	have	been	downloaded,	they	appear	in	a	tabular	format	on	the
right-hand	side	of	the	dialog	(see	image	B,	above).	Each	dive	comprises	a	row	in	the	table,	showing	the	date,	duration	and	depth.	Next	to	each	dive	is	a	checkbox:	check	all	the	dives	that	need	to	be	transferred	to	the	Dive	List.	In	the	case	of	the	image	above,	the	last	six	dives	are	checked	and	will	be	transferred	to	the	Dive	List.	Then	click	the	OK	button
at	the	bottom	of	the	dialog.	All	the	imported	dives	appear	in	the	Dive	List,	sorted	by	date	and	time.	Disconnect	and	switch	off	the	dive	computer	to	conserve	its	battery	power.If	there	is	a	problem	in	communicating	with	the	dive	computer,	an	error	message	is	shown,	similar	to	this	text:	"Unable	to	open	/dev/ttyUSB0	Mares	(Puck	Pro)".	Refer	to	the	text
in	the	box	below.Bluetooth	is	becoming	a	more	common	way	of	communication	between	dive	computers	and	Subsurface.	Subsurface	provides	a	largely	operating	system	independent	Bluetooth	interface.	An	increasing	number	of	dive	computers	use	Bluetooth	Low	Energy	(BTLE)	as	a	means	of	communication.	However,	BTLE	is	not	a	standardized
protocol,	consequently	adaptations	need	to	be	made	for	communicating	with	each	different	dive	computer	model.	See	the	list	of	supported	dive	computers.	Bluetooth	communication	is	often	more	reliable	if	all	Bluetooth	devices	seen	by	the	Subsurface	computer	are	removed	and	pairing	with	the	Bluetooth	dive	computer	is	performed	from	afresh.	The
Bluetooth	and	BTLE	interfaces	are	under	active	development	with	respect	to	new	dive	computers	that	use	these	mechanisms	of	communication.Setting	up	Subsurface	for	Bluetooth	communication	requires	four	steps:1.Ensure	Bluetooth	is	activated	on	the	host	computer	running	Subsurface.2.Ensure	Subsurface	sees	the	Bluetooth	adapter	on	the	host
computer.3.Ensure	the	Bluetooth-enabled	dive	computer	is	Bluetooth-discoverable	and	in	PC	upload	mode.4.Ensure	Subsurface	is	paired	with	the	Bluetooth-enabled	dive	computer.5.If	more	than	one	Bluetooth	mode	is	available,	select	the	appropriate	mount	point.Select	the	Download	dialog	by	selecting	Import	→	Import	from	dive	computer	from	the
Main	Menu.	After	checking	the	box	labelled	"Choose	Bluetooth	download	mode",	the	dialog	below	appears.Although	the	Subsurface	Bluetooth	interface	is	intended	to	function	without	Bluetooth	pairing	at	the	operating	system	level,	it	is	always	prudent	to	follow	up	initial	Bluetooth	pairing	problems	by	pairing	the	Bluetooth	dive	computer	with	the
Subsurface	computer	using	the	operating	system	services	of	the	desktop	computer.	Delete	all	existing	pairings	and	start	by	scanning	for	Bluetooth	devices	from	an	empty	list	(on	the	desktop)	of	Bluetooth	devices.	Once	Subsurface	has	recognized	the	Bluetooth	dive	computer,	subsequent	divelog	downloads	are	likely	to	be	simple.On	the	Linux	or
MacOS	platforms	the	name	of	the	Subsurface	computer	and	its	Bluetooth	address	are	shown	on	the	right	hand	side.	The	power	state	(on/off)	of	the	Bluetooth	adapter	is	shown	below	the	address	and	can	be	changed	by	checking	the	Turn	on/off	box.	If	the	Bluetooth	address	is	not	shown,	then	Subsurface	does	not	see	the	local	Bluetooth	device.	Ensure
the	Bluetooth	driver	is	installed	correctly	on	the	Subsurface	computer	and	check	if	it	can	be	used	by	other	Bluetooth	utilities	like	bluetoothctl	or	bluemoon.	This	completes	the	first	two	steps	above.	Ensure	the	Bluetooth-enabled	dive	computer	is	in	PC-upload	mode	and	it	is	discoverable	by	other	Bluetooth	devices.	Consult	the	manual	of	the	dive
computer	for	more	information.	Now	the	third	item	in	the	list	above	has	been	finished.	Select	the	Scan	button	towards	the	bottom	left	of	the	dialog	above.	After	searching,	the	dive	computer	should	be	listed	(perhaps	as	one	of	a	number	of	Bluetooth	devices)	in	the	main	list	box	on	the	left-hand	side	of	the	dialog	(see	image	above).	If	this	does	not	work,
select	the	Clear	button,	then	scan	again	for	Bluetooth	devices	using	the	Scan	button.	After	taking	these	actions	Subsurface	should	see	the	dive	computer.	On	the	left	hand	side,	if	the	computer	has	more	than	one	local	Bluetooth	devices	connected,	use	the	list	box	to	indicate	which	one	needs	to	connect	to	Subsurface.	The	label	of	the	discovered	dive
computer	contains	the	name	of	the	device,	its	address	and	its	pairing	status.	For	BTLE	devices	the	address	often	starts	with	"LE".	If	the	device	is	not	paired	and	has	a	red	background	color,	a	context	menu	can	be	opened	by	selecting	the	item	with	a	right-click.	Select	the	Pair	option	and	wait	for	the	task	to	complete.	If	necessary,	consult	the	user
manual	of	the	dive	computer	being	used.	This	accomplishes	steps	4	and	5,	above.After	the	devices	are	paired,	press	the	Save	button	of	the	dialog.	This	closes	the	Bluetooth	dialog.	Now	select	Download	in	the	Download	from	dive	computer	dialog	which	should	still	be	open.	The	downloaded	dives	are	shown	on	the	right-hand	side	of	the	download
dialog.Bluetooth	download	on	Windows	is	much	the	same	as	on	Linux	and	MacOS.	A	log	message	on	the	bottom	left	of	the	Remote	Bluetooth	device	selection	shows	details	about	the	current	status	of	the	Bluetooth	agent	(see	image	above).Currently	Subsurface	works	only	with	local	Bluetooth	adapters	which	use	Microsoft	Bluetooth	Stack.	If	the	local
device	uses	Widcomm,	Stonestreet	One	Bluetopia	Bluetooth	or	BlueSoleil	drivers	it	will	not	work.	However,	Bluetooth	hardware/dongles	from	these	manufacturers	(e.g.	iSonic)	that	support	the	Microsoft	Bluetooth	Stack	do	work.The	Subsurface	support	for	BLTE	dive	computers	on	Windows	is	EXPERIMENTAL	and	only	supported	on	Windows	10.
Please	make	sure	that	you	have	the	latest	version	of	Windows	10.	Version	1803	is	a	minimum	requirement.	Also	make	sure	that	you	have	installed	the	latest	drivers	for	your	motherboard	and/or	BTLE	dongle.IN	CASE	OF	PROBLEMS:	If	the	Bluetooth	adapter	from	the	Subsurface	computer	gets	stuck	and	the	Download	process	fails	repeatedly,	unpair
the	devices	and	then	repeat	the	above	steps.	If	this	is	not	successful,	Appendix	A	contains	information	for	manually	setting	up	and	inspecting	the	Bluetooth	connection	with	Subsurface.It	may	be	necessary	to	distinguish	between	different	dive	computers	used	to	upload	dive	logs	to	Subsurface.	For	instance	if	a	buddy’s	dive	computer	is	the	same	make
and	model	as	your	own	and	dive	logs	are	uploaded	from	both	dive	computers	to	the	same	Subsurface	computer,	then	you	might	like	to	call	one	"Alice’s	Suunto	D4"	and	the	other	"Bob’s	Suunto	D4".	Alternatively,	consider	a	technical	diver	who	dives	with	two	or	more	dive	computers	of	the	same	model,	the	logs	of	both	(or	all)	being	uploaded.	In	this
case	it	might	be	prudent	to	call	one	of	them	"Suunto	D4	(1)"	and	another	"Suunto	D4	(2)".	This	is	easily	done	in	Subsurface.	On	the	Main	Menu,	select	Log	→	Edit	device	names.	A	dialog	box	opens,	showing	the	current	Model,	ID	and	Nickname	of	the	dive	computers	used	for	upload.	Edit	the	Nickname	field	for	the	appropriate	dive	computer.	After
saving	the	Nickname,	the	dive	logs	show	the	nickname	for	that	particular	device	instead	of	the	model	name,	allowing	easy	identification	of	devices.Some	divers	use	more	than	one	dive	computer	at	the	same	time,	e.g.	during	technical	diving.	If	you	import	the	dive	profiles	from	these	different	dive	computers	into	Subsurface,	the	profiles	can	be	viewed
independently.	During	upload	the	data	from	the	dive	computers	are	automatically	merged	into	a	single	dive.	The	different	profiles	are	presented	on	the	Profile	panel	with	the	name	of	each	dive	computer	indicated	at	the	bottom	left	as	well	as	an	indicator	of	the	number	of	dive	computers	uploaded	for	this	dive	(e.g."No.	2	of	2").	The	original	dive	profile
is	shown	by	default	while	profiles	from	additional	dive	computers	are	added	"behind"	that	of	the	first	uploaded	dive	computer.	While	the	dive	is	highlighted	in	the	Dive	List,	switch	between	the	profiles	of	the	different	dive	computers	by	using	the	left/right	arrow	keyboard	keys.	If	profiles	from	more	than	one	dive	computer	exists	for	a	dive,	right-
clicking	on	the	name	of	the	dive	computer	(bottom	left	of	the	profile	panel)	activates	a	context	menu	(image	below)	that	allows	one	to	make	the	selected	dive	computer	the	one	whose	profile	is	shown	by	default:	this	changes	the	order	in	which	the	profiles	are	shown	when	using	the	left-arrow	and	right-arrow	keys.	The	context	menu	also	allows	deleting
any	of	the	dive	computers	or	to	take	the	information	from	a	specific	dive	computer	and	present	that	as	a	separate	dive.The	data	in	the	Notes	panel	are	not	affected	by	the	specific	dive	computer	that	is	selected.With	the	uploaded	dives	in	the	Dive	List,	the	information	from	the	dive	computer	is	not	complete	and	more	details	must	be	added	to	have	a	full
record	of	the	dives.	To	do	this,	the	Notes,	Equipment	and	Information	tabs	on	the	top	left	hand	of	the	Subsurface	window	should	be	used.	These	three	tabs	represent	a	increase	in	the	amount	of	information	stored	for	a	dive.The	Notes	tab	holds	basic	information	about	the	dive,	the	date	and	time,	locality,	buddy,	divemaster	and	some	dive	notes.	This	is
about	the	minimum	amount	of	information	required	for	a	coherent	dive	log.If	one	wishes,	one	can	expand	the	dive	information	by	using	the	Equipment	tab	to	record	information	about	the	equipment	used:	cylinders	and	their	start	and	end	pressures,	dive	suit	used	and	weight	system	used.Expanding	the	dive	information	even	more,	the	Information	tab
is	used	to	record	environmental	information	such	as	water	type	(usually	fresh	water	or	salt	water),	temperatures,	surface	conditions	and	conditions	during	the	dive,	e.g.	visibility	and	current.	For	dives	downloaded	from	a	dive	computer,	water	type	and	water	temperature	are	automatically	provided	in	the	Information	tab.	Some	dive	computers	also
provide	air	temperature	and	altitude.The	procedure	below	is	virtually	identical	for	hand-entered	dives	and	for	dives	downloaded	from	a	dive	computer.The	date	and	time	of	the	dive	are	shown	as	obtained	from	the	dive	computer.	In	some	cases,	provide	the	date	and	time	of	the	dive,	for	example	when	entering	a	dive	by	hand	or	when	a	dive	computer
doesn’t	provide	this	information.	If	you	click	on	the	Notes	tab,	the	following	fields	are	visible	(left	hand	image,	below):The	right	hand	image,	above,	shows	a	Notes	tab	filled	with	dive	information.	The	Date	and	Time	fields	reflect	the	date	and	time	of	the	dive.	By	clicking	the	date,	a	calendar	is	displayed	for	selecting	the	correct	date.	Press	ESC	to	close
the	calendar.	The	time	values	(hour	and	minutes)	can	also	be	edited	directly	by	clicking	on	each	of	them	in	the	text	box	and	by	over-typing	the	information	displayed.Dive	locations	are	managed	as	a	separate	part	of	the	dive	log	(See	the	section	entitled	Manipulating	Dive	Site	Information).	The	dive	information	in	the	Notes	and	Equipment	tabs	can
therefore	NOT	be	edited	at	the	same	time	as	the	dive	site	information.	Save	all	the	other	dive	information	(e.g.	divemaster,	buddy,	protective	gear,	notes	about	the	dive)	by	selecting	Apply	changes	on	the	Notes	tab	BEFORE	editing	the	dive	site	information.	Then	supply	a	dive	site	name	in	the	textbox	labelled	Location	on	the	Notes	tab.Using	existing
dive	locations:	Type	in	the	name	of	the	dive	site,	e.g.	"Tihany,	Lake	Balaton,	Hungary".	If	several	dives	are	made	at	the	same	location,	the	site	information	for	the	first	dive	is	re-used.	Therefore,	if	a	dive	site	has	been	used	before,	the	name	of	that	site	(and	sometimes	the	names	of	similar	sites)	appears	below	the	dive	site	text	box	(image	below).
Double-click	on	the	appropriate	dive	site	name	with	associated	coordinates	and	that	site	will	be	associated	with	the	dive	being	entered.Entering	a	new	dive	location:	On	the	other	hand,	having	dived	at	a	new	dive	site,	a	new	record	needs	to	be	created	that	could	be	used	for	the	new	and	for	later	dives	at	this	new	site.	Type	the	name	of	the	new	dive	site
into	the	text	box	(image	A	below).Double-click	on	the	blue	bar	below	the	new	dive	location	name.	The	blue	bar	disappears	(image	B	above)	and	the	globe	icon	on	the	right-hand	of	the	location	name	text	box	turns	blue.	In	the	Dive	Map	part	of	the	Subsurface	window,	a	world	map	appears	(image	C	above).	Click	on	the	blue	globe	icon	to	the	right	of	the
dive	site	name	in	the	Notes	panel	(image	B	above).	This	opens	a	window	for	entering	the	details	of	the	new	dive	location	(image	A	below).	The	globe	icon	changes	to	indicate	that	the	location	data	are	being	edited.	The	only	important	data	here	are	the	geographic	coordinates	of	the	dive	location.New	dive	locations	can	be	recorded	in	one	of	four	ways:
(1):	Enter	coordinates	by	hand	if	they	are	known,	using	one	of	four	formats	with	latitude	followed	by	longitude:ISO	6709	Annex	D	format	e.g.	30°13'28.9"N	30°49'1.5"E	or,	alternatively,	30d13'28.9"N	30d49'1.5"E	Degrees	and	decimal	minutes,	e.g.	N30°	13.49760'	,	E30°	49.30788'	Degrees	minutes	seconds,	e.g.	N30°	13'	29.8"	,	E30°	49'	1.5"	Decimal
degrees,	e.g.	30.22496	,	30.821798Southern	hemisphere	latitudes	are	given	with	a	S,	e.g.	S30°,	or	with	a	negative	value,	e.g.	-30.22496.	Similarly	western	longitudes	are	given	with	a	W,	e.g.	W07°,	or	with	a	negative	value,	e.g.	-7.34323.	Some	keyboards	don’t	have	the	degree	sign	(°).	It	can	be	replaced	by	a	d	like	this:	N30d	W20d	(see	example
above).	Enter	any	other	contextual	information	about	the	dive	site	(Description	and	Notes),	then	select	Apply	Changes	to	save	the	geolocation	for	this	dive	site.	If	the	typed	coordinate	information	does	not	conform	to	one	of	the	above	formats,	the	background	of	the	text	box	turns	RED.	Correct	the	typing	error(s)	and	the	background	of	the	text	box
turns	white	again	as	it	should	be.	Dive	site	information	can	later	be	added	or	edited	by	clicking	the	globe	icon	to	the	right	of	the	dive	site	name	in	the	Notes	tab.GPS	coordinates	of	a	dive	site	are	linked	to	the	location	name	-	so	saving	a	dive	site	with	only	coordinates	and	no	name	causes	problems.	(Subsurface	will	think	all	of	these	dives	have	the	same
location	and	try	to	keep	their	GPS	coordinates	the	same).(2):	Use	the	Dive	Map	to	specify	the	coordinates.	The	Dive	map	now	shows	all	the	existing	dive	locations	in	grey	as	well	as	an	additional	marker	in	red	(image	B	above).	Drag	the	red	marker	to	the	location	of	the	dive	site	being	entered.	The	map	can	be	dragged	and	zoomed	using	the	mouse
wheel.	Position	the	red	marker	by	dragging	it	on	the	map,	zooming	in	on	the	appropriate	part	of	the	map	and	placing	the	marker	at	an	appropriate	position	(image	B	below).	The	coordinates	of	the	dive	location	are	automatically	inserted	into	the	appropriate	text	box	in	the	dive	location	information	window	(image	A	below).	Enter	any	other	contextual
information	about	the	dive	site	(Description	and	Notes),	then	select	Done	to	save	the	geolocation	for	this	dive	site.	The	dive	site	information	can	later	be	edited	by	clicking	the	globe	icon	to	the	right	of	the	dive	site	name	in	the	Notes	tab.Once	the	dive	location	data	have	been	saved,	the	dive	on	the	Dive	List	has	a	globe	icon	immediately	to	the	left	of	the
location	name	of	a	particular	dive.(3):	Dive	coordinates	from	a	mobile	device	with	GPS	using	Subsurface-Mobile.	Most	smartphones	have	an	integrated	GPS,	useful	for	collecting	the	coordinates	of	dive	sites.	The	user	manual	for	Subsurface-mobile	(accessible	from	within	that	app)	contains	detailed	instructions	for	performing	the	collection	of	GPS	data
and	for	managing,	uploading	and	synchronising	the	coordinates	with	a	dive	log.(4):	Import	coordinates	from	GPS	equipment.	Some	divers	prefer	to	take	a	GPS	onto	the	boat	and	record	a	GPS	track	while	diving.	Subsurface	can	extract	the	dive	site	from	this	track	and	store	the	dive	site	coordinates	as	part	of	the	dive	log.	Follow	the	next	steps:Connect
the	GPS	to	your	desktop	computer.	Most	GPS	equipment	have	a	USB	port	for	connecting	to	a	desktop	computer	and	GPS	track	recordings	can	be	opened	from	the	desktop	computer.	Make	sure	you	can	see	the	correct	track	on	the	GPS	as	a	.GPX	file.	Alternatively	copy	the	appropriate	.GPX	file	from	the	GPS	to	a	directory	on	your	desktop	computer.In
the	Dive	List,	select	the	dive	to	be	edited	and	specify	a	name	for	the	dive	site	using	the	Locality	field	in	the	Notes	panel.Open	the	Dive	site	management	panel	by	selecting	the	blue	globe	icon	to	the	right	of	the	Locality	text	box	of	the	Notes	tab.Select	the	button	"Use	GPS	file"	to	the	right	of	the	Coordinates	text	box	(see	image	A	above).	This	opens	a
file	selection	dialog.Select	the	appropriate	.GPX	file	on	the	GPS,	or	alternatively,	the	.GPX	file	that	has	been	copied	from	the	GPS	to	the	desktop	computer.	Subsurface	reads	the	.GPX	file	and	compares	the	dive	time	with	the	times	of	the	GPS	track.	The	result	is	shown	in	the	panel	in	the	image	below.GPS	tracks	are	recorded	in	UTC	time,	that	is	the
time	at	a	longitude	of	zero	degrees,	often	referred	to	as	"Greenwich	time".	In	order	to	obtain	the	local	time	for	the	GPS	track,	it	is	necessary	to	know	the	time	zone	of	the	dive	site.	For	instance,	in	the	above	example	the	time	zone	was	UTC+2,	that	is	2	hours	after	UTC.	Set	the	UTC	time	zone	in	the	appropriate	text	field	shown	in	the	image	below.Even
though	the	.GPX	standard	requires	dive	tracks	in	UTC	time,	most	GPS	devices	can	show	the	local	time.	Make	sure	your	GPS	device	shows	the	same	local	time	as	your	dive	computer.	If	the	times	are	not	identical,	then	specify	a	correction	in	the	bottom	text	box	of	the	panel	illustrated	below.The	colored	icon	to	the	right	of	the	Start	and	end	times	in	the
above	panel	shows	the	degree	of	synchronization	between	dive	computer	and	GPS	device.	A	green	icon	indicates	that	the	GPS	track	coincides	with	the	time	of	the	dive.	A	yellow	icon	indicates	partial	synchronization	while	a	red	icon	indicates	that	the	dive	and	the	GPS	track	are	at	different	times	and	that	coordinates	cannot	be	extracted.	Make	sure
that	the	GPS	date	and	the	dive	date	are	the	same.Finally,	select	the	Save	button	at	the	bottom	right	of	the	panel.	This	updates	the	coordinates	in	the	Dive	site	management	panel	and	moves	the	flag	on	the	map	to	the	locality	corresponding	to	the	coordinates.	Then	close	the	panel.Dive	site	name	lookup:	If	you	typed	coordinates	into	the	appropriate	text
box,	you	can	do	an	automated	name	lookup	based	on	the	coordinates.	This	is	done	when	Subsurface	uses	the	Internet	to	find	the	name	of	the	dive	site	based	on	the	coordinates	that	were	given.	If	a	name	is	found,	it	is	automatically	inserted	into	the	tags	box.	The	list	box	(Titled	Dive	sites	on	same	coordinates")	at	the	bottom	of	the	dive	site	panel
contains	the	names	of	other	dives	sites	used	at	the	current	location.	For	instance	if	the	dive	site	is	"Blue	Hole"	and	there	are	several	sites	named	"Blue	Hole",	all	of	them	are	listed.Enter	any	other	contextual	information	about	the	dive	site	(Description	and	Notes),	then	select	Apply	Changes	to	save	the	geolocation	for	this	dive	site.	The	dive	site
information	can	later	be	edited	by	clicking	the	globe	icon	to	the	right	of	the	dive	site	name	in	the	Notes	tab.Having	entered	information	about	the	dive	site	into	the	Notes	tab,	the	following	additional	information	can	be	typed	in:Divemaster:	The	name	of	the	divemaster	or	dive	guide	should	be	entered	in	this	field	which	offers	auto	selection	based	on
the	list	of	divemasters	in	the	current	logbook.Buddy:	In	this	field,	enter	the	name(s)	of	the	buddy	or	buddies	(separated	with	commas)	who	were	on	the	dive.	Auto	selection	based	on	the	list	of	buddies	in	the	current	logbook	is	offered.Rating:	Provide	a	subjective	overall	rating	of	the	dive	on	a	5-point	scale	by	clicking	the	appropriate	star	on	the	rating
scale.Tags:	Tags	that	describe	the	type	of	dive	done	can	be	entered	here	(separated	by	commas).	Examples	of	common	tags	are	boat,	drift,	training,	cave,	etc.	Subsurface	has	many	built-in	tags.	By	starting	to	type	a	tag,	Subsurface	lists	the	tags	that	correspond	to	the	typing.	For	instance,	by	typing	cav,	the	tags	cave	and	cavern	are	shown	to	choose
from.Notes:	Any	additional	information	for	the	dive	can	be	entered	here.The	Equipment	tab	allows	entering	information	about	the	type	of	cylinder	and	gas	used,	as	well	as	the	weights	used	for	the	dive.	This	is	a	highly	interactive	part	of	Subsurface	and	the	information	on	cylinders	and	gases	(entered	here)	determines	the	behavior	of	the	Dive	profile
(top	right-hand	panel).Cylinders:	The	cylinder	information	is	entered	through	a	dialog	that	looks	like	this:For	hand-entered	dives,	this	information	needs	to	be	typed	in.	For	dive	computers,	Subsurface	often	gets	the	gas	used	from	the	dive	computer	and	automatically	inserts	the	gas	composition(%	oxygen	or	%	helium)	in	the	table.	The	+	button	at	the
top	right	allows	adding	more	cylinders	for	this	dive.	The	dark	dustbin	icon	on	the	left	allows	you	to	delete	information	for	a	cylinder.	Note	that	it	is	not	possible	to	delete	a	cylinder	if	it	is	used	during	the	dive.	A	cylinder	might	be	implicitly	used	in	the	dive,	even	without	a	gas	change	event.	Start	by	selecting	a	cylinder	type	on	the	left-hand	side	of	the
table.	To	select	a	cylinder,	the	Type	box	should	be	clicked.	This	brings	up	a	list	button	that	can	be	used	to	display	a	dropdown	list	of	cylinders:The	drop-down	list	can	then	be	used	to	select	the	cylinder	type	that	was	used	for	this	dive,	or	just	start	typing	in	the	box	which	shows	the	available	options	for	the	entered	characters.	The	Size	of	the	cylinder	as
well	as	its	working	pressure	(Work.press)	will	automatically	be	shown	in	the	dialog.Next,	indicate	the	starting	pressure	and	the	ending	pressure	of	the	specified	gas	during	the	dive.	The	unit	of	pressure	(metric/imperial)	corresponds	to	the	settings	chosen	in	the	Preferences.Finally,	provide	the	gas	mixture	used.	If	air	was	used,	the	value	of	21%	can	be
entered	into	the	oxygen	box	or	this	field	can	be	left	blank.	If	nitrox	or	trimix	were	used,	their	percentages	of	oxygen	and/or	helium	should	be	entered.	Any	inappropriate	fields	should	be	left	empty.	After	typing	the	information	for	the	cylinder,	save	the	data	either	by	pressing	ENTER	on	the	keyboard	or	by	clicking	outside	the	cell	containing	the	cursor.
Information	for	any	additional	cylinders	can	be	added	by	using	the	+	button	at	the	top	right	hand.	Here	is	an	example	of	a	complete	description	for	a	dive	using	two	cylinders	(air	and	EAN50):Suit:	Here	the	type	of	dive	suit	used	can	be	entered.	Auto	selection	of	the	suit	description	is	available.	Some	dry-suit	users	may	choose	to	use	this	field	to	record
what	combination	of	suit	and	thermal	undersuit	was	used.Weights:	Information	about	the	weight	system	used	can	be	entered	using	a	dialog	similar	to	that	of	the	cylinder	information.	If	you	click	the	+	button	on	the	top	right	of	the	weights	dialog,	the	table	looks	like	this:By	clicking	on	the	Type	field,	a	drop-down	list	becomes	accessible	through	a
down-arrow:This	can	be	used	to	select	the	type	of	weight	system	used	during	the	dive.	You	may	start	typing	in	the	box	to	specify	a	different	weighting	mechanism	that	will	be	saved	by	Subsurface.	In	the	Weight	field,	type	in	the	amount	of	weight	used	during	the	dive.	After	specifying	the	weight	system,	save	the	data	by	pressing	ENTER	on	the
keyboard	or	by	clicking	outside	the	cell	with	the	cursor.	It’s	possible	to	enter	information	for	more	than	one	weight	system	by	adding	an	additional	system	using	the	+	button	on	the	top	right	hand.	Weight	systems	can	be	deleted	using	the	dust	bin	icon	on	the	left	hand.	Here	is	an	example	of	information	for	a	dive	with	two	types	of	weights:	integrated
as	well	as	a	weight	belt:The	Information	tab	serves	two	purposes:Allow	divers	to	enter	information	about	the	environment	with	respect	to	a	specific	dive.Show	some	dive	information	that	is	not	displayed	elsewhere.Below	is	an	example	of	an	Information	tab	with	complete	information:For	technical	or	freedivers,	the	Dive	mode	can	be	selected.	Dive
mode:	This	is	a	dropdown	box	allowing	you	to	choose	the	type	of	dive	performed.	The	options	are	OC	(Open	Circuit	SCUBA,	the	default	setting,	for	most	recreational	dives),	Freedive	(dive	without	SCUBA	equipment),	CCR	(Closed-circuit	rebreather)	and	pSCR	(Passive	semi-closed	rebreather).Use	the	Information	tab	to	also	enter	environmental
information	for	a	dive.Air/water	temperatures:	Air	and	water	temperatures	during	the	dive	are	shown	in	text	boxes	to	the	right	of	the	Start	time.	Many	dive	computers	supply	water	temperature	information	and	this	box	may	contain	that.	If	air	temperature	isn’t	provided	by	the	dive	computer,	the	first	temperature	reading	might	be	used	for	the	air
temperature.	Generally	this	is	close	to	the	real	air	temperature.	If	editing	is	required,	only	a	value	is	required,	the	units	of	temperature	will	be	automatically	supplied	by	Subsurface	(following	the	Preferences	Units,	metric	or	imperial	units	will	be	used).The	Water	type/density	field	shows	the	information	reported	by	the	dive	computer.	This	field	is
editable	only	if	it	is	enabled	in	the	Log	Preferences	(File→Preferences→Dive	log).	When	enabled,	for	instance	for	manually-entered	dives	without	dive	computer	information,	select	the	desired	water	type	using	the	dropdown	box.	The	following	water	types	are	available:Fresh	water,	usually	at	inland	dive	sites	or	in	caves.Brackish	water,	water	that
contains	a	little	salt.EN13319,	an	value	defined	in	the	European	CE	standard	for	dive	computers	that	represents	neither	fresh	water	or	sea	water.	This	value	is	available	on	some	dive	computers	and	is	regarded	by	some	as	a	safe	value	for	both	fresh	water	and	sea	water.Salt	water	encountered	in	the	sea.The	topic	of	water	salinity	is	complex	because	it
differs	somewhat	between	different	oceans.	A	warning	icon	is	shown	if	the	water	type	reported	by	the	dive	computer	currently	displayed	is	different	from	the	value	that	is	typed	here.	The	water	density	value	(corresponding	to	salinity)	is	automatically	calculated	from	the	choice	of	water	type.Altitude	If	this	dive	was	away	from	the	sea	and	your	dive
computer	does	not	record	atmospheric	pressure	or	altitude	you	may	wish	to	edit	the	altitude	because	dives	at	altitude	require	special	calculations.	The	text	box	Atm.	pressure/Altitude	allows	this.	If	this	text	box	contains	a	value,	dive	calculations	take	into	account	altitude.	The	dropbox	on	the	right	allows	two	ways	of	expressing	atmospheric	pressure:
mbar	or	m/ft	above	sea	level.	The	altitude	unit	(metric/imperial)	is	taken	from	the	settings	in	the	Units	Preferences	screen.	A	third	option	is	to	use	the	atmospheric	pressure	provided	by	the	dive	computer.	In	order	to	specify	the	pressure/altitude,	first	select	the	appropriate	unit	in	the	dropbox	(in	the	case	of	the	image	on	the	left	these	are	"mbar/m/Use
DC",	then	type	an	appropriate	value	into	the	text	box.	In	the	case	of	m/ft	the	altitude	typed	into	the	text	box	is	automatically	converted	to	the	mean	expected	atmospheric	pressure	(mbar)	at	the	specified	altitude.	In	the	case	of	"Use	DC",	no	value	is	required	in	the	text	box.	Atmospheric	pressure	provided	by	a	dive	computer	does	not	need	any
editing.Recording	of	five	dive	conditions	that	can	be	done	on	a	five	star	rating	scale.	The	convention	is	that	the	most	comfortable	environmental	condition	is	marked	with	five	stars,	while	the	most	unpleasant	condition	only	gets	one	star.	An	environmental	condition	with	no	stars	is	assumed	to	have	no	rating,	e.g.	surface	waves	in	a	cave.Visibility:
Provide	a	qualitative	rating	of	visibility	during	the	dive	on	a	5-point	scale	by	clicking	the	appropriate	star.Current:	Provide	a	qualitative	rating	of	water	current	strength	during	the	dive	on	a	5-point	scale	by	clicking	the	appropriate	star.The	following	three	environmental	parameters	can	be	entered	if	they	are	enabled	in	the	Log	Preferences
(File→Preferences→Dive	log)_:Surface	waves:	Provide	a	qualitative	rating	of	the	size	of	surface	waves	(swell/chop)	when	entering	or	leaving	the	water.Surge:	Provide	a	qualitative	rating	of	water	surge	strength	during	the	dive	on	a	5-point	scale	by	clicking	the	appropriate	star.Chill:	Provide	a	qualitative	rating	of	your	perception	of	how	cold	you	got
during	the	dive.METHOD	1:	After	downloading	dives	from	a	dive	computer,	the	dive	profiles	of	each	is	shown	in	the	Dive	profile	tab,	as	well	as	a	few	items	of	information	in	the	Notes	tab	(e.g.	water	temperature)	and	in	the	Equipment	tab	(e.g.	gas	pressures	and	gas	composition).	Other	fields	remain	empty.	It	may	be	useful	to	simultaneously	edit	some
of	the	fields	in	the	Notes	and	Equipment	tabs.	For	instance,	it’s	possible	that	a	diver	performed	several	dives	during	a	single	day,	using	identical	equipment	at	the	same	dive	site,	or	with	the	same	divemaster	and/or	buddy	or	tags.	Instead	of	completing	the	information	for	each	dive	separately,	select	all	the	dives	for	that	day	in	the	Dive	List	and	insert
the	same	information	in	the	Notes	and	Equipment	fields	that	need	identical	information.	This	is	done	by	editing	the	dive	notes	or	the	equipment	for	any	one	of	the	selected	dives.Simultaneous	editing	only	works	with	fields	that	do	not	already	contain	information.	This	means	if	some	fields	have	been	edited	for	a	particular	dive	among	the	selected	dives,
these	are	not	changed	while	editing	the	dives	simultaneously.	Technically,	the	rule	for	editing	several	dives	simultaneously	is:	if	the	data	field	being	edited	contains	exactly	the	same	information	for	all	the	dives	that	have	been	selected,	the	new,	edited	information	is	substituted	for	all	the	selected	dives.	Otherwise	only	the	edited	dive	is	changed,	even
though	several	dives	have	been	selected	in	the	Dive	List.	This	speeds	up	the	completion	of	the	dive	log	after	several	similar	dives.METHOD	2:There	is	a	different	way	of	achieving	the	same	goal.	Select	a	dive	with	all	the	appropriate	information	typed	into	the	Notes	and	Equipment	tabs.	Then,	from	the	main	menu,	select	Log	→	Copy	dive	components.	A
box	is	presented	with	a	selection	of	check	boxes	for	most	of	the	fields	in	the	Notes	and	Equipment	tabs.	Select	the	fields	to	be	copied	from	the	currently	selected	dive,	then	select	OK.	Now,	in	the	Dive	List,	select	the	dives	into	which	this	information	is	to	be	pasted.	Then,	from	the	main	menu,	select	Log	→	Paste	dive	components.	All	the	selected	dives
now	contain	the	data	initially	selected	in	the	original	source	dive	log.Many	divers	wish	to	annotate	dives	with	text	that	indicate	particular	events,	e.g.	"Saw	dolphins",	or	"Released	surface	buoy".	This	is	easily	done:Right-click	at	the	appropriate	point	on	the	dive	profile.	This	brings	up	the	dive	profile	context	menu.	Select	Add	bookmark.	A	red	flag	is
placed	on	the	dive	profile	at	that	point	(see	A	below).Right-click	on	the	red	flag.	This	brings	up	the	context	menu	(see	B	below).	Select	Edit	name.A	text	box	is	shown.	Type	the	explanatory	text	for	the	bookmark	(see	C	below).	Select	OK.	This	saves	the	text	associated	with	the	bookmark.Hovering	the	mouse	over	the	red	bookmark,	the	appropriate	text
is	shown	at	the	bottom	of	the	information	box	(see	D	below).The	information	entered	in	the	Notes	tab	and	the	Equipment	tab	can	be	saved	by	using	the	two	buttons	on	the	top	right	hand	of	the	Notes	tab.	If	the	Apply	changes	button	is	clicked,	the	dive	data	are	saved	in	the	memory	image	of	the	dive.	If	the	Discard	changes	button	is	clicked,	the	newly
entered	dive	data	are	erased	from	the	computer	memory,	although	the	dive	profile	is	retained.	When	the	user	exits	Subsurface	there	is	a	final	prompt	to	confirm	the	new	data	should	now	be	saved	permanently	on	the	computer	disk.Many	divers	log	their	dives	using	the	proprietary	software	provided	by	the	manufacturers	of	their	dive	computers.
Subsurface	can	import	dive	logs	from	a	range	of	other	dive	log	software.	While	import	from	some	software	is	supported	natively,	others	require	export	of	the	dive	log	to	an	intermediate	format	that	can	then	be	imported	into	Subsurface.	Currently,	Subsurface	supports	importing	CSV	log	files	from	several	sources.	Dive	log	import	from	APD	LogViewer,
XP5,	Sensus	and	Seabear	files	are	preconfigured,	but	because	the	import	is	flexible,	users	can	configure	their	own	imports.	Manually	kept	log	files	(e.g.	a	spreadsheet)	can	also	be	imported	by	configuring	the	CSV	import.	Subsurface	can	also	import	UDDF	and	UDCF	files	used	by	some	dive	log	software	and	some	dive	computers,	like	the	Heinrichs	&
Weikamp	DR5.	Finally,	for	some	dive	log	software	like	Mares	Dive	Organizer	we	currently	recommend	importing	the	logbook	first	into	a	web	service	like	divelogs.de	and	then	import	from	there	with	Subsurface.	Divelogs.de	supports	a	few	additional	logbook	formats	that	Subsurface	currently	cannot	handle.If	the	format	of	other	software	is	supported
natively	on	Subsurface,	select	either	Import	→	Import	log	files	or	File	→	Open	log	file.	Notice	that	the	import	adds	the	imported	data	to	the	current	Dive	list,	and	the	open	style	starts	a	new	dive	list.	Subsurface	supports	the	data	formats	of	many	dive	computers,	including	Suunto,	Shearwater	and	some	CCR	equipment.	When	importing	dives,
Subsurface	tries	to	detect	multiple	records	for	the	same	dive	and	merges	the	information	as	best	as	it	can.	If	there	are	no	time	zone	issues	(or	other	reasons	that	would	cause	the	beginning	time	of	the	dives	to	be	significantly	different)	Subsurface	will	not	create	duplicate	entries.	Below	is	more	specific	information	to	import	data	to
Subsurface.Importing	dives	from	other	software	is	done	through	a	universal	interface	activated	by	selecting	Import	from	the	Main	Menu,	then	clicking	on	Import	Log	Files	to	bring	up	dialog	A,	below.	The	exact	appearance	of	this	dialog	differs	between	operating	systems.Towards	the	bottom	right	is	a	dropdown	selector	with	a	default	label	of	Dive	Log
Files	which	accesses	different	types	of	direct	imports	available,	as	in	dialog	B,	above.	Currently	these	are:XML-formatted	dive	logs	(DivingLog	5.0,	MacDive	and	several	other	dive	log	systems)Cochran	dive	logsUDDF-formatted	dive	logs	(e.g.	Kenozooid)UDCF-formatted	dive	logsPoseidon	MkVI	CCR	logsAPD	Inspiration/Evolution	CCR	logsLiquiVision
logsdivelogs.de	logsOSTC	Tools	logsJDiveLogSuunto	Dive	Manager	(DM3,	DM4,	DM5)Seac	SeacSyncDL7	files	used	by	Diver’s	Alert	network	(DAN)Underwater	technologies	AV1	dive	logsDivesoft	dive	logsPoseidon	MK	VI	eCCR	dive	logsCSV	(text-based	and	spreadsheet-based)	dive	logs,	including	APD	CCR	logsSelecting	the	appropriate	format	from
the	dropdown	list	and	then	the	specific	log	file	in	the	main	window	containing	the	file	list.	Then	select	the	Open	button	near	the	bottom	right.If	the	dive	log	being	imported	is	in	CSV	format,	the	user	is	given	the	opportunity	to	perform	manual	edits	to	the	column	headers	before	it	is	imported	to	Subsurface	(see	image	below).For	more	information	on
configuring	a	CSV	import,	see	Importing	data	in	CSV	format.	In	many	cases	changes	to	the	column	headers	are	not	required	because	they	are	pre-configured	for	the	specific	type	of	import	and	the	CSV	import	screen	can	be	bypassed	by	selecting	the	OK	button.	This	opens	the	imported	dive	log	in	the	Subsurface	Dive	List.Some	other	formats	not
accessible	through	the	Import	dialog	are	also	supported,	as	explained	below.OSTC	Tools	is	a	Microsoft-based	suite	of	dive	download	and	dive	management	tools	for	the	OSTC	family	of	dive	computers.	OSTC	Tools	downloads	dive	data	from	the	dive	computer	and	stores	it	as	a	binary	file	with	file	extension	.dive	.	Subsurface	can	directly	import	these
files	when	using	the	universal	import	dialog.	From	the	dropdown	list	at	the	bottom	right	select	OSTCTools	Files	(.dive	.DIVE).	This	makes	the	OSTC	Tools	dive	logs	visible	in	the	file	list	panel.	Select	one	or	more	dive,	then	click	the	Open	button.	The	OSTC	dives	are	shown	in	the	Dive	List	panel.All	H&W	devices	supported	by	OSTCTools	can	be
imported	to	Subsurface.	This	includes	OSTC,	OSTC	Mk2,	OSTC	2N/2C,	OSTC3,	OSTC	Sport,	and	probably	although	untested,	Frog,	OSTC2	and	OSTC	CR.Please	remember	that	OSTCTools	is	not	true	diving	log	software,	but	rather	a	useful	set	of	tools	for	analysis	and	management	of	OSTC	devices.	Only	raw	dive	computer	data	will	be	imported	to
Subsurface;	the	rest	of	the	data	(buddies,	equipment,	notes,	etc)	need	to	be	completed	manually.Since	Mares	uses	proprietary	Windows	software	not	compatible	with	multi-platform	applications,	these	dive	logs	cannot	be	directly	imported	into	Subsurface.	Mares	dive	logs	need	to	be	imported	using	a	three-step	process,	using	www.divelogs.de	as	a
gateway	to	extract	the	dive	log	information.Export	the	dive	log	data	from	Mares	Dive	Organizer	to	your	desktop,	using	a	.sdf	file	name	extension.	Refer	to	Appendix	C	for	more	information.Data	should	then	be	imported	into	www.divelogs.de.	First,	create	a	user	account	in	www.divelogs.de	and	Log	into	that	web	site,	then	select	Import	Logbook	→	Dive
Organizer	from	the	menu	on	the	left	hand	side.	The	instructions	must	be	carefully	followed	to	transfer	the	dive	information	(in	_.sdf	format)	from	the	Dive	Organizer	database	to	www.divelogs.de.Finally,	import	the	dives	from	divelogs.de	to	Subsurface,	using	the	instructions	below.SmartTrak	stores	the	raw	data	from	a	Uwatec/Scubapro	dive	computer
along	with	a	plethora	of	other	data	manually	added	by	the	user,	ranging	from	dive	points	to	buddies	data	or	DAN	survey	info.	However,	this	is	Microsoft	Windows-based	proprietary	software	by	Uwatec	(today	Scubapro)	using	Microsoft	Access	databases,	preventing	the	integration	the	importer	into	the	Subsurface	core	application.A	stand	alone	tool
for	Linux	has	been	developed	to	import	the	.slg	files	generated	by	SmartTrak	to	Subsurface’s	.xml	format.	It	can	be	downloaded	from	the	usual	Subsurface	repository,	as	a	Windows	installer	or	a	Linux	AppImage.	The	application	is	not	currently	supported	on	Mac.It	can	also	be	built	for	Linux	systems.	Two	dependencies	need	to	be	met	in	your	system
before	building:	glib2.0	and	mdbtools	(see	below).In	addition,	a	web	service	is	available	for	divelog	conversions	from	SmartTrak	to	Subsurface	(see	below).Feel	free	to	contact	the	Subsurface	development	team	on	our	mailing	list	for	assistance	in	importing	SmartTrak	dive	logs.Assuming	the	above	dependencies	have	been	installed	and	the	Subsurface
source	tree	is	in	the	directory	~/src/subsurface,	then:Move	to	the	source	tree	directory	out	of	Subsurface	(e.g.	~/src)Run	"	$	./subsurface/scripts/smtk2ssrf-build.sh	",	if	every	thing	has	gone	fine,	you	will	now	have	an	executable	named	smtk2ssrf	in	~/src/subsurface/smtk-import/buildYou	can	run	it	from	this	directory,	copy	it	to	another	one,	e.g.	~/bin
or	simply	run	"sudo	make	install",	and	the	binary	will	be	installed	in	/usr/local/bin	(which	is	commonly	included	in	every	$PATH).The	script	has	some	options	mostly	useful	for	development	purposes.	If	you	think	you	may	need	them,	please	read	comments	on	script	header	itself.WARNING:	While	building	smtk2ssrf,	a	light	version	of	Subsurface	is	built
(usable	but	lacking	a	lot	of	features).	So,	if	you	commonly	use	the	built	executable	placed	at	~/subsurface/build/,	you	will	need	to	rebuild	it	as	explained	in	this	manual	above.smtk2ssrf	accepts	0,	2	or	more	parameters.	If	it	is	launched	without	parameters	in	a	graphical	user	interface,	a	simple	window	opens	for	choosing	the	.slg	file(s)	to	import	and	a
destination	file	to	store	the	Subsurface-formatted	data	into	(see	image	below).Existing	data	in	the	destination	file	will	be	erased,	so	DO	NOT	use	a	regular	subsurface	divelog	file	as	a	destination:	rather,	specify	a	new	filename	as	a	destination.If	launched	from	a	command	line	with	two	or	more	parameters,	the	format	is	as	follows:$	smrtk2ssrf
/input/file_1.slg	/input/file_2.slg	/output/file3.xmlwhere	input	is	the	directory	containing	the	.slg	file(s)	and	output	is	the	directory	where	the	Subsurface-formatted	output	is	written	to.	Files	file_1.slg	and	file_2.slg	in	the	input	directory	are	imported	and	stored	in	file3.xml	in	the	output	directory.	Check	any	warning	and	error	messages	in	the	console	or
in	the	graphical	window:	some	may	be	relevant	as	support	for	Galileo	family	of	dive	computers	is	still	a	work	in	progress.	is	a	no-frills	web	service	for	converting	SmartTrak	dive	logs	to	Subsurface.	Select	the	browse	button.	This	allows	you	to	browse	your	computer	directories	and	to	select	the	SmartTrak	divelog	to	be	converted.	Once	it	has	been
selected,	click	the	Submit	query	button.	After	a	short	while,	a	dialog	box	appears	(image	below)	for	saving	the	converted	file	to	the	local	computer.Open	the	new	file	(generated	in	the	previous	steps)	using	Subsurface	and	check	the	dives	and	data.	If	everything	is	fine,	close	the	.xml	file	and	open	your	regular	divelog.	Then	from	the	Main	Menu	select
Import	→	Import	log	file	and	choose	the	.xml	file	containing	the	imported	dives:	these	will	show	in	the	Dive	List,	time	ordered,	along	with	the	existing	dives.	The	new	dives,	although	time	ordered,	will	keep	the	numbering	system	from	SmartTrak,	so	a	renumbering	action	is	needed.	See	the	section	on	Renumbering	the	dives	for	instructions	on	this
topic.Importing	dive	information	from	divelogs.de	is	simple,	using	a	single	dialog	box.	The	Import	→	Import	from	Divelogs.de	option	should	be	selected	from	the	Main	Menu.	This	brings	up	a	dialog	box	(see	image	A	below).	Enter	a	user-ID	and	password	for	divelogs.de	and	then	select	the	Download	button.	Download	from	divelogs.de	starts
immediately,	displaying	a	progress	bar	in	the	dialog	box.	At	the	end	of	the	download,	the	success	status	is	shown	(see	image	B,	below).	The	Apply	button	should	then	be	selected,	after	which	the	imported	dives	appear	in	the	Subsurface	Dive	List	panel.Subsurface	can	directly	import	the	database	generated	by	the	proprietary	SeacSync	application.
Simply	locate	the	database	file	on	your	computer,	then	use	the	universal	import	dialog.On	Windows	10,	The	SeacSync	database	is	typically	found	in:	C:\[USERNAME]\AppData\Roaming\SeacSync\divesDB.dbSubsurface	will	not	modify	the	database	during	import,	so	it	can	be	imported	directly	from	this	location.A	comma-separated	file	(.csv)	can	be
used	to	import	dive	information	either	as	dive	profiles	(as	in	the	case	of	the	APD	Inspiration	and	Evolution	closed	circuit	rebreathers)	or	as	dive	metadata	(in	case	the	user	keeps	dive	data	in	a	spreadsheet).	The	CSV	format	is	a	universal	simplified	format	that	allows	easy	information	exchange	between	different	computers	or	software	packages.	For	an
introduction	to	CSV-formatted	files	see	A	Diver’s	Introduction	To	CSV	Files.	Subsurface	dive	logs	can	also	be	exported	in	CSV	format	to	other	software	that	reads	this	format.	See	APPENDIX	D:	Exporting	a	spreadsheet	to	CSV	format	for	information	that	may	be	helpful	for	importing	spreadsheet-based	data	into	Subsurface.CSV	files	can	be	viewed
using	an	ordinary	text	editor.	A	CSV	file	is	normally	organized	into	a	single	line	that	provides	the	headers	(or	field	names	or	column	headings)	of	the	data	columns,	followed	by	the	data,	one	record	per	line.There	are	two	types	of	CSV	dive	logs	that	can	be	imported	into	Subsurface:CSV	dive	details:	This	dive	log	format	contains	similar	information	to
that	of	a	typical	written	dive	log,	e.g.	dive	date	and	time,	dive	depth,	dive	duration,	names	of	buddy	and	divemaster	and	information	about	cylinder	pressures	before	and	after	the	dive,	as	well	as	comments	about	the	dive.	All	the	data	for	a	single	dive	go	on	a	single	line	of	text,	following	the	order	of	the	column	headings.CSV	dive	profile:	This	dive	log
format	includes	much	more	information	about	a	single	dive.	For	instance	there	may	be	information	at	30-second	intervals,	indicating	depth,	water	temperature,	and	cylinder	pressure	at	that	moment	in	time.	Each	line	contains	the	information	for	a	single	instant	in	time	during	the	dive,	30	seconds	after	that	of	the	previous	instant.	Many	lines	are
required	to	complete	the	depth	profile	information	for	a	single	dive.	This	is	a	common	export	format	used	by	closed-circuit	rebreather	(CCR)	dive	equipment	and	many	software	packages	that	handle	dive	computer	data	and/or	dive	logs.Before	being	able	to	import	the	CSV	data	to	Subsurface	you	need	to	know	a	few	things	about	the	data	being
imported:Which	character	separates	the	different	columns	within	a	single	line	of	data?	This	field	separator	should	be	either	a	comma	(,)	a	semicolon	(;)	or	a	TAB	character.	This	can	be	determined	by	opening	the	file	with	a	text	editor.	If	it	is	comma-delimited	or	semicolon-delimited,	the	comma	or	semicolon	characters	between	the	values	are	clearly
visible.	If	these	are	not	evident	and	the	numbers	are	aligned	in	columns,	the	file	is	probably	TAB-delimited	(i.e.	it	uses	a	TAB	as	a	field	separator).Which	data	columns	need	to	be	imported	into	Subsurface?	Is	it	a	CSV	dive	details	file	or	a	CSV	dive	profile	file?	Open	the	file	using	a	text	editor	and	note	the	titles	of	the	columns	to	be	imported	and	their
column	positions.Is	the	numeric	information	(e.g.	dive	depth)	in	metric	or	in	imperial	units?With	this	information,	importing	the	data	into	Subsurface	is	straightforward.	Select	Import	→	Import	Log	Files	from	the	main	menu.	In	the	resulting	file	selection	menu,	select	CSV	files	(towards	the	bottom	right).	This	shows	all	.CSV	files	in	the	selected
directory.	Select	the	file	that	needs	to	be	imported.	A	configuration	panel	appears	as	depicted	below:At	the	top	left,	there	is	a	dropdown	list	containing	pre-	configured	settings	for	common	dive	computers	and	software	packages.	If	the	CSV	file	being	imported	originated	from	any	of	these	pre-configured	items,	select	it.	Otherwise	use	the	Manual
Import	option.	The	configuration	panel	also	has	dropdown	lists	for	the	specification	of	the	appropriate	field	separator	(Tab,	comma	or	semicolon),	the	date	format	used	in	the	CSV	file,	the	time	units	(seconds,	minutes	or	minutes:seconds),	as	well	as	the	unit	system	(metric	or	imperial).	Selecting	the	appropriate	options	among	these	is	critical	for
successful	data	import.Complete	this	by	ensuring	that	all	the	data	columns	have	the	appropriate	column	headings.	The	top	blue	row	of	the	data	table	contains	the	column	headings	found	in	the	CSV	data	file.	The	blue	row	of	balloons	immediately	above	these	contains	the	names	understood	by	Subsurface.	These	balloons	can	be	moved	using	a	drag-and-
drop	action.	For	instance,	Subsurface	expects	the	column	heading	for	Dive	number	("	#	")	to	be	"Dive	#	".	If	the	column	heading	that	Subsurface	expects	is	not	in	the	blue	row,	drag	the	appropriate	balloon	from	the	upper	area	and	drop	it	in	the	appropriate	blue	cell	at	the	top	of	the	table.	For	example,	to	indicate	the	correct	column	for	"Dive	#",	drag
the	ballooned	item	labelled	"Dive	#	"	and	drop	it	in	the	blue	cell	immediately	above	the	white	cell	containing	"	#	",	depicted	in	the	image	below.Continue	in	this	way	to	ensure	all	the	column	headings	in	the	blue	row	of	cells	correspond	to	the	headings	listed	in	the	top	part	of	the	dialog.	When	finished,	select	the	OK	button	on	the	bottom	right	of	the
dialog.	The	data	from	the	CSV	file	are	imported	and	shown	in	the	Dive	List	panel.But,	the	CSV	import	has	a	couple	of	caveats.	Avoid	some	special	characters	like	ampersand	(&),	less	than	()	and	double	quotes	(")	as	part	of	the	numbers	or	text	within	a	cell.	The	file	should	use	UTF-8	character	set,	if	using	non-ASCII	characters.	Also	the	size	of	the	CSV
file	might	cause	problems.	Importing	100	dives	at	a	time	(CSV	dive	details)	works,	but	larger	files	might	exceed	the	limits	of	the	parser	used.	When	encountering	problems	with	CSV	imports,	first	try	with	a	smaller	file	to	make	sure	everything	works.The	dive	site	information	of	all	dives	is	managed	as	a	separate	entity	independent	of	the	dive
information.	Selecting	the	rightmost	tab	of	the	Notes	panel,	labelled	"Dive	sites"	brings	up	the	dive	sites	management	panel	(image	below).	Linking	a	dive	to	a	dive	site	is	performed	from	within	the	Notes	tab	showing	the	information	for	that	dive	(see	the	section	on	Locations).	On	the	other	hand	the	dive	sites	management	panel	allows	dive-
independent	data	to	be	managed.	A	new	dive	site	can	be	created	either	while	editing	a	dive	(within	the	Notes	tab,	see	Locations)	or	it	could	be	created	within	the	dive	sites	management	panel	(image	below).If	a	description	for	a	dive	site	has	previously	been	entered,	this	is	shown	in	the	panel	as	well	as	the	number	of	dives	at	each	site.	The	list	of	sites
can	be	ordered	by	clicking	on	any	of	the	three	headings.	A	dustbin	and	an	edit	icon	are	on	the	left	of	each	dive	site	name.	The	following	actions	are	possible	for	managing	the	collection	of	dive	sites:At	the	top	right	of	the	dive	site	management	panel	is	a	text	box	(see	image	above).	If	you	wish	to	only	show	dives	from	a	particular	site,	then	type	a	partial
dive	site	name	such	as	"Genova".	This	shows	only	the	dive	sites	that	have	been	described	for	Genova,	assuming	that	the	word	"Genova"	forms	part	of	the	dive	site	name	or	description.The	information	for	each	dive	site	can	be	edited	either	from	from	within	the	Notes	tab	or	within	the	Dive	sites	tab.	In	order	to	edit	the	dive	site	information,	select	the
Edit	icon	to	the	left	of	the	dive	site	name	(see	image	above).	Editing	dive	site	information	from	within	the	Notes	tab	is	discussed	in	the	section	on	Locations	where	each	of	the	fields	in	the	dive	site	edit	panel	is	explained.Add	any	desirable	information	to	the	tab.	Editing	of	coordinates	is	explained	in	the	section	dealing	with	Locations.	Having	finished
editing	the	dive	site	information,	select	the	Done	button	at	the	top.	This	returns	you	to	the	dive	sites	management	panel.Merging	two	or	more	dives	is	achieved	in	the	dive	site	edit	panel	(see	image	above).	We	assume	that	the	dive	sites	that	need	merging	are	not	far	apart.	Merging	is	performed	by	selecting	a	dive	site	and	then	merging	other	dives
with	this	selected	dive	site.	In	the	edit	panel,	above,	select	the	text	box	labelled	"Show	dive	sites	in	the	range	of:"	and	provide	a	critical	distance	that	would	include	the	site	that	needs	to	be	merged	with	the	present	site.	A	list	of	sites	within	this	range	is	presented	(see	image	below).Select	the	dive	site	to	be	merged	by	right-clicking	it.	A	confirmation
message	is	presented	(see	image	above).	Clicking	the	confirmation	message	merges	the	selected	dive	with	the	dive	named	at	the	top	of	the	panel	and	returns	you	to	the	dive	sites	management	panel.At	the	top	right	of	the	dive	sites	management	table	is	a	round	button	with	a	"+".	Clicking	that	button	inserts	a	new	site	entitled	"New	dive	site"	into	the
list	(image	below).	The	new	site	can	also	be	deleted	(maybe	after	erroneously	clicking	the	+	icon	or	you	realized	the	dive	site	already	exists)	by	selecting	Edit	→	Undo	from	the	main	menu	or	by	typing	Ctrl-Z	(or	CMD-Z	on	a	Mac)	while	the	dive	sites	management	table	has	focus.	Edit	this	new	site	by	selecting	its	edit	icon	and	provide	a	name,
coordinates	and,	if	preferred,	a	description.	Clicking	the	"Done"	button	in	the	edit	panel	returns	you	to	the	dive	sites	management	panel.On	the	left	of	each	dive	site	is	a	dustbin	icon.	Clicking	the	dustbin	deletes	that	site.	If	there	are	any	dives	performed	at	that	site,	a	warning	message	is	shown	(see	image	below).	If	this	site	is	then	deleted,	the
location(s)	of	dives	that	used	this	site	would	need	to	be	created.Since	the	dive	sites	list	is	managed	separately	from	the	dive	list,	it	is	possible	to	add	dive	sites	to	the	list	even	though	these	sites	have	not	been	used	for	any	dives.	In	this	case	the	column	labelled	"#	of	dives"	shows	a	zero.	This	makes	it	possible	for	divers	to	share	dive	sites	and	sites	can



be	created	before	any	of	them	are	dived.	Alternatively	a	site	can	be	created	with	a	useful	description	such	as	"Ann	dived	this	site	last	summer	and	she	saw	huge	numbers	of	bumphead	parrotfish.	She	said	Jan	-	Apr	is	the	best	time.	I	hope	to	dive	there	myself".	In	this	way	the	dive	sites	list	becomes	a	repository	of	useful	information	outside	of	the	dive
list.At	the	top	left	of	the	dive	sites	management	panel	is	a	button	"Purge	unused	dive	sites".	Selecting	this	button	deletes	all	the	dive	sites	that	do	not	have	associated	dives.Many	(if	not	most)	divers	take	photographs	or	videos	during	a	dive.	We	term	these	as	media,	meaning	either	photos	or	videos.	Subsurface	allows	the	storage	and	display	of	these
media	for	each	dive.	Images	are	superimposed	on	the	dive	profile	at	the	times	during	the	dive	when	they	were	taken.	Media	can	be	viewed	either	from	the	dive	profile	or	from	the	Media	tab	in	the	Notes	Panel.	Subsurface	allows	viewing	of	photographs	as	well	as	video	files	in	a	unified	interface.Right-click	on	a	dive	or	on	a	group	of	dives	on	the	dive
list,	bringing	up	the	Dive	list	context	Menu.	Select	the	appropriate	option	to	import	media	either	from	file	or	from	the	Internet.	The	system	file	browser	appears.	Select	the	folder	and	media	that	need	to	be	loaded	into	Subsurface	and	click	the	Open	button.	Towards	the	bottom	of	the	file	browser	is	a	filter	that	allows	showing	media	(photos	and	videos),
only	photographs,	only	videos,	or	all	files.	Choose	the	appropriate	option.If	media	are	imported	from	the	Internet,	provide	a	URL	pointing	to	a	single	media.	If	the	URL	points	to	a	directory,	no	images	are	imported:	images	from	the	Internet	need	to	be	imported	one	at	a	time.	If	media	are	loaded	from	the	Internet,	Subsurface	assumes	there	is	an
Internet	connection	each	time	this	item	is	viewed	within	Subsurface.Having	selected	the	local	folder	or	Internet	image	to	be	imported,	the	time	synchronization	dialog	appears	(see	image	below).	The	time	synchronization	is	not	perfect	between	the	dive	computer	used	during	a	dive	and	the	camera	used	during	that	same	dive.	These	two	devices	often
differ	by	several	minutes.	Subsurface	attempts	to	synchronize	them	so	that	the	exact	times	of	media	can	be	used	to	position	media	on	the	dive	profile.Subsurface	synchronizes	camera	with	dive	computer	in	three	ways:Pro-actively:	Before	the	dive,	ensure	synchronization	of	the	dive	computer	time	settings	with	the	time	settings	of	the	camera	by
changing	the	date-time	settings	on	one	or	both	of	these	devices.Manually:	Writing	down	the	exact	camera	time	at	the	start	of	a	dive	allows	using	the	difference	in	time	between	the	two	devices.	As	long	as	the	device	settings	for	time	has	not	been	changed	in	either	device,	the	times	of	both	devices	after	the	dive	or	even	at	the	end	of	the	day	allows
manually	setting	the	time	difference	in	the	Time	shift	dialog	(see	image	below).	Towards	the	top	of	the	dialog	is	a	time	setting	tool	immediately	under	the	heading	Shift	times	of	image(s)	by,	in	the	image	below.	If	the	camera	time	is	7	minutes	later	than	that	of	the	dive	computer,	set	the	time	setting	tool	to	a	value	of	00:07	and	select	the	Earlier	radio
button.	This	is	appropriate,	since	the	media	need	to	be	shifted	7	minutes	earlier	(camera	is	7	minutes	ahead	of	dive	computer).	Ignore	any	"AM"	or	"PM"	suffix	in	that	tool.	Click	the	OK	button	and	synchronization	is	done.By	photograph:	There	is	a	very	slick	way	of	achieving	synchronization,	requiring	a	photograph	of	the	face	of	the	dive	computer
showing	the	time.	Subsurface	gets	the	exact	time	the	photograph	was	taken,	using	the	metadata	the	camera	stores	within	each	photo	and	compares	this	with	the	time	visible	on	the	photo.	To	do	this,	use	the	bottom	half	of	the	Time	shift	dialog.	In	this	case	the	top	part	of	the	dialog	is	ignored.	Click	on	the	horizontal	bar	called	Select	image	of	dive
computer	showing	time.	This	brings	up	a	file	browser	for	selecting	the	photograph	of	the	dive	computer	time.	Select	the	photograph	using	the	file	browser	and	click	on	OK.	This	photograph	of	the	dive	computer	appears	in	the	bottom	panel	of	the	Shift	times	dialog.	Now	Subsurface	knows	exactly	when	the	photograph	was	taken.	Now	set	the	date-time
dialog	to	the	left	of	the	photo	so	it	reflects	the	date	and	time	of	the	dive	computer	in	the	photo.	When	the	date-time	tool	has	been	set,	Subsurface	knows	exactly	what	the	time	difference	between	camera	and	dive	computer	is,	and	it	can	synchronize	the	devices.	The	image	below	shows	a	photograph	of	the	face	of	the	dive	computer	and	with	the	date-
time	tool	set	to	the	date-time.If	the	timestamp	of	a	photograph	or	video	is	more	than	30	minutes	before	or	after	the	dive,	it	is	not	placed	on	the	dive	profile	(see	the	red	warning	in	the	image	above).	However,	If	the	appropriate	checkbox	is	selected	(see	image	above)	these	images	can	still	be	placed	on	the	Media	tab	of	the	Notes	panel	so	that	all	media
associated	with	a	dive	are	visible,	including	images	taken	before	or	after	the	dive.After	the	media	have	been	loaded,	they	appear	in	two	places:the	Media	tab	of	the	Notes	Panel	(left	part	of	image	below).as	tiny	icons	(stubs)	on	the	dive	profile	at	the	appropriate	positions	reflecting	the	time	each	photograph	or	video	was	taken.	To	view	the	media	on	the
dive	profile,	activate	the	Toggle	media	button	in	the	tool	bar	to	the	left	of	the	dive	profile:This	results	in	a	profile	display	as	in	the	image	below:Hover	the	mouse	over	any	of	the	media	stubs.	A	thumbnail	image	is	shown	of	the	appropriate	media.	See	the	image	below:Clicking	on	the	thumbnail	brings	up	a	full	size	photo	or	video	overlaid	on	the
Subsurface	window,	allowing	a	good	view	of	the	media	(see	the	image	below).	Note	that	the	thumbnail	on	the	dive	profile	has	a	small	dustbin	icon	in	the	bottom	right	hand	corner	(see	image	above).	Selecting	the	dustbin	removes	the	image	from	the	dive.	Be	careful	when	clicking	on	a	thumbnail.	Images	can	also	be	deleted	using	the	Media	tab	(see
text	below).Media	associated	with	a	dive	are	shown	as	thumbnails	in	the	Media	tab	of	the	Notes	Panel.	Media	taken	in	rapid	succession	during	a	dive	(therefore	sometimes	with	large	overlap	on	the	dive	profile)	can	easily	be	accessed	in	the	Media	tab.	This	tab	serves	as	a	tool	for	individually	accessing	the	media	of	a	dive,	while	the	stubs	on	the	dive
profile	show	when	during	a	dive	when	a	photo/video	was	taken.	The	size	of	the	thumbnails	in	the	Media	tab	can	be	changed	using	the	Zoom	level	slider	at	the	bottom	of	the	panel.	Single-click	a	thumbnail	in	the	Media	panel	to	select	a	photo/video.	Double-click	a	thumbnail	to	view	the	full-sized	image	or	play	the	video,	overlaying	the	Subsurface
window.	Delete	media	from	the	Media	panel	by	selecting	it	(single-click)	and	then	by	pressing	the	Del	key	on	the	keyboard.	This	removes	it	BOTH	from	the	Media	tab	as	well	as	the	dive	profile.By	right-clicking	on	a	video	and	selecting	the	"Save	dive	data	as	subtitles"	option,	a	subtitles	file	with	the	same	name	as	the	video	but	with	an	".ass"	extension
is	created	that	contains	time	dependent	dive	data	(runtime,	depth,	temperature,	NDL,	TTS,	surface	GF)	to	be	overlayed	with	the	video.	The	VLC	video	player	automatically	finds	this	file	upon	playing	the	video	and	overlays	the	dive	data.	Alternatively,	the	ffmpeg	video	encoder	can	be	used	to	create	a	new	video	file	with	the	dive	data	encoded	in	the
video	stream.	To	do	so	runffmpeg	-v	video.mp4	-vf	"ass=video.ass"	video_with_data.mp4from	the	command	line.	You	need	to	have	the	libass	library	installed.Most	underwater	photographers	store	media	on	an	external	drive.	If	such	a	drive	can	be	mapped	by	the	operating	system	(almost	always	the	case)	the	media	can	be	directly	accessed	by
Subsurface.	This	eases	the	interaction	between	Subsurface	and	an	external	repository	of	media.	When	associating	a	dive	profile	with	media	from	an	external	drive,	the	normal	procedure	of	selection	and	synchronization	(see	text	above)	is	used.	After	the	external	drive	has	been	disconnected,	Subsurface	cannot	access	these	media	any	more.	If	the
display	of	media	is	activated	(using	the	toolbox	icon	to	the	left	of	the	Dive	Profile),	the	program	shows	only	the	thumbnails	and	the	images	cannot	be	viewed	at	full-screen	size.	If	the	external	drive	with	the	media	is	re-connected,	the	media	can	be	seen	in	the	normal	way.Inspecting	each	individual	dive	in	order	to	determine	whether	there	are
associated	media	can	be	time	consuming.	There	is	a	rapid	way	of	seeing	which	dives	have	associated	media	and	which	not:	activate	the	Media	checkbox	in	the	dropdown	list	obtained	by	right-clicking	on	the	header	bar	of	the	Divelist.	In	the	Divelist,	all	dives	with	associated	media	have	an	icon	indicating	whether	the	media	were	taken	during	the	dive,
just	before/after	the	dive	or	both	during	and	before/after	the	dive.	More	information	is	provided	in	the	section	dealing	with	photo	icons	on	the	Divelist.After	a	photograph	or	video	has	been	loaded	into	Subsurface	and	associated	with	a	specific	dive,	Subsurface	saves	the	path	to	the	directory	where	the	media	lie	as	well	as	the	file	name	of	the	each
photo/video,	in	order	to	find	it	when	the	dive	is	opened	again.	If	the	media	or	the	whole	media	collection	is	moved	to	another	drive	or	to	a	different	machine,	the	path	to	the	media	changes.	Now,	Subsurface	looks	for	the	photos/videos	at	their	original	location	before	they	were	moved,	cannot	find	them	and	cannot	display	them.	Because,	after	moving
media,	large	numbers	of	files	may	need	to	be	deleted	and	re-imported	from	the	new	disk,	Subsurface	can	locate	the	media	based	on	their	filename	and	path.This	is	done	by	selecting	from	the	Main	Menu:	File	→	Find	moved	images.	This	brings	up	a	window	within	which	the	searching	of	the	images	can	be	controlled.	The	search	is	started	by	clicking	on
Select	folder	and	scan.	Since	recorded	during	different	dive	trips	might	have	the	same	filename,	the	names	of	the	parent	folders	are	likewise	compared.	Therefore,	the	root	folder	of	the	NEW	picture	collection	should	be	chosen.	For	finer	control,	it	is	possible	to	search	only	for	media	of	the	currently	selected	dive(s)	by	selecting	the	appropriate
option.After	the	searching	has	completed,	the	original	filenames	and	the	new	locations	of	the	photographs	will	be	shown.	The	matching	parts	of	the	paths	are	emphasized.	Media	that	are	found	at	their	known	positions	are	not	listed.	The	proposed	changes	can	be	applied	by	clicking	Apply	or	rejected	by	clicking	Cancel.This	section	gives	examples	of
the	versatility	of	Subsurface	as	a	dive	logging	tool.Subsurface	easily	handles	dives	involving	more	than	one	cylinder.	Multi-cylinder	diving	usually	happens	(a)	if	a	diver	doesn’t	have	enough	gas	for	the	complete	dive	in	a	single	cylinder;	(b)	if	a	diver	needs	more	than	one	gas	mixture	because	of	the	depth	or	the	decompression	needs	of	the	dive.	For	this
reason	multi-cylinder	dives	are	often	used	by	technical	divers	who	dive	deep	or	long.	As	far	as	Subsurface	is	concerned,	there	are	only	two	types	of	information	that	need	to	be	provided:Describe	the	cylinders	used	during	the	dive	This	is	performed	in	the	Equipment	tab	of	the	Info	panel,	as	described	above.	Enter	the	cylinders	one	by	one,	specifying	its
size	and	pressure,	as	well	as	the	gas	composition	within	it.Record	the	times	at	which	the	switch	from	one	cylinder	to	another	was	done:	This	is	information	tracked	by	some	dive	computers	(provided	the	diver	indicated	these	changes	to	the	dive	computer	by	pressing	specific	buttons).	If	the	dive	computer	does	not	provide	the	information,	the	diver	has
to	record	these	changes	using	a	different	method,	e.g.	writing	it	on	a	slate	or	by	creating	a	bookmark	on	the	dive	computer.Record	the	cylinder	changes	on	the	dive	profile:	If	the	latter	option	was	followed,	the	diver	needs	to	indicate	the	gas	change	event	by	right-clicking	at	the	appropriate	point	in	time	on	the	Dive	Profile	panel	and	indicating	the
cylinder	to	which	the	change	was	made.	After	right-clicking,	follow	the	context	menu	to	"Add	gas	change"	and	select	the	appropriate	cylinder	from	those	defined	during	the	first	step,	above	(see	image	below).	If	the	gas	bar	button	in	the	toolbar	has	been	activated,	the	cylinder	switches	are	also	indicated	in	the	gas	bar	(image	below).When	this	is
complete,	Subsurface	indicates	the	appropriate	use	of	cylinders	in	the	dive	profile.	Below	is	a	two-cylinder	dive,	starting	off	with	EAN28,	then	changing	cylinders	to	EAN50	after	26	minutes	for	decompression.Several	dive	computers	perform	automatic	recording	of	cylinder	pressure.	In	this	case	no	manual	intervention	is	needed.	Older	dive	computers
(e.g.	Uwatec	Galileo,	several	Suunto	models)	handle	more	than	one	pressure	transducer	on	cylinders,	switching	from	one	sensor	to	another	as	the	diver	switches	among	cylinders	and	providing	a	sequential	record	of	cylinders	pressures	during	a	dive.	Some	of	the	latest	models	(e.g.	Shearwater	Perdix	AI,	Scubapro	G2)	record	two	or	more	pressure
transducers	concurrently	and	continuously	during	the	whole	dive.	In	these	cases	Suburface	correctly	interprets	the	data.	There	is	continuous	effort	within	the	_Subsurface	development	team	to	add	new	dive	computer	models	to	those	that	can	be	downloaded	from	and	to	represent	cylinder	pressures	correctly.	Regardless	of	the	type	of	sensor	handling
of	dive	computers,	technical	divers	are	likely	to	use	both	automated	and	manual	methods	of	cylinder	pressure	logging	when	more	than	two	gases	are	used.	However,	automated	recording	of	cylinder	pressure	simplifies	logging	of	sidemount	dives	(where	two	cylinders	are	used).	See	the	list	of	supported	dive	computers.Sidemount	diving	is	just	another
form	of	multi-cylinder	diving,	often	with	both	or	all	cylinders	having	the	same	gas	mixture.	Although	it’s	a	popular	configuration	for	cave	divers,	sidemount	diving	can	be	done	by	recreational	divers	who	have	completed	the	appropriate	training.	See	the	comments	in	the	last	paragraph,	above,	about	automated	recording	of	cylinder	pressures.	Manual
logging	of	cylinder	pressures	during	sidemount	involves	three	steps,	exactly	as	with	multi-cylinder	dives	above:During	the	dive,	record	cylinder	switch	events.	Since	sidemount	diving	normally	involves	two	cylinders	with	air	or	with	the	same	gas	mixture,	Subsurface	distinguishes	between	these	different	cylinders.	In	contrast,	many	dive	computers	that
allow	gas	switching	only	distinguish	between	different	gases	used,	not	among	different	cylinders	used.	This	means	when	sidemount	dives	are	downloaded	from	these	dive	computers,	the	switching	event	between	cylinders	with	the	same	gas	is	not	downloaded.	This	may	mean	that	a	diver	may	have	to	keep	a	written	log	of	cylinder	switch	times	using	a
slate,	or	(if	the	dive	computer	has	the	capability)	marking	each	cylinder	switch	with	a	bookmark	that	can	be	retrieved	later.	Returning	from	a	dive	with	the	times	of	cylinder	changes	is	the	only	tedious	part	of	logging	sidemount	dives.Within	Subsurface	describe	the	cylinders	used	during	the	dive.	The	diver	needs	to	provide	the	specifications	of	the
different	cylinders,	using	the	Equipment	tab	of	the	Info	Panel	(see	image	below	where	two	12	liter	cylinders	were	used).Indicate	cylinder	change	events	on	the	Subsurface	dive	profile.	Once	the	dive	log	has	been	imported	from	a	dive	computer	into	Subsurface,	the	cylinder	switch	events	need	to	be	shown	on	the	dive	profile.	Cylinder	changes	are
recorded	by	right-clicking	at	the	appropriate	point	on	the	dive	profile,	then	selecting	Add	gas	change.	A	list	of	the	appropriate	cylinders	is	shown	with	the	currently	used	cylinder	greyed	out.	In	the	image	below	Tank	1	is	greyed	out,	leaving	only	Tank	2	to	be	selected.	Select	the	appropriate	cylinder.	The	cylinder	change	is	then	shown	on	the	dive
profile	with	a	cylinder	symbol.	If	the	gas	bar	is	activated	using	the	toolbar	to	the	left	of	the	profile,	then	the	cylinder	change	is	also	shown	on	the	gas	bar	(see	image	below).	After	all	the	cylinder	change	events	have	been	recorded	on	the	dive	profile,	the	correct	cylinder	pressures	for	both	cylinders	are	shown	on	the	dive	profile,	as	in	the	image
below.Passive	semi-closed	rebreathers	(pSCR)	are	a	technical	advance	in	diving	equipment	that	recirculates	the	breathing	gas	a	diver	uses,	while	removing	carbon	dioxide	from	the	exhaled	gas.	While	a	small	amount	(typically	a	tenth)	of	the	exhaled	breathing	gas	is	released	into	the	water,	a	small	amount	of	fresh	gas	is	released	from	the	driving	gas
cylinder.	A	diver	using	a	single	cylinder	of	breathing	gas	can	therefore	dive	for	much	longer	periods	than	using	a	recreational	open-circuit	configuration.	With	pSCR	equipment,	a	very	small	amount	of	breathing	gas	is	released	every	time	the	diver	inhales.	With	active	SCR	(aSCR)	equipment,	in	contrast,	a	small	amount	of	breathing	gas	is	released
continuously	from	the	driving	cylinder.To	log	pSCR	dives,	no	special	procedures	are	required.	Use	the	normal	steps	outlined	above:Select	pSCR	in	the	Dive	Mode	dropdown	list	on	the	Info	panel.pSCR	diving	often	involves	gas	changes,	requiring	an	additional	cylinder.	Define	all	the	appropriate	cylinders	as	described	above	and	indicate	the
cylinder/gas	changes	as	described	above	in	the	section	on	multicylinder	dives.In	pSCR	diving,	the	inspired	gas	often	has	a	pO2	below	that	of	the	fresh	gas	from	cylinder.	This	is	because	fresh	gas	is	only	supplied	at	a	slow	rate	and	the	diver	continuously	uses	oxygen	from	the	loop	for	metabolism,	resulting	in	the	so-called	"pO2	drop	over	the
mouthpiece".	For	pSCR	dive	profiles	the	dive	ceiling	is	adjusted	for	this	oxygen	drop,	and	often	requires	longer	decompression	periods.	Below	is	a	dive	profile	of	a	pSCR	dive	using	EAN36	as	bottom	gas	and	oxygen	for	decompression.	Note	that	this	dive	lasted	over	two	hours.Visualizing	the	pO2	drop_:	The	difference	between	the	pO2	of	the	fresh
cylinder	gas	and	the	pO2	in	the	loop	can	be	visualized	in	Subsurface	by	opening	the	Tech	setup	panel	in	the	File	→	Preferences	menu	item	and	then	providing	suitable	information	in	the	section	labelled	pSCR	options.	The	pSCR	metabolic	rate	is	your	rate	of	oxygen	metabolism	in	liters/min	(commonly	between	0.5	and	2.5).	The	Dilution	ratio	is	the	ratio
indicating	how	much	gas	in	the	loop	is	replaced	with	fresh	gas,	relative	to	the	gas	being	breathed	(common	values	are	between	1:3	and	1:10).	These	values	are	also	used	when	planning	pSCR	dives.	If	the	oxygen	content	of	the	loop	is	not	recorded	by	an	oxygen	sensor,	Subsurface	estimates	the	pO2	in	the	loop	using	the	information	supplied	above.	This
pO2	is	shown	as	the	green	line	representing	the	oxygen	partial	pressure	in	the	dive	profile.	If	the	oxygen	pressure	in	the	loop	is	measured	using	an	oxygen	sensor	connected	to	a	dive	computer,	this	information	is	probably	recorded	by	the	dive	computer	and	these	measured	pO2	values	are	shown	on	the	dive	profile.	In	addition,	the	Tech	setup
Preferences	panel	allows	one	to	activate	a	checkbox	labelled	Show	equivalent	OC	pO2	with	pSCR	pO2.	This	activates	display	of	the	pO2	in	the	fresh	gas	from	the	cylinder	(an	orange	line).	The	vertical	distance	between	the	orange	graph	and	the	green	graph	indicates	the	"pO2	drop	over	the	mouthpiece".	Much	of	pSCR	diving	involves	managing	this
pO2	difference.pSCR	and	bailout:	Gases	used	in	pSCR	often	yield	very	low	pO2	values	in	shallow	water.	For	this	reason	one	often	completes	the	shallow	sections	of	a	dive	using	open	circuit	(OC)	rather	than	the	rebreather.	In	this	case	parts	of	the	dive	are	performed	OC,	while	the	rest	of	the	dive	is	performed	on	the	pSCR	loop.	To	indicate	such
changes	in	divemode,	right-click	on	the	dive	profile	at	the	appropriate	time.	From	the	context	menu,	select	Change	divemode	and	choose	the	appropriate	option	(see	image	on	left).	Some	dive	computers	record	such	changes	in	divemode	as	part	of	the	dive	log.	The	appropriate	icon	is	shown	on	the	depth	profile	(see	image	below).	Below	is	a	pSCR	dive
with	the	shallow	sections	using	OC.	An	OC	divemode	was	entered	right	at	the	start,	followed	by	a	change	to	pSCR	at	18m.	During	the	ascent,	there	was	a	bailout	to	OC	at	14m.	Note,	for	the	OC	sections,	the	pO2	is	identical	to	the	OC-pO2	whereas	for	the	pSCR	section,	the	pO2	(green	line)	differs	from	the	OC-pO2	(orange	line).Closed	system
rebreathers	also	recirculate	gas	that	has	been	breathed.	However,	they	use	advanced	technology	to	maintain	a	breathable	oxygen	concentration:	a)	remove	carbon	dioxide	from	the	exhaled	gas.	b)	regulate	the	oxygen	concentration	to	remain	within	safe	diving	limits.	The	CCR	interface	of	Subsurface	is	currently	experimental	and	under	active
development.	Subsurface	currently	supports	Poseidon	MkVI	and	APD	Discovery/Evolution	dive	computers,	as	well	as	Shearwater	dive	computers	connected	to	CCR	systems.	In	contrast	to	a	conventional	recreational	dive	computer,	a	CCR	system	computer	usually	does	not	allow	the	download	of	a	log	containing	multiple	dives.	Rather,	each	dive	is
stored	independently.	This	means	that	Subsurface	cannot	download	a	dive	log	directly	from	a	CCR	dive	computer,	but	that	it	imports	individual	CCR	dive	profiles	in	the	same	way	it	imports	dive	log	data	from	other	digital	databases:	one	dive	at	a	time.	However,	the	Shearwater	based	CCR	systems	are	different	in	this	respect	and	allow	multi-dive
downloads.For	Shearwater	CCR	controllers,	or	independent	Shearwater	CCR	logs,	just	download	the	dive	log	as	would	be	the	case	for	non-CCR	dives.	Subsurface	interprets	the	CCR	dive	log	correctly.	Except	for	Shearwater	CCR	dive	computers,	CCR	dive	data	are	currently	obtained	from	the	proprietary	software	provided	when	purchasing	CCR	dive
equipment.	See	the	section	dealing	with	Importing	dive	information	from	other	digital	sources	and	Appendix	B	for	more	complete	information.	Use	that	software	to	download	the	dive	data	into	a	known	directory.	From	the	main	menu	of	Subsurface,	select	Import	→	Import	log	files	to	bring	up	the	universal	import	dialog.	As	explained	in	that	section,	the
bottom	right	hand	of	the	import	dialog	contains	a	dropdown	list	(labelled	Filter:)	of	appropriate	devices	that	currently	include	(Poseidon)	MkVI	or	APD	log	viewer	files.	Import	for	other	CCR	equipment	is	under	active	development.	Having	selected	the	appropriate	CCR	format	and	the	directory	where	the	original	dive	logs	have	been	stored	from	the
CCR	dive	computer,	select	a	particular	dive	log	file	(in	the	case	of	the	MkVI	it	is	a	file	with	a	.txt	extension).	After	selecting	the	appropriate	dive	log,	click	the	Open	button	at	the	bottom	right	hand	of	the	universal	import	dialog.	The	selected	dive	is	imported	to	the	Subsurface	dive	list.Partial	pressures	of	gases:	The	graph	of	oxygen	partial	pressure
shows	the	information	from	the	oxygen	sensors	of	the	CCR	equipment.	In	contrast	to	recreational	equipment	(where	pO2	values	are	calculated	based	on	gas	composition	and	dive	depth),	CCR	equipment	provide	actual	measurements	of	pO2,	derived	from	oxygen	sensors.	In	this	case	the	graph	for	oxygen	partial	pressure	should	be	fairly	flat,	reflecting
the	setpoint	settings	during	the	dive.	The	mean	pO2	is	NOT	the	mean	oxygen	partial	pressure	as	given	by	the	CCR	equipment,	but	a	value	calculated	by	Subsurface	as	follows:For	TWO	O2	sensors	the	mean	value	of	the	two	sensors	are	given.For	THREE-sensor	systems	(e.g.	APD),	the	mean	value	is	also	used.	However	differences	of	more	than	0,1	bar
in	the	simultaneous	readings	of	different	sensors	are	treated	as	false.	If	one	of	the	three	sensors	provides	false	data,	it	is	ignored.If	no	sensor	data	are	available,	the	pO2	value	is	assumed	to	be	equal	to	the	setpoint.The	mean	pO2	of	the	sensors	is	indicated	with	a	green	line,The	oxygen	setpoint	values	as	well	as	the	readings	from	the	individual	oxygen
sensors	can	be	shown.	The	display	of	additional	CCR	information	is	turned	on	by	checking	the	appropriate	boxes	in	the	Tech	setup	Preferences	panel	(accessible	by	selecting	File→Preferences→Tech	setup).	This	part	of	the	Preferences	panel	is	shown	in	the	image	below,	representing	two	checkboxes	that	modify	the	display	of	pO2	when	the	appropriate
toolbar	button	on	the	Dive	Profile	has	been	checked.Checking	any	of	these	boxes	allows	the	display	of	additional	oxygen-related	information	whenever	the	pO2	toolbar	button	on	the	Profile	panel	is	activated.	The	first	checkbox	allows	the	display	of	setpoint	information.	This	is	an	orange	line	superimposed	on	the	green	oxygen	partial	pressure	graph
and	allows	a	comparison	of	the	mean	measured	oxygen	partial	pressure	and	the	setpoint	values,	as	shown	below.The	second	checkbox	allows	the	display	of	the	data	from	each	individual	oxygen	sensor	of	the	CCR	equipment.	The	data	for	each	sensor	is	color-coded	as	follows:Sensor	1:	greySensor	2:	blueSensor	3:	brownThe	mean	oxygen	pO2	is
indicated	by	the	green	line.	This	allows	the	direct	comparison	of	data	from	each	of	the	oxygen	sensors,	useful	for	detecting	abnormally	low	or	erratic	readings	from	a	particular	sensor.The	setpoint	data	can	be	overlaid	on	the	oxygen	sensor	data	by	activating	both	of	the	above	check	boxes.	Partial	pressures	for	nitrogen	(and	helium,	if	applicable)	are
shown	in	the	usual	way	as	for	open	circuit	dives.Events:	Several	events	are	logged,	e.g.	switching	the	mouthpiece	to	open	circuit.	These	events	are	indicated	by	yellow	triangles	and,	if	you	hover	over	a	triangle,	a	description	of	that	event	is	given	as	the	bottom	line	in	the	Information	Box.Bailout:	Bailout	events	during	a	CCR	dive	can	be	recorded	in	a
Subsurface	divelog.	Right-click	on	the	dive	profile	to	generate	a	dive	profile	context	menu.	Select	Change	divemode	and	choose	the	appropriate	bailout	option	(probably	OC).	An	appropriate	icon	is	shown	on	the	depth	profile	(see	image	below).	In	most	CCR	equipment	it	is	also	possible	to	bailout	to	pSCR,	especially	in	cases	where	the	electronics	died
and	the	diluent	supply	is	limited.	This	can	also	be	reflected	in	the	dive	log	and	Subsurface	will	calculate	and	graph	the	appropriate	pO2	values.	The	case	during	CCR	training	is	more	complex	if	the	instructor	prefers	a	low	setpoint	such	as	0.7	to	be	maintained	during	bailout.	In	this	case	the	CCR	equipment	maintains	the	low	setpoint	and	overrides	the
OC	or	pSCR	conditions.	In	such	cases	it	is	probably	more	accurate	not	to	record	a	bailout	event	in	the	dive	log	since	Subsurface	will	calculate	pO2	values	based	on	the	erroneous	assumption	that	there	is	no	setpoint.	Below	is	a	dive	profile	for	a	CCR	dive	with	bailout	at	57	minutes.	In	this	profile	the	green	pO2	graph	diverges	from	the	setpoint	value
and	reflects	the	pO2	in	the	OC	diluent	gas	(in	this	case	air).	The	pO2	in	the	loop	(shown	as	a	meandering	graph	for	each	oxygen	sensor)	is	irrelevant	because	the	actual	inspired	gas	comes	directly	from	the	diluent	cylinder.	In	cases	where	bailout	occurs	using	a	stage	cylinder,	indicate	the	bailout	as	well	as	the	gas	change	event	and	Subsurface	will
calculate	all	the	appropriate	pO2	values.	Some	dive	computers	record	bailout	events	as	well	as	gas	change	events:	in	this	case	the	events	are	shown	automatically	in	the	dive	log.Deco	ceiling:	The	deco	ceiling	calculated	by	Subsurface	is	not	very	accurate	because	the	precise	pressure	of	nitrogen	in	the	loop	can	usually	not	be	determined	from	the	dive
log	imported	from	the	CCR	equipment.	Many	CCR	dive	computers,	however,	report	an	internally-calculated	deco	ceiling	that	is	reported	in	the	dive	log,	reflecting	a	more	accurate	assessment.	The	display	of	this	ceiling	is	activated	by	clicking	the	appropriate	button	to	the	left	of	the	dive	profile:The	default	color	of	the	computer-generated	deco	ceiling
is	white.	This	can	be	set	to	red	by	checking	the	appropriate	check	box	after	selecting	File→Preferences→Tech	setup.	The	profile	above	indicates	the	dive	computer-generated	deco	ceiling	in	red.Cylinder	pressures:	Some	CCR	dive	computers	like	Poseidon	record	the	pressures	of	the	oxygen	and	diluent	cylinders.	The	pressures	of	these	two	cylinders
are	shown	as	green	lines	overlapping	the	depth	profile.	In	addition,	start	and	end	pressures	for	both	oxygen	and	diluent	cylinders	are	shown	in	the	Equipment	Tab.	Below	is	a	dive	profile	for	a	CCR	dive,	including	an	overlay	of	setpoint	and	oxygen	sensor	data,	as	well	as	the	cylinder	pressure	data.	In	this	case	there	is	agreement	from	the	readings	of
the	two	oxygen	sensors.Equipment-specific	information:	Equipment-specific	information	gathered	by	Subsurface	is	shown	in	the	Extra	data	tab.	This	may	include	setup	information	or	metadata	about	the	dive.More	equipment-specific	procedures	and	information	for	downloading	CCR	dive	logs	for	Poseidon	and	APD	equipment	can	be	found	in	Appendix
B.The	Dive	Map	has	buttons	useful	for	obtaining	spatial	information	about	a	dive.	These	are:Select	this	button	to	show	the	Dive	Map	as	a	satellite	image	or	as	a	Google	Maps	representation.Zoom	in.	Select	a	smaller	area	of	the	map.Zoom	out.	Select	a	larger	area	of	the	map.The	"Hamburger"	button	on	the	top	right-hand	of	the	Dive	Map	activates	the
Map	menu.	The	items	are:Open	location	in	Google	Maps.	Open	the	location	of	the	active	dive	in	a	separate	Google	Maps	window	with	the	dive	site	indicated	by	a	Google	Maps	teardrop	marker.Copy	location	to	clipboard	(decimal).	Copy	the	coordinates	of	the	active	dive	to	the	clipboard	in	decimal	degrees	e.g.	-25.933905	30.710572Copy	location	to
clipboard	(sexagesimal).	Copy	the	coordinates	of	the	active	dive	to	the	clipboard	in	sexagecimal,	e.g.	25°56’02.058"S	30°42’38.059"ESelect	visible	dive	locations.	In	the	Dive	List	panel,	highlight	all	the	dive	sites	visible	in	the	Dive	Map.	This	allows	easy	selection	of	the	dives	within	a	particular	geographical	area	to	inspect	them	or	to	calculate	statistics
for	them.The	Information	tab	gives	some	summary	information	about	a	particular	dive	that	has	been	selected	in	the	Dive	List.	Useful	information	here	includes	the	surface	interval	before	the	dive,	the	maximum	and	mean	depths	of	the	dive,	the	gas	volume	consumed,	the	surface	air	consumption	(SAC)	and	the	number	of	oxygen	toxicity	units	(OTU)
incurred.Gas	consumption	and	SAC	calculations:	Subsurface	calculates	SAC	and	Gas	consumption	taking	in	account	gas	incompressibility,	particularly	at	tank	pressures	above	200	bar,	making	them	more	accurate.	Refer	to	Appendix	F	for	more	information.The	Summary	tab	gives	summary	statistics	for	more	than	one	dive,	assuming	that	more	than
one	dive	has	been	selected	in	the	Dive	List	using	the	standard	Ctrl-click	or	Shift-click	of	the	mouse.	If	only	one	dive	has	been	selected,	figures	for	only	that	dive	are	given.	This	tab	shows	the	number	of	dives	selected,	the	total	amount	of	dive	time	in	these	dives,	as	well	as	the	minimum,	maximum	and	mean	for	the	dive	duration,	water	temperature	and
surface	air	consumption	(SAC).	It	also	shows	the	depth	of	the	shallowest	and	deepest	dives	of	those	selected.When	using	a	dive	computer,	it	often	reports	several	data	items	that	cannot	easily	be	presented	in	a	standardized	way	because	the	nature	of	the	information	differs	from	one	dive	computer	to	another.	These	data	often	comprise	setup
information,	metadata	about	a	dive,	battery	levels,	no	fly	times,	or	gradient	factors	used	during	the	dive.	When	possible,	this	information	is	presented	in	the	Extra	Data	tab.	Below	is	an	image	showing	extra	data	for	a	dive	using	a	Poseidon	rebreather.Of	all	the	panels	in	Subsurface,	the	Dive	Profile	contains	the	most	detailed	information	about	each
dive.	The	Dive	Profile	has	a	button	bar	on	the	left	hand	side,	allowing	control	of	several	display	options.	The	functions	of	these	buttons	are	described	below.	The	main	item	in	the	Dive	Profile	is	the	graph	of	dive	depth	as	a	function	of	time.	In	addition	to	depth,	it	also	shows	the	ascent	and	descent	rates	compared	to	the	recommended	speed	of	going	up
or	down	in	the	water	column.	This	information	is	given	using	different	colors:ColorDescent	speed	(m/min)Ascent	speed	(m/min)Red>	30>	18Orange18	-	309	-	18Yellow9	-	184	-	9Light	green1.5	-	91.5	-	4Dark	green<	1.5<	1.5The	profile	also	includes	depth	readings	for	the	peaks	and	troughs	in	the	graph.	So	users	should	see	the	depth	of	the	deepest
point	and	other	peaks.	Mean	depth	is	plotted	as	a	grey	line,	indicating	mean	dive	depth	up	to	a	particular	moment	during	the	dive.In	some	cases	the	dive	profile	does	not	fill	the	whole	area	of	the	Dive	Profile	panel.	Clicking	the	Scale	button	in	the	toolbar	on	the	left	of	the	dive	profile	increases	the	size	of	the	dive	profile	to	fill	the	area	of	the
panel.Water	temperature	is	shown	as	a	blue	line	with	temperature	values	placed	adjacent	to	significant	changes.The	Information	box	displays	a	large	range	of	information	about	the	dive	profile.	Normally	the	Information	Box	is	located	to	the	top	left	of	the	Dive	Profile	panel.	The	Information	Box	can	be	moved	around	in	the	Dive	Profile	panel	by	click-
dragging	it	with	the	mouse	so	that	it	is	not	obstructing	important	detail.	The	position	of	the	Information	Box	is	saved	and	used	again	during	subsequent	dive	analyses.When	the	mouse	points	inside	the	Dive	Profile	panel,	the	information	box	expands	and	shows	many	data	items.	In	this	situation,	the	data	reflect	the	time	point	along	the	dive	profile
shown	by	the	mouse	cursor	(see	right-hand	part	of	figure	(B)	above	where	the	Information	Box	reflects	the	situation	at	the	position	of	the	cursor	[arrow]	in	that	image).	Moving	the	cursor	horizontally	lets	the	Information	Box	show	information	for	any	point	along	the	dive	profile.	It	gives	extensive	statistics	about	depth,	gas	and	ceiling	characteristics	of
the	particular	dive.	These	include:	Time	period	into	the	dive	(indicated	by	a	@),	depth,	cylinder	pressure	(P),	temperature,	ascent/descent	rate,	surface	air	consumption	(SAC),	oxygen	partial	pressure,	maximum	operating	depth,	equivalent	air	depth	(EAD),	equivalent	narcotic	depth	(END),	equivalent	air	density	depth	(EADD,	also	as	gas	density	in	g/l),
decompression	requirements	at	that	instant	in	time	(Deco),	the	surface	GF	(a	measure	of	inert	gas	loading	of	the	diver’s	body	defined	as	the	excess	over	the	surface	pressure	normalized	such	that	the	maximally	allowed	over	pressure	at	the	surface,	the	M-value,	corresponds	to	100%),	the	time	to	surface	(TTS),	the	calculated	ceiling,	as	well	as	of	the
statistics	in	the	Information	Box,	shown	as	four	buttons	on	the	left	of	the	profile	panel.	These	are:Show	the	Maximum	Operating	Depth	(MOD)	of	the	dive,	given	the	gas	mixture	used.	MOD	is	dependent	on	the	oxygen	concentration	in	the	breathing	gas.	For	air	(21%	oxygen)	it	is	around	57	m	if	a	maximum	pO2	of	1.4	is	specified	in	the	Preferences
section	(select	File	→	Preferences	→	Tech	setup)	and	edit	the	text	box	pO2	in	calculating	MOD.	When	diving	below	the	MOD	there	is	a	markedly	increased	risk	of	exposure	to	the	dangers	of	oxygen	toxicity.Show	either	the	No-deco	Limit	(NDL)	or	the	Total	Time	to	Surface	(TTS).	NDL	is	the	time	duration	that	a	diver	can	continue	with	a	dive,	given	the
present	depth,	that	does	not	require	decompression	(that	is,	before	an	ascent	ceiling	appears).	Once	a	diver	has	exceeded	the	NDL	and	decompression	is	required	(that	is,	there	is	an	ascent	ceiling	above	the	diver)	then	TTS	gives	the	number	of	minutes	required	before	the	diver	can	surface.	TTS	includes	ascent	time	as	well	as	decompression	time.
Even	if	the	profile	contains	several	gas	switches,	TTS	at	a	specific	moment	during	the	dive	is	calculated	using	the	current	gas.	TTS	longer	than	2	hours	is	not	accurately	calculated	and	Subsurface	only	indicates	TTS	>	2h.Show	Deco	information.	When	enabled,	the	information	box	shows	the	current	gradient	factor	(GF),	the	surface	GF	and	the
momentary	ceilings	for	the	individual	tissue	compartments.	The	gradient	factor	is	in	indication	of	how	much	of	the	allowed	pressure	gradient	between	tissues	(normalized	with	a	100/100	Bühlmann	model)	the	diver	is	currently	using.	The	surface	GF	is	an	indication	of	to	what	degree	the	partial	pressure	of	nitrogen	in	the	blood	exceeds	the	partial
pressure	required	for	safely	reaching	the	surface.	Surface	GF	>	100%	means	that	it	is	unsafe	to	surface.Show	the	Surface	Air	Consumption	(SAC),	an	indication	of	the	surface-normalized	respiration	rate	of	a	diver.	The	value	of	SAC	is	less	than	the	real	respiration	rate	because	a	diver	at	10m	uses	breathing	gas	at	a	rate	roughly	double	that	of	the
equivalent	rate	at	the	surface.	SAC	gives	an	indication	of	breathing	gas	consumption	rate	independent	of	the	depth	of	the	dive,	so	the	respiratory	rates	of	different	dives	can	be	compared.	The	units	for	SAC	is	liters/min	or	cubic	ft/min.Show	the	Equivalent	Air	Depth	(EAD)	for	nitrox	dives	as	well	as	the	Equivalent	Narcotic	Depth	(END)	for	trimix	dives.
These	are	important	to	divers	breathing	gases	other	than	air.	Their	values	are	dependent	on	the	composition	of	the	breathing	gas.	The	EAD	is	the	depth	of	a	hypothetical	air	dive	that	has	the	same	partial	pressure	of	nitrogen	as	the	current	depth	of	the	nitrox	dive	at	hand.	A	nitrox	dive	leads	to	the	same	decompression	obligation	as	an	air	dive	to	the
depth	equalling	the	EAD.	The	END	is	the	depth	of	a	hypothetical	air	dive	that	has	the	same	sum	of	partial	pressures	of	the	narcotic	gases	nitrogen	and	oxygen	as	the	current	trimix	dive.	A	trimix	diver	can	expect	the	same	narcotic	effect	as	a	diver	breathing	air	diving	at	a	depth	equalling	the	END.If	at	some	point	a	isobaric	counter	diffusion	situation	is
encountered	in	the	leading	tissue	(defined	to	be	a	moment	in	time	where	helium	is	off-gassing	while	nitrogen	is	on-gassing	and	the	net	effect	is	on-gassing)	this	is	indicated	in	the	infobox	as	well.	Note	that	this	condition	not	only	depends	on	the	gas	that	is	currently	breathed	but	on	the	tissue	loadings	as	well.Figure	(B)	above	shows	an	information	box
with	a	nearly	complete	set	of	data.On	the	left	of	the	Information	Box	is	a	vertical	bar	graph	showing	the	pressures	of	the	nitrogen	(and	other	inert	gases,	e.g.	helium,	if	applicable)	that	the	diver	was	inhaling	at	a	particular	instant	during	the	dive,	shown	by	the	position	of	the	cursor	on	the	Dive	Profile.	The	drawing	on	the	left	below	indicates	the
meaning	of	the	different	parts	of	the	Gas	Pressure	Bar	Graph.The	light	green	area	indicates	the	gas	pressure,	with	the	top	margin	of	the	light	green	area	showing	the	total	gas	pressure	of	ALL	gases	inhaled	by	the	diver	and	measured	from	the	bottom	of	the	graph	to	the	top	of	the	light	green	area.	This	pressure	has	a	relative	value	in	the	graph	and
does	not	indicate	absolute	pressure.The	horizontal	black	line	underneath	the	light	green	margin	indicates	the	equilibrium	pressure	of	the	INERT	gases	inhaled	by	the	diver,	usually	nitrogen.	In	the	case	of	trimix,	it	is	the	pressures	of	nitrogen	and	helium	combined.	In	this	example,	the	user	is	diving	with	EAN32,	so	the	equilibrium	inert	gas	pressure	is
68%	of	the	distance	from	the	bottom	of	the	graph	to	the	total	gas	pressure	value.The	dark	green	area	at	the	bottom	of	the	graph	represents	the	pressures	of	inert	gas	in	each	of	the	16	tissue	compartments,	following	the	Bühlmann	algorithm,	with	fast	tissues	on	the	left	hand	side.The	top	black	horizontal	line	indicates	the	inert	gas	pressure	limit
determined	by	the	gradient	factor	that	applies	to	the	depth	of	the	diver	at	the	particular	point	on	the	Dive	Profile.	The	gradient	factor	shown	is	an	interpolation	between	the	GFLow	and	GFHigh	values	specified	in	the	Ceiling	Display	part	of	the	Tech	setup	Preferences	Panel	of	Subsurface.The	bottom	margin	of	the	red	area	in	the	graph	indicates	the
Bühlman-derived	M-value.	That	is	the	pressure	value	of	inert	gases	at	which	bubble	formation	is	expected	to	be	severe,	resulting	in	a	significant	risk	of	decompression	sickness.These	five	values	are	shown	on	the	left	in	the	image	above.	The	way	the	Gas	Pressure	Bar	Graph	changes	during	a	dive	can	be	seen	on	the	right	hand	side	of	the	above	figure
for	a	diver	using	EAN32.Graph	A	indicates	the	start	of	a	dive	with	the	diver	at	the	surface.	The	pressures	in	all	the	tissue	compartments	are	still	at	the	surface	equilibrium	pressure	because	no	diving	has	taken	place.Graph	B	indicates	the	situation	after	a	descent	to	30	meters.	Few	of	the	tissue	compartments	have	had	time	to	respond	to	the	descent,
so	their	gas	pressures	are	far	below	the	equilibrium	gas	pressure.Graph	C	represents	the	pressures	after	30	minutes	at	30	m.	The	fast	compartments	have	attained	equilibrium	(i.e.	they	have	reached	the	height	of	the	black	line	indicating	the	equilibrium	pressure).	The	slower	compartments	(towards	the	right)	have	not	reached	equilibrium	and	are	in
the	process	of	slowly	increasing	in	pressure.Graph	D	shows	the	pressures	after	ascent	to	a	depth	of	4.5	meters.	Since	during	ascent	the	total	inhaled	gas	pressure	has	decreased	strongly	from	4	bar	to	1.45	bar,	the	pressures	in	the	different	tissue	compartments	now	exceed	that	of	the	total	gas	pressure	and	approach	the	gradient	factor	value	(i.e.	the
top	black	horizontal	line).	Further	ascent	will	result	in	exceeding	the	gradient	factor	value	(GFHigh),	endangering	the	diver.Graph	E	indicates	the	situation	after	remaining	at	4.5	meters	for	10	minutes.	The	fast	compartments	have	decreased	in	pressure.	As	expected,	the	pressures	in	the	slow	compartments	have	not	changed	much.	The	pressures	in
the	fast	compartments	do	not	approach	the	GFHigh	value	any	more	and	the	diver	is	safer	than	in	the	situation	indicated	in	graph	D.Many	dive	computers	record	events	during	a	dive.	For	instance,	most	dive	computers	report	alarms	relating	to	high	partial	pressures	of	oxygen,	to	rapid	ascents	or	the	exceeding	of	no-deco	limits	(NDL).	On	the	other
hand,	other	events	are	classified	as	warnings	and,	for	instance,	occur	when	the	remaining	gas	in	a	cylinder	falls	below	a	predetermined	limit,	a	deep	stop	needs	to	be	performed	or	the	need	to	change	gas	during	multi-cylinder	dives.	Some	dive	computers	also	report	notifications,	e.g.	when	a	safety	stop	is	initiated	or	terminated	or	when	a
predetermined	amount	of	OTUs	have	been	incurred.	The	alarms,	warnings	and	notifications	differs	from	one	dive	computer	to	another:	some	dive	computers	do	not	report	any	of	the	above	events,	while	others	provide	an	extensive	log	of	events.	The	reporting	of	events	is	therefore	a	function	of	the	dive	computer	used.	In	addition,	Subsurface	does	not
always	have	the	ability	to	detect	all	the	events	reported	by	a	specific	dive	computer.Events	are	indicated	by	symbols	on	the	dive	profile.	Notifications	are	shown	as	a	white,	round	symbol	with	a	letter	i;	warnings	are	indicated	by	a	yellow	triangle	and	alarms	by	a	red	triangle.	By	moving	the	cursor	over	a	symbol,	the	explanation	is	given	in	the	bottom-
most	line	of	the	Information	Box	(see	image	below,	where	the	cursor	is	positioned	over	the	alarm	that	was	reported).Some	dive	computers	report	bookmarks	that	the	diver	has	set	during	the	dive.	These	are	indicated	as	a	small	red	flag	on	the	profile	and	are	discussed	more	fully	in	the	section	on	inserting	bookmarks.The	dive	profile	can	include	graphs
of	the	partial	pressures	of	O2,	N2,	and	He	during	the	dive	(see	figure	above)	as	well	as	a	calculated	and	dive	computer	reported	deco	ceilings	(only	visible	for	deep,	long,	or	repetitive	dives).	Partial	pressures	of	oxygen	are	indicated	in	green,	nitrogen	in	black,	and	helium	in	dark	red.	These	partial	pressure	graphs	are	shown	below	the	profile
data.Show	the	partial	pressure	of	oxygen	during	the	dive.	This	is	shown	below	the	dive	depth	and	water	temperature	graphs.Show	the	partial	pressure	of	nitrogen	during	the	dive.Display	of	the	partial	pressure	of	helium	during	the	dive.	This	is	only	important	to	divers	using	Trimix,	Helitrox	or	similar	breathing	gases.The	air	consumption	graph
displays	the	tank	pressure	and	its	change	during	the	dive.	The	air	consumption	takes	depth	into	account	so	that	even	when	manually	entering	the	start	and	end	pressures	the	graph,	is	not	a	straight	line.	Like	the	depth	graph,	the	slope	of	the	tank	pressure	provides	information	about	the	momentary	SAC	rate	(Surface	Air	Consumption)	when	using	an
air	integrated	dive	computer.	Here	the	color	coding	is	not	relative	to	some	absolute	values	but	relative	to	the	mean	normalized	air	consumption	during	the	dive.	So	areas	in	red	or	orange	indicate	times	of	increased	normalized	air	consumption	while	dark	green	reflects	times	when	the	diver	was	using	less	gas	than	average.When	in	planner	mode,	the
SAC	is	set	to	be	constant	during	the	bottom	part	of	the	dive	as	well	during	decompression.	Therefore,	when	planning	a	dive,	the	color	is	a	representation	of	the	breathing	gas	density.Clicking	on	the	heart	rate	button	allows	display	of	heart	rate	information	during	the	dive	if	the	dive	computer	was	attached	to	a	heart	rate	sensor.It	is	possible	to	zoom
into	the	profile	graph.	This	is	done	either	by	using	the	scroll	wheel	/	scroll	gesture	of	the	mouse	or	trackpad.	By	default	Subsurface	always	shows	a	profile	area	large	enough	for	at	least	30	minutes	and	30m	(100ft)	–	this	way	short	or	shallow	dives	are	easily	recognizable;	something	free	divers	won’t	care	about.Measurements	of	depth	or	time
differences	can	be	achieved	by	using	the	ruler	button	on	the	left	of	the	dive	profile	panel.	The	measurement	is	done	by	dragging	the	red	dots	to	the	two	points	on	the	dive	profile	that	you	wish	to	measure.	Information	is	then	given	in	the	horizontal	white	area	underneath	the	two	red	dots.Photographs	and	videos	that	have	been	added	to	a	dive	can	be
shown	on	the	profile	by	selecting	the	Show-media	button.	The	position	of	a	photo	or	video	on	the	profile	shows	the	exact	time	when	it	was	taken.	The	runtime	of	videos	is	represented	by	a	bar	if	Subsurface	was	able	to	extract	this	information	from	the	video	file.	If	this	button	is	not	active,	the	media	are	hidden.The	profile	can	also	include	the	dive
computer	reported	ceiling	(more	precisely,	the	deepest	deco	stop	that	the	dive	computer	calculated	for	each	particular	moment	in	time)	as	a	red	overlay	on	the	dive	profile.	Ascent	ceilings	occur	when	a	direct	ascent	to	the	surface	increases	the	risk	of	a	diver	suffering	from	decompression	sickness	(DCS)	and	it	is	necessary	to	either	ascend	slower	or	to
perform	decompression	stop(s)	before	ascending	to	the	surface.	Not	all	dive	computers	record	this	information	and	make	it	available	for	download;	for	example	none	of	the	Suunto	dive	computers	make	these	data	available	to	divelog	software.	Subsurface	also	calculates	ceilings	independently,	shown	as	a	green	overlay	on	the	dive	profile.	Because	of
the	differences	in	algorithms	used	and	amount	of	data	available	(and	other	factors	taken	into	consideration	at	the	time	of	the	calculation)	it’s	unlikely	that	ceilings	from	dive	computers	and	from	Subsurface	are	the	same,	even	if	the	same	algorithm	and	gradient	factors	(see	below)	are	used.	It’s	also	quite	common	that	Subsurface	calculates	a	ceiling	for
non-decompression	dives	when	the	dive	computer	stayed	in	no-deco	mode	during	the	whole	dive	(represented	by	the	dark	green	section	in	the	profile	at	the	beginning	of	this	section).	This	is	because	Subsurface’s	calculations	describe	the	deco	obligation	at	each	moment	during	a	dive,	while	dive	computers	usually	take	the	upcoming	ascent	into
account.	During	the	ascent	some	excess	nitrogen	(and	possibly	helium)	are	already	breathed	off	so	even	though	the	diver	technically	encountered	a	ceiling	at	depth,	the	dive	still	does	not	require	a	specific	deco	stop.	This	feature	lets	dive	computers	offer	longer	non-stop	bottom	times.Strictly	speaking,	the	green	calculated	ceiling	is	a	direct
representation	of	the	inert	gas	loadings	of	the	simulated	tissues	only	and	is	independent	of	any	assumed	ascent	velocities.	It	indicates	the	deco	model’s	minimal	allowed	depth	at	this	instant	of	time	given	the	inert	gas	loadings	and	is	not	a	statement	about	a	possible	ascent	schedule	in	the	remaining	dive.	To	obtain	the	latter,	use	the	"Edit	dive	in
planner"	option	from	the	Log	menu.If	the	dive	computer	itself	calculates	a	ceiling	and	makes	it	available	to	Subsurface	during	upload	of	dives,	this	can	be	shown	as	a	red	area	by	checking	Dive	computer	reported	ceiling	button	on	the	Profile	Panel.If	the	Calculated	ceiling	button	on	the	Profile	Panel	is	clicked,	then	a	ceiling,	calculated	by	Subsurface,	is
shown	in	green	if	it	exists	for	a	particular	dive	(A	in	figure	below).	This	setting	can	be	modified	in	two	ways:If,	in	addition,	the	show	all	tissues	button	on	the	Profile	Panel	is	clicked,	the	ceiling	is	shown	for	the	tissue	compartments	following	the	Bühlmann	model	(B	in	figure	below).If,	in	addition,	the	3m	increments	button	on	the	Profile	Panel	is	clicked,
then	the	ceiling	is	indicated	in	3	m	increments	(C	in	figure	below).Gradient	Factor	settings	strongly	affect	the	calculated	ceilings	and	their	depths.	For	more	information	about	Gradient	factors,	see	the	section	on	Gradient	Factor	Preference	settings.	The	currently	used	gradient	factors	(e.g.	GF	35/75)	are	shown	above	the	depth	profile	if	the
appropriate	toolbar	buttons	are	activated.	N.B.:	The	indicated	gradient	factors	are	NOT	the	gradient	factors	in	use	by	the	dive	computer,	but	those	used	by	Subsurface	to	calculate	deco	obligations	during	the	dive.	For	more	information	external	to	this	manual	see:By	selecting	this	icon,	the	different	cylinders	used	during	a	dive	can	be	represented	as	a
colored	bar	at	the	bottom	of	the	Dive	Profile.	In	general	oxygen	is	represented	by	a	green	bar,	nitrogen	a	yellow	bar	and	helium	a	red	bar.	The	image	below	shows	a	dive	which	first	uses	a	trimix	cylinder	(red	and	green),	followed	by	a	switch	to	a	nitrox	cylinder	(yellow	and	green)	after	23	minutes.	Cylinders	with	air	are	shown	as	a	light	blue
bar.Display	the	tissue	heat-map.	The	heat	map	summarizes,	for	the	duration	of	the	dive,	the	inert	gas	tissue	pressures	for	each	of	the	16	tissue	compartments	of	the	Bühlmann	model.	Blue	colors	mean	low	gas	pressures	in	a	tissue	compartment	and	thus	on-gassing,	green	to	red	means	excess	gas	in	the	tissue	and	thus	off-gassing.	Fast	to	slow	tissues
are	indicated	from	top	to	bottom.	The	figure	below	explains	in	greater	detail	how	the	heat	map	can	be	interpreted.Image	A	on	the	left	shows	the	Gas	Pressure	Graph	in	the	Information	box,	representing	a	snapshot	of	inert	gas	pressures	at	a	particular	point	in	time	during	the	dive.	The	inert	gas	pressures	of	16	tissue	compartments	are	shown	as	dark
green	vertical	bars	with	the	quick	tissue	compartments	on	the	left	and	the	slow	tissue	compartments	on	the	right.	Refer	to	the	section	on	the	Gas	Pressure	Graph	for	more	details	on	the	different	elements	of	this	graph.Image	B	shows	a	gradient	of	unique	colors,	spanning	the	whole	range	of	inert	gas	pressures.	It	is	possible	to	map	the	height	of	each
of	the	dark	green	vertical	bars	of	A	to	a	color	in	B.	For	instance,	the	fastest	(leftmost)	dark	green	vertical	bar	in	A	has	a	height	corresponding	to	the	medium	green	part	of	B.	The	height	of	this	bar	can	therefore	be	summarized	using	a	medium	green	color.	Similarly,	the	highest	dark	green	bar	in	A	is	as	high	as	the	yellow	part	of	B.	The	14	remaining
tissue	pressure	bars	in	A	can	also	be	translated	to	colors.	The	colors	represent	three	ranges	of	tissue	inert	gas	pressure:The	bottom	range	in	B	(marked	On-gassing)	includes	colors	from	light	blue	to	black,	representing	tissue	gas	pressures	below	the	equilibrium	pressure	of	inert	gas	(bottom	horizontal	line	in	A).	The	measurement	unit	is	the	%	of	inert
gas	pressure,	relative	to	the	equilibrium	inert	gas	pressure.	In	this	range	on-gassing	of	inert	gas	takes	place	because	the	inert	gas	pressure	in	the	tissue	compartment	is	lower	than	in	the	surrounding	environment.	Black	areas	in	the	heat	map	indicate	that	a	tissue	compartment	has	reached	the	equilibrium	inert	gas	pressure,	i.e.	the	inert	gas	pressure
in	the	tissue	compartment	equals	that	of	the	water	in	which	the	diver	is.	The	equilibrium	pressure	changes	according	to	depth.The	central	range	in	B	includes	the	colors	from	black	to	light	green,	when	the	inert	gas	pressure	of	a	tissue	compartment	is	higher	than	the	equilibrium	pressure	but	less	than	the	ambient	pressure.	In	this	zone	decompression
is	not	very	efficient	because	the	gradient	of	inert	gas	pressure	from	tissue	to	the	environment	is	relatively	small	and	indicated	by	dark	green	areas	of	the	heat	map.The	top	range	in	B	(marked	Off-gassing)	includes	colors	from	light	green	to	red	and	white,	representing	tissue	gas	pressures	above	that	of	the	total	ambient	pressure	(top	of	light	green
area	of	A).	The	measurement	unit	is	the	%	of	inert	gas	pressure	above	ambient	pressure,	relative	to	the	Bühlmann	M-value	gradient	(bottom	of	red	area	in	A).	These	tissue	pressures	are	normally	reached	while	ascending	to	a	shallower	depth.	Below	a	value	of	100%,	this	range	indicates	efficient	off-gassing	of	inert	gas	from	the	tissue	compartment	into
the	environment.	Usually,	efficient	off-gassing	is	indicated	by	light	green,	yellow	or	orange	colors.	Above	100%	(red	to	white	in	B)	the	M-value	gradient	is	exceeded	and	the	probability	of	decompression	sickness	increases	markedly.Image	C	shows	the	color	mapping	of	each	of	the	vertical	bars	in	A,	the	fast	tissues	(on	the	left	in	A)	depicted	at	the	top
and	the	slow	tissue	compartments	at	the	bottom	of	C.	The	highest	vertical	bar	in	A	(vertical	bar	3rd	from	the	left)	is	presented	as	the	yellow	rectangle	3rd	from	the	top	in	C.	The	16	vertical	bars	in	A	are	now	presented	as	a	vertical	column	of	16	colored	rectangles,	representing	a	snapshot	of	tissue	compartment	gas	pressures	at	a	particular	instant
during	the	dive.Image	D	is	a	compilation	of	similar	color	mappings	of	16	tissue	compartments	during	a	10-minute	period	of	a	dive,	the	colors	representing	the	inert	gas	loading	of	a	tissue	compartment	at	a	point	in	time	during	the	dive.	Faster	tissues	are	shown	at	the	top	and	slower	tissues	at	the	bottom,	with	time	forming	the	horizontal	axis	of	the
graph.	The	column	of	rectangles	in	C	can	be	found	on	the	horizontal	axis	between	9	and	10	minutes.The	colors	of	the	heat	map	are	not	affected	by	the	gradient	factor	settings.	This	is	because	the	heat	map	indicates	tissue	pressures	relative	to	the	Bühlmann	M-value	gradient,	and	not	relative	to	any	specific	gradient	factor.	For	more	information
external	to	this	manual	see:Understanding	M-values	by	Erik	Baker,	Immersed	Vol.	3,	No.	3.Since	the	colors	of	the	heat	map	are	not	affected	by	the	gradient	factor(s),	the	heat	map	is	also	applicable	when	using	the	VPM-B	decompression	model.The	image	below	compares	the	profiles	and	heat	maps	for	two	planned	decompression	dives	to	60m:	the
first	using	the	Bühlmann	decompression	model,	the	second	using	the	VPM-B	decompression	model.	Both	profiles	have	the	same	total	decompression	time,	but	the	VPM-B	model	requires	deeper	stops	early	in	the	ascent	phase.In	both	profiles,	the	inert	gas	pressures	in	the	faster	tissues	rise	much	more	rapidly	than	the	slower	tissues	during	the	descent
and	bottom	phase,	with	the	colors	transitioning	from	light	blue	through	blue	and	purple	to	black.	Similarly,	the	inert	gas	pressure	in	the	fast	tissues	reduces	more	rapidly	than	the	slow	tissues	at	each	decompression	stop,	with	colors	transitioning	from	red,	orange	and	yellow	to	green	and	black.The	comparison	of	the	two	profiles	and	heatmaps	shows
that	by	including	deep	stops,	the	oversaturation	gradient	in	the	faster	tissues	early	in	ascent	phase	is	reduced.	However,	on-gassing	of	slower	tissues	continues	during	the	deep	stops,	which	leads	to	greater	oversaturation	gradient	in	slower	tissues	at	the	end	of	the	dive.The	context	menu	for	the	Dive	Profile	is	accessed	by	right-clicking	while	the
mouse	cursor	is	over	the	Dive	Profile	panel.	The	menu	allows	creating	Bookmarks,	Gas	Change	Event	markers,	or	manual	CCR	set-point	changes	other	than	the	ones	that	might	have	been	imported	from	a	Dive	Computer.	Markers	are	placed	against	the	depth	profile	line,	with	the	time	of	the	event	determined	by	the	mouse	cursor	when	the	right	mouse
button	was	clicked	to	bring	up	the	menu.	Gas	Change	events	involve	a	selection	of	which	gas	is	being	switched	TO.	The	list	of	choices	is	based	on	the	available	gases	defined	in	the	Equipment	Tab.	Setpoint	change	events	open	a	dialog	letting	you	choose	the	next	setpoint	value.	As	in	the	planner,	a	setpoint	value	of	zero	shows	the	diver	is	breathing
from	an	open	circuit	system	while	any	non-zero	value	shows	the	use	of	a	closed	circuit	rebreather	(CCR).	By	right-clicking	while	over	an	existing	marker	a	menu	appears,	adding	options	to	allow	deletion	of	the	marker,	or	to	allow	all	markers	of	that	type	to	be	hidden.	Hidden	events	can	be	restored	to	view	by	selecting	Unhide	all	events	from	the
context	menu.The	dives	in	the	Dive	List	can	be	filtered,	selecting	only	some	of	the	dives	based	on	attributes	such	as	dive	tags,	dive	site,	divemaster	or	buddy.	For	instance,	filtering	lets	you	list	the	dives	during	a	particular	year	at	a	specific	dive	site,	or	otherwise	the	cave	dives	with	a	particular	buddy.	Filtering	can	be	performed	based	on	virtually	any
information	in	the	Info	panel.To	open	the	filter,	select	Log	→	Filter	divelist	from	the	main	menu.	This	replaces	the	Dive	Map	Panel	with	a	Filter	Panel.	The	top	window	bar	contains	the	number	of	dives	that	satisfy	the	current	criteria	of	the	filter	(see	image	below).By	default	a	full-text	specification	for	filtering	is	shown.	For	instance,	if	one	typed	the
word	"shark"	into	the	Full-text	box,	all	dives	are	shown	that	have	the	word	"shark"	in	any	of	the	text	fields	in	the	Info	panel,	including	the	Notes,	the	Tags	and	Location.	One	can	select	whether	the	search	phrase	(e.g.	"shark")	must	be	a	complete	word,	the	starting	part	of	a	word	(e.g.	"SharkLife")	or	any	part	of	a	word	(e.g.	"whalesharks").	See	the
image	below.However,	filtering	can	be	performed	in	a	much	more	precise	way	by	adding	constraints	to	the	filter	panel.	Clicking	the	Load	Constraints	button	(located	near	the	top	left-hand	of	the	filter	panel)	brings	up	a	list	of	the	terms	that	could	be	selected	for	filtering	the	Dive	List.For	instance,	selecting	the	constraint	"Location"	from	this	list	adds	a
line	to	the	filter	panel	for	specifying	the	location	constraint.	For	instance,	typing	"Sodwana"	into	the	Locality	text	box	brings	up	all	the	dives	for	which	the	dive	location	was	given	as	Sodwana.	There	are	two	combo-boxes	associated	with	the	Location	constraint.	Selecting	"is	not"	from	the	first	combobox	allows	showing	all	the	dives	that	were	NOT
performed	at	Sodwana.	The	second	combobox	operates	in	a	similar	way	to	that	of	the	Full-text	filter	as	described	above	(first	part	of	word,	complete	word,	contains-word).	Constraints	can	be	refined	in	one	of	two	ways:Filtering	dives	at	more	than	one	site:	I	may	wish	to	list	dives	at	Sodwana	as	well	as	at	Aliwal	(a	logical	OR	operation).	In	this	case	type
both	dive	sites	into	the	text	box,	separated	by	a	comma	(see	image	below).Filtering	some	dive	at	a	dive	site:	I	may	wish	to	list	only	the	dives	at	2	Mile	Reef	at	Sodwana.	However	the	way	I	entered	the	dive	locations	for	dives	was	not	consistent	(some	cases	"2	Mile	Reef	Sodwana",	other	cases	"Sodwana	2	mile	reef").	In	that	case	add	a	Location
constraint,	select	"with	substring"	from	the	combobox	and	specify	"Sodwana".	Then	add	a	second	Location	constraint,	select	"with	substring"	from	the	combobox	and	type	"2	mile	Reef")	in	the	location	text	box	(see	image	below).	This	is	a	logical	AND	operation.	The	same	principles	apply	to	all	constraints	selectable	from	the	constraints	list.We	may
wish	to	refine	our	selection	of	dives	to	show	in	the	Dive	List.	Let’s	say	we	wish	to	show	dives	for	which	the	water	temperature	was	18	°C	or	higher.	Select	"Water	Temp."	from	the	list	of	constraints.	A	line	containing	this	new	constraint	is	added	to	the	filter	panel.	Select	"at	least"	from	the	combobox	on	this	line	and	type	"18"	in	the	appropriate	text	box.
Below	is	an	image	with	constraints	defined	to	filter	dives	at	Sodwana	with	water	temperatures	at	18	°C	or	higher.In	order	to	refine	our	filter	we	may	wish	to	show	only	dives	on	a	Tuesday.	Select	"week	day"	from	the	list	of	constraints.	A	line	containing	this	new	constraint	is	added	to	the	filter	panel	with	a	dropdown	list	of	days	that	are	selectable.
Select	"Tuesday"	from	the	list.	The	image	below	shows	a	filter	that	selects	dives	at	Sodwana	on	Tuesdays	with	the	water	temperature	at	or	above	18	°C.As	a	last	step	in	refining	our	filter	we	may	wish	to	add	another	constraint	specifying	visibility	of	at	least	three	stars.	Select	"visibility"	from	the	list	of	constraints.	A	new	line	is	added	to	the	filter	panel,
allowing	us	to	select	the	number	of	stars	we	require.	In	this	case	click	on	the	third	star	and	ensure	that	the	combobox	shows	"at	least".	We	have	now	filtered	for	all	dives	at	Sodwana	on	a	Tuesday	with	water	temperature	at	or	above	18	°C	and	with	a	3-star	or	better	visibility.Clearly	it	is	possible	to	construct	highly	refined	filters.	The	examples	above
show	only	a	tiny	fraction	of	the	possibilities	in	creating	filters.Deleting	a	constraint:	A	constraint	can	be	removed	from	the	filter	by	clicking	the	appropriate	dustbin	icon	on	the	left	of	the	filter	panel.We	need	to	define	a	new	term:	"Filter	sets".	A	"Filter	set"	is	a	combination	of	constraints	that	have	been	defined	to	form	a	filter,	as	in	our	example	above.
Specifying	a	filter	set	(as	above)	can	take	some	time	and	experimentation,	and	we	may	wish	to	save	this	set	for	later	use.	Save	the	set	by	clicking	the	button	"Save	set".	A	text	box	opens	to	provide	a	name	for	this	set.	Provide	a	set	name,	click	the	OK	button	and	the	set	is	now	permanently	saved	as	part	of	the	overall	dive	log.If	you	wish	to	access	the
filter	set	on	a	later	date,	click	the	button	"Load	set".	This	provides	a	list	of	sets	that	have	been	saved.	Select	the	set	you	wish	to	use.	It	is	loaded	into	the	filter	panel,	showing	the	name	of	the	set	in	the	top	line	of	the	panel	immediately	following	"Current	set:"Filter	sets	can	be	deleted	by	selecting	the	"Filter	sets"	tab	in	the	Filter	Panel	and	by	clicking
on	the	dustbin	icon	on	the	left	of	the	appropriate	filter	set	name.The	filter	action	can	only	be	stopped	by	using	the	Reset	button	(yellow	up-arrow)	or	by	manually	deleting	any	full-text	specification	as	well	as	all	the	constraints	with	associated	dustbin	icons.	Closing	the	Filter	Panel	does	not	terminate	filtering:	the	filtered	dive	list	remains	unchanged.
This	is	obvious	from	the	top	bar	of	the	Subsurface	window	indicating	that	only	some	of	all	the	dives	are	shown.	Closing	the	Filter	Panel	activates	the	Map	Panel,	allowing	viewing	the	map	locations	of	the	filtered	dive	list.	For	instance	one	might	wish	to	filter	on	Bob	Smith	as	a	buddy.	Closing	the	Filter	Panel	allows	viewing	the	map	locations	where	Bob
Smith	was	a	buddy.	To	re-open	the	Filter	Panel	in	this	case,	select	Log	→	Filter	divelist	from	the	Main	Menu.	To	switch	off	filtering	and	exit	the	Filter	Panel,	click	on	Reset	and	then	on	Close.Creating	meaningful	statistics	that	convey	the	information	you	are	looking	for	is	surprisingly	hard.	Different	users	have	very	different	needs	and	very	different
expectations.	Subsurface	provides	a	rather	detailed	set	of	statistics	features	to	summarize	information	from	the	dive	log	in	a	graphical	way.	To	access	the	dive	statistics	tool,	select	Main	Menu	→	View	→	Dive	Statistics.	This	tool	is	so	flexible	that	it	is	impossible	to	cover	every	possible	use	case.	Rather,	we	provide	a	conceptual	introduction,	followed	by
specific	examples.	The	tool	can	be	closed	using	the	Close	button	at	the	top	left.	The	Statistics	tool	has	four	panels	(see	image	below):A	setup	panel	containing	comboboxes	for	requesting	a	graph	(top	left).The	graph	that	has	been	requested	(top	right).The	Filter	panel	(bottom	right).The	Dive	List,	reflecting	the	dives	or	dive	trips	included	in	the	analysis
(bottom	left).By	default,	when	the	Statistics	panel	is	opened,	a	histogram	is	shown	of	the	number	of	dives	performed	each	year.	This	is	an	example	of	counts	data.	To	request	a	graph	representing	counts,	three	comboboxes	need	to	be	set:a)	The	top	combobox	of	the	Base	variable	needs	to	be	specified.	Which	variable	should	be	along	the	horizontal
axis?	Examples	are	Year,	Buddy,	Rating,	Max.	depth.b)	The	binning	combobox	for	the	Base	variable	needs	to	be	specified.	This	represents	the	increment	for	each	bar	along	the	horizontal	axis.	For	instance,	when	counts	of	number	of	dives	are	extracted	for	years,	this	could	be	in	increments	of	a	year,	a	quarter	(3	month	period)	or	a	month.	For	some
variables,	e.g.	Buddy	or	Rating,	a	binning	value	is	not	relevant	and	cannot	be	selected.	However,	for	others,	e.g.	Year	or	Max.	depth,	selecting	the	appropriate	binning	is	important.c)	For	simple	counts	data,	the	top	combobox	of	the	Data	variable	needs	to	be	set	to	"none".	This	is	because	a	data	variable	is	not	involved	in	this	type	of	graph.	Divers	used
to	spreadsheets	may	prefer	a	pie	chart	for	these	data,	achieved	by	selecting	"Categorical/piechart"	from	the	Chart	combobox.	It	is	possible	to	simultaneously	provide	counts	for	two	variables.	In	this	case	one	could	specify	a	Data	variable	which	results	in	the	counts	being	subdivided	according	to	the	data	variable.	This	option	does	not	have	a	piechart
equivalent.	Detailed	information	for	each	bar	can	be	obtained	by	hovering	the	mouse	over	the	the	appropriate	bar.For	simple	histograms,	the	default	height	of	each	bar	is	determined	by	the	mean	value	for	the	observations	included	in	each	bar.	However,	this	can	be	manipulated	using	the	Operation	combobox	to	show	the	mean,	maximum,	minimum,
median	and	sum	applicable	to	each	bar.	Image	A	below	shows	quarterly	count	data	of	dives	while	image	B	shows	quarterly	count	data,	subdivided	by	dive	mode	(some	dives	open	circuit,	other	dives	rebreather).	The	mouse	is	positioned	over	a	specific	bar	to	provide	detailed	information.	The	legend	can	be	dragged	around	so	that	it	does	not	obscure
part	of	the	graph.	Alternatively,	the	legend	can	be	removed	by	deselecting	the	appropriate	checkbox	at	the	bottom	left	of	the	setup	panel.Sometimes	you	might	wish	to	investigate	the	relationship	between	two	dive	variables.	Has	my	SAC	rate	decreased	over	the	years?	Is	the	water	temperature	colder	at	greater	dive	depth?	One	of	the	ways	of
investigating	these	questions	is	to	draw	a	scattergraph	where	the	values	of	one	variable	is	plotted	against	the	other	variable	(see	image	below).For	the	dataset	in	the	above	image,	the	SAC	rate	appears	to	have	decreased	over	time.	If	the	"linear	regression"	checkbox	is	marked,	a	red	line	is	shown	that	summarizes	the	best	estimate	of	the	relationship
between	SAC	rate	and	year.	In	this	graph	it	appears	that	SAC	rate	has	decreased	from	around	21	l/min	to	around	14	l/min	between	2013	and	2021.	The	pink	area	around	the	red	line	indicates	the	uncertainty	of	the	precise	orientation	of	the	line.	The	line	is	expected	to	lie	somewhere	within	the	pink	area	with	a	certainty	of	95%.	The	intensity	of	the
pink	color	also	indicates	the	relative	reliability	of	these	estimates.	The	procedure	for	obtaining	a	scattergraph	is:a)	Specify	the	Base	variable:	Which	variable	should	be	along	the	horizontal	axis?	Examples	are	Date,	Temperature,	Max.	depth,	SAC	rate.b)	Set	the	binning	value	for	the	Base	variable	to	"none".c)	Specify	the	Data	variable:	Which	variable
should	be	along	the	vertical	axis?Within	the	scattergraph,	hover	over	a	specific	point	to	see	more	information	for	that	point.You	might	also	wish	to	compare	different	categories	of	dives.	Is	the	(5-star)	Rating	of	a	dive	related	to	water	temperature?	Is	my	SAC	rate	related	to	diving	with	different	dive	suits?	Since	dive	suit	and	Rating	are	categories,	a
scattergraph	is	not	appropriate.	The	default	is	a	categorical	dot	graph,	which,	in	the	case	of	image	A	below,	shows	the	precise	water	temperatures	for	each	Rating.	The	red	lines	indicate	the	top	quartile,	the	mean	and	the	lower	quartile	of	temperature	for	each	rating.	The	column	with	no	star	indicates	dives	for	which	a	Rating	has	not	been	selected.	It
appears	that	dives	with	a	5-star	rating	have	higher	temperatures	that	the	other	ratings.	To	obtain	a	categorical	graph:a)	Select	a	variable	with	categories	(along	the	horizontal	axis)	as	a	Base	variable.b)	Select	the	data	variable	and	set	binning	to	"none".c)	By	default	the	Chart	combobox	shows	"Categorical/data	points".	If	this	is	not	the	case,	select	this
value.Alternatively	you	could	create	a	Box-whisker	graph	for	the	same	data.	In	the	Chart	combobox,	select	"Categorical/box-whisker".	This	creates	a	graph	indicating	the	maximum,	top	quartile	(Q3),	median,	bottom	quartile	(Q1)	and	minimum	for	each	category	or	class.	Image	B	above	shows	a	box-whisker	graph	for	the	same	data	as	image	A	above.
You	can	see	that	the	values	for	a	Rating	of	5	stars	tend	to	be	higher	than	for	other	ratings.	Hover	over	a	box	to	see	more	complete	information	for	that	box.As	explained	in	the	section	above	on	counts	data,	bar-charts	showing	a	breakdown	of	each	category	for	a	number	of	subcategories	is	easy	(images	below).a)	Select	a	variable	with	categories	(along
the	horizontal	axis)	as	a	Base	variable	(e.g.	dive	mode	or	suite	type).b)	Select	another	category	of	data	as	a	Data	variable	(e.g.	gas	type	or	cylinder	type).The	images	below	show	two	alternative	bar-chart	representations.	If,	in	the	Chart	combobox,	one	selects	"Barchart/stacked	vertical",	a	graph	similar	to	image	A	below	is	generated.	This	summarized
a	log	of	technical	dives	where,	for	each	cylinder	gas	type,	the	bar	is	subdivided	into	a	count	for	open-circuit	dives	and	for	rebreather	dives.	On	the	other	hand,	if	"Barchart/grouped	vertical"	is	selected	in	the	Chart	combobox,	a	graph	similar	to	image	B,	below,	is	produced.	Here	the	subdivision	within	each	gas	type	is	shown	as	adjacent	bars.Bar-charts
can	be	rotated	by	90	degrees	by	selecting	the	appropriate	chart	type	in	the	Chart	combobox.	For	instance,	here	is	the	horizontal	bar-chart	produced	when	selecting	"Barchart/stacked	horizontal"	in	the	Chart	combobox	and	using	the	same	dataset	as	in	the	graph	above.	This	is	useful	if	the	labels	for	different	bars	are	long,	preventing	them	being
displayed	with	vertical	bar	charts.Let’s	say	you	are	viewing	a	bar	graph	showing	mean	maximum	dive	depth	for	different	years.	However	two	of	the	years	have	dive	depth	values	that	appear	atypical	and	you	wish	to	inspect	the	dives	only	for	those	two	years.	The	obvious	approach	is	to	use	the	Filter	tool	to	select	only	data	for	the	two	years	of	interest
and	then	view	those	data	using	the	Statistics	panel.	However,	Subsurface	provides	a	rapid	mechanism	of	selecting	the	appropriate	subset	of	data	using	your	mouse.	In	the	above	example	of	a	bar	graph,	select	the	bars	for	the	two	years	of	interest	by	clicking	on	them	and	activate	the	"Restrict	to	selection"	button	towards	the	bottom	left	of	the	Statistics
panel.	This	displays	only	the	data	for	the	two	bars	that	have	been	selected.	This	restricted	subset	can	now	be	analyzed	using	all	the	options	in	the	Statistics	panel.	Below	is	a	scattergraph	for	a	number	of	dives,	showing	the	water	temperature	for	different	dive	depths.Let’s	say	you	wish	to	analyze	only	dives	at	tropical	dive	sites,	defined	by
temperatures	above	22°C	and	depths	less	than	60m.	Select	the	appropriate	dives	by	dragging	your	mouse	across	the	scattergraph	(see	image	above)	and	restrict	the	data	by	activating	the	"Restrict	to	selection"	button.	Now	only	the	selected	subset	of	points	is	shown	on	the	graph.	You	can	now	select	Base	and	Data	variables	to	further	analyze	the
restricted	data.	The	graph	below	shows	the	SAC	rates	as	a	function	of	dive	depth	for	the	restricted	dataset	created	above.	The	graph	shows	that	SAC	rate	was	more	or	less	constant	(around	15	l/min)	for	all	dive	depths	at	tropical	dive	sites.The	ability	to	rapidly	create	subsets	of	data	for	display	(using	the	restriction	tool)	creates	a	powerful	mechanism
to	do	rapid	but	detailed	analysis	of	a	dive	log.After	creating	a	data	subset,	The	text	in	the	restriction	tool	indicates	the	number	of	dives	in	the	subset	that	has	been	selected.	Note,	in	the	figure	above,	that	a	previously	greyed-out	button,	"Reset	restriction",	has	been	made	active	after	restricting	the	data	for	graphing.	The	original	dataset	can	be	restored
by	clicking	the	"Reset	restriction"	button.	The	text	in	the	restriction	tool	now	shows	"Analyzing	all	dives".Several	actions	on	either	a	single	dive,	or	a	group	of	dives,	can	be	performed	using	the	Dive	List	Context	Menu.	It	is	found	by	selecting	either	a	single	dive	or	a	group	of	dives	and	then	right-clicking.The	context	menu	is	used	in	many	functions
described	below.The	default	information	in	the	Dive	List	includes,	for	each	dive,	Dive_number,	Date,	Rating,	Dive_depth,	Dive_duration	and	Dive_location.	This	information	can	be	controlled	and	changed	by	right-clicking	on	the	header	bar	of	the	Dive	List,	bringing	up	a	list	of	columns	that	can	be	shown	in	the	dive	list	(see	above).	Check	an	items	to	be
included	in	the	Dive	List.	The	list	is	immediately	updated.	Preferences	for	information	shown	in	the	Dive	List	are	saved	and	used	when	Subsurface	is	re-opened.By	selecting	the	Media	checkbox	in	the	dropdown	list,	an	icon	is	shown	indicating	whether	any	media	are	associated	with	a	particular	dive.	There	are	three	icons:This	dive	has	photographs	or
videos	taken	during	the	dive,	typically	using	an	underwater	camera.This	dive	has	photographs	or	videos	taken	immediately	before	or	immediately	after	the	dive.	This	is	useful	for	finding	photos/media	of	dive	teams	or	boats	just	before/after	the	dive,	whales	or	other	surface	animals	seen	just	before	or	after	the	dive,	or	of	landscapes	as	seen	from	the
boat.This	dive	has	photographs	or	videos	taken	both	during	the	dive	and	immediately	before	or	after	the	dive.Dives	are	normally	numbered	incrementally	from	non-recent	dives	(low	sequence	numbers)	to	recent	dives	(higher	sequence	numbers).	Numbering	of	dives	is	not	always	consistent.	For	instance,	when	non-recent	dives	are	added,	correct
numbering	does	not	automatically	follow	on	because	of	the	dives	that	are	more	recent	in	date/time	than	the	newly-added	dive	with	an	older	date/time.	This	requires	renumbering	the	dives.	Do	this	by	selecting	(from	the	Main	Menu)	Log	→	Renumber.	Provide	the	lowest	sequence	number	to	be	used.	This	results	in	new	sequence	numbers	(based	on
date/time)	for	all	the	dives	in	the	Dive	List	panel.Renumber	a	few	selected	dives	in	the	dive	list	by	selecting	only	the	dives	that	need	renumbering.	Right-click	on	the	selected	list	and	use	the	Dive	List	Context	Menu	to	perform	the	renumbering.	A	popup	window	appears	letting	the	user	specify	the	starting	number	for	the	process.For	regular	divers,	the
dive	list	can	rapidly	become	very	long.	Subsurface	can	group	dives	into	trips.	It	does	this	by	grouping	dives	that	have	date/times	not	separated	by	more	than	two	days	and	creating	a	single	heading	for	each	diving	trip	represented	in	the	dive	log.	Below	is	an	ungrouped	dive	list	(A,	on	the	left)	as	well	as	the	corresponding	grouped	dive	list	of	five	dive
trips	(B,	on	the	right):Grouping	into	trips	allows	a	rapid	way	of	accessing	individual	dives	without	having	to	scan	a	long	lists	of	dives.	To	group	the	dives	in	a	dive	list,	(from	the	Main	Menu)	select	Log	→	Auto	group.	The	Dive	List	panel	now	shows	only	the	titles	for	the	trips.Normally,	in	the	dive	list,	minimal	information	is	included	in	the	trip	title.	More



information	about	a	trip	can	be	added	by	selecting	its	trip	title	bar	from	the	Dive	List.	This	shows	a	Trip	Notes	tab	in	the	Notes	panel.	Here	you	can	add	or	edit	information	about	the	date/time,	the	trip	location	and	any	other	general	comments	about	the	trip	as	a	whole	(e.g.	the	dive	company	that	was	used,	the	general	weather	and	surface	conditions
during	the	trip,	etc.).	After	entering	this	information,	select	Save	from	the	buttons	at	the	top	right	of	the	Trip	Notes	tab.	The	trip	title	in	the	Dive	List	panel	should	now	reflect	the	edited	information.Once	the	dives	have	been	grouped	into	trips,	you	can	expand	one	or	more	trips	by	clicking	the	expansion	button	[+/-]	on	the	left	of	each	trip	title.	This
expands	the	selected	trip,	revealing	individual	dives	during	the	trip.After	selecting	a	trip	title,	the	context	menu	allows	the	merging	of	trips	by	either	merging	the	selected	trip	with	the	trip	below	or	with	the	trip	above.	(Merge	trip	with	trip	below;	Merge	trip	with	trip	above)If	a	trip	includes,	for	example,	ten	dives,	you	can	split	this	trip	into	two	trips
(trip	1:	top	four	dives;	trip	2:	bottom	six	dives)	by	selecting	and	right-clicking	the	top	four	dives.	The	resulting	context	menu	lets	the	user	create	a	new	trip	by	choosing	the	option	Create	new	trip	above.	The	top	four	dives	are	then	grouped	into	a	separate	trip.	The	figures	below	show	the	selection	and	context	menu	on	the	left	(A)	and	the	completed
action	on	the	right	(B):Dives	can	be	permanently	deleted	from	the	dive	log	by	selecting	and	right-clicking	them	to	bring	up	the	context	menu,	then	selecting	Delete	dive(s).	Typically	this	would	apply	to	a	case	where	a	user	wishes	to	delete	workshop	calibration	dives	of	the	dive	computer	or	dives	of	extremely	short	duration.You	can	unlink	dives	from
the	trip	to	which	they	belong.	To	do	this,	select	and	right-click	the	relevant	dives	to	bring	up	the	context	menu.	Then	select	the	option	Remove	dive(s)	from	trip.	The	dive(s)	now	appear	immediately	above	or	below	the	trip	to	which	they	belonged,	depending	on	the	date	and	time	of	the	unlinked	dive.Selected	dives	can	be	moved	from	the	trip	to	which
they	belong	and	placed	within	a	separate	trip.	To	do	this,	select	and	right-click	the	dive(s)	to	bring	up	the	context	menu,	and	then	select	Create	new	trip	above.Sometimes	it’s	necessary	to	adjust	the	start	time	of	a	dive.	This	may	apply	to	situations	where	dives	are	done	in	different	time	zones	or	when	the	dive	computer	has	a	wrong	time.	To	do	this,
select	and	right-click	the	dive(s)	to	be	adjusted.	This	brings	up	the	context	menu	on	which	the	Shift	times	option	should	be	selected.	You	must	then	specify	the	time	(in	hours	and	minutes)	by	which	the	dives	should	be	adjusted	and	click	on	the	option	of	whether	the	time	adjustment	should	be	earlier	or	later.Sometimes	a	dive	is	briefly	interrupted,	for
example,	if	a	diver	returns	to	the	surface	for	a	few	minutes,	resulting	in	two	or	more	dives	being	recorded	by	the	dive	computer	and	appearing	as	different	dives	in	the	Dive	List	panel.	Merge	these	dives	onto	a	single	dive	by	selecting	the	appropriate	dives,	right-clicking	them	to	bring	up	the	context	menu	and	then	selecting	Merge	selected	dives.	It
may	be	necessary	to	edit	the	dive	information	in	the	Notes	panel	to	reflect	events	or	conditions	that	apply	to	the	merged	dive.	The	figure	below	shows	the	depth	profile	of	two	dives	that	were	merged:On	some	occasions,	a	diver	reaches	the	surface	and	immediately	dives	again.	However,	it	may	happen	that	the	dive	computer	does	not	register	a	new
dive,	but	continues	the	previous	dive	due	to	the	brief	surface	interval.	In	this	case	it	is	possible	to	split	a	dive	so	that	the	two	dives	are	shown	as	independent	dives	on	the	Dive	List.	If	this	operation	is	performed,	Subsurface	scans	the	selected	dive(s)	and	splits	the	dive	at	points	during	the	dive	where	the	depth	is	less	than	a	meter.Important	actions	on
dives	or	trips,	described	above,	can	be	undone	or	redone.	This	includes:	delete	dives,	merge	dives,	split	selected	dives,	renumber	dives	and	shift	dive	times.	To	do	this	after	performing	any	of	these	actions,	from	the	Main	Menu	select	Edit.	This	brings	up	the	possibility	to	Undo	or	Redo	an	action.The	export	function	can	be	found	by	selecting	File	→
Export,	which	brings	up	the	Export	dialog.	This	dialog	always	gives	two	options:	save	ALL	dives,	or	save	only	the	dives	selected	in	Dive	List	panel	of	Subsurface.	Click	the	appropriate	radio	button	(see	images	below).A	dive	log	or	part	of	it	can	be	saved	in	several	formats:Subsurface	XML	format.	This	is	the	native	format	used	by	Subsurface.Subsurface
dive	sites	XML.	Export	the	dive	sites	in	XML	format.	This	allows	the	sharing	of	dive	sites	with	other	divers	or	software.Universal	Dive	Data	Format	(UDDF).	Refer	to	for	more	information.	UDDF	is	a	generic	format	that	enables	communication	among	many	dive	computers	and	computer	programs.Divelogs.de,	an	Internet-based	dive	log	repository.	In
order	to	upload	to	Divelogs.de,	you	need	a	user-ID	as	well	as	a	password	for	Divelogs.de.	Log	into	and	subscribe	to	this	service	to	upload	dive	log	data	from	Subsurface.DiveShare	is	also	a	dive	log	repository	on	the	Internet	focusing	on	recreational	dives.	To	upload	dives,	you	need	a	user	ID,	so	registration	with	is	required.CSV	summary	dive	details,
that	includes	the	most	critical	information	of	the	dive	profile.	Included	information	of	a	dive	is:	dive	number,	date,	time,	buddy,	duration,	depth,	temperature	and	atmospheric	pressure:	in	short,	most	of	the	information	that	recreational	divers	enter	into	handwritten	log	books.	It	does	not	include	the	dive	profile.CSV	Dive	computer	dive	profile,	that
includes	a	large	amount	of	detail	for	each	dive,	including	the	depth	profile,	temperature	and	pressure	information	of	each	dive.	The	source	of	the	data	being	saved	are	the	data	as	downloaded	from	your	dive	computer.CSV	Computer	Profile	Panel	data.	This	option	exports	the	information	presented	in	the	Profile	Panel.	The	Profile	panel	contains	many
calculated	and	interpolated	values,	e.g.	SAC,	cylinder	pressure,	decompression	ceilings,	gas	partial	pressures	and	interpolated	depths.	These	data	therefore	differ	from	the	raw	dive	information	imported	from	a	dive	computer.	This	export	option	is	primarily	intended	to	be	accessible	to	external	software	for	further	processing	of	the	Profile	Panel
information.Dive	profile,	which	enables	easy	sharing	of	the	dive	profile	using	social	media.	This	option	writes	the	image	of	the	dive	profile(s)	in	a	.png	graphics	format	to	the	folder	specified	in	the	File	save	dialog.	The	saved	image	looks	exactly	like	the	on-screen	profile,	so	ensure	that	all	the	appropriate	profile	toolbar	options	are	activated.	If	several
dives	are	selected,	the	images	are	written	as	separate	graphics	files.	Selecting	the	Dive	profile	option	opens	a	window	to	name	the	file(s)	to	which	the	profile(s)	is	written.	Provide	a	filename	and	select	Save	to	create	the	graphics	output.Worldmap	format,	an	HTML	file	with	a	world	map	upon	which	each	dive	and	some	information	about	it	are
indicated.	This	map	is	not	editable.	If	you	select	any	of	the	dive	sites	on	the	map,	a	summary	of	the	dive	is	available	in	text,	as	shown	in	the	image	below.TeX	format,	a	file	for	printing	using	the	TeX	typesetting	software.	Choose	a	filename	with	a	.tex	extension.	You	will	also	need	a	template	file,	that	can	be	obtained	from	robert/subsurfacetemplate/	in
the	same	directory	as	the	.tex	file.	The	file	can	then	be	processed	with	plain	TeX	(not	LaTeX),	for	example	by	running	pdftex	filename.tex	on	the	command	line.LaTeX.	Write	the	dive(s)	to	a	LaTeX	document	of	which	the	typesetting	is	done	automatically	using	TeX.	LaTeX	handles	page	content	and	layout	while	TeX	handles	typesetting.Image	depths,
which	creates	a	text	file	that	contains	the	file	names	of	all	photos	or	videos	attached	to	any	of	the	selected	dives	in	the	Dive	List,	together	with	the	depth	underwater	where	of	each	of	those	photos/videos	was	taken.When	the	"Anonymize"	option	is	selected	for	xml-based	file	formats,	the	letters	A-Z	are	all	replaced	by	the	letter	X	in	the	notes,	buddy,
divemaster,	divesite	name	and	divesite	description	fields.	This	way,	you	can	share	dive	log	files	for	debugging	purposes	without	revealing	personal	information.	Please	note,	though,	that	other	characters	are	not	replaced,	so	this	is	not	useful	for	languages	with	non-latin	characters	and	GPS	coordinates	of	dive	sites	are	preserved	as	well.HTML.	This
export	is	provided	by	selecting	the	appropriate	tab	at	the	top	of	the	panel.	The	dive(s)	are	stored	in	HTML	files,	readable	with	an	Internet	browser.	Most	modern	web	browsers	are	supported,	but	JavaScript	must	be	enabled.	The	HTML	export	cannot	be	changed	or	edited.	It	contains	most	of	the	information	recorded	in	the	dive	log.	However,	it	does
not	show	the	calculated	values	in	the	Dive	Profile	panel,	e.g.	dive	ceiling,	calculated	cylinder	pressure,	gas	pressures	and	MOD.	The	HTML	export	contains	a	search	option	to	search	the	dive	log.	HTML	export	is	specified	on	the	second	tab	of	the	Export	dialog	(image	B	above).	A	typical	use	of	this	option	is	to	export	all	your	dives	to	a	smartphone	or	a
tablet	where	it	would	serve	as	a	portable	record	of	dives,	useful	for	dive	companies	wishing	to	verify	the	dive	history	of	a	diver,	and	doing	away	with	the	need	to	carry	an	original	logbook	when	doing	dives	with	dive	companies.General	Settings,	under	the	HTML	tab,	provides	the	following	options:Subsurface	Numbers:	if	this	option	is	checked,	the
dive(s)	are	exported	with	the	numbers	associated	with	them	in	Subsurface,	Otherwise	the	dive(s)	will	be	numbered	starting	from	1.Export	Yearly	Statistics:	if	this	option	is	checked,	a	yearly	statistics	table	will	be	attached	to	the	HTML	exports.Export	List	only:	a	list	of	dives	only	(date,	time,	depth,	duration)	will	be	exported	and	the	detailed	dive
information,	e.g.	dive	profile,	will	not	be	available.Under	Style	Options	some	style-related	options	are	available	like	font	size	and	theme.Export	to	other	formats	can	be	done	through	third	party	facilities,	for	instance	www.divelogs.de.For	each	diver,	dive	log	information	is	highly	important.	Not	only	is	it	a	record	of	diving	activities	for	your	pleasure,	but
it’s	important	information	required	for	admission	to	training	courses	or	sometimes	even	diving	sites.	The	security	of	the	dive	log	is	critical.	To	have	a	dive	log	that	is	resistant	to	failure	of	a	home	computer	hard	drive,	loss	or	theft	of	equipment,	the	Cloud	is	an	obvious	solution.	This	also	has	the	added	benefit	that	you	can	access	your	dive	log	from
anywhere	in	the	world.	For	this	reason,	facilities	such	as	divelogs.de	and	Diving	Log	offer	to	store	dive	log	information	on	the	Internet.Subsurface	includes	access	to	a	transparently	integrated	cloud	storage	back	end	that	is	available	to	all	Subsurface	users.	Storing	and	retrieving	a	dive	log	from	the	cloud	is	no	more	difficult	than	accessing	the	dives	on
the	local	hard	disk.	The	only	requirement	is	that	you	should	first	register	as	a	user	on	the	cloud.	To	use	Subsurface	cloud	storage	,	follow	these	steps:Open	the	Cloud	Preferences	by	selecting	File	→	Preferences	→	Cloud.	(See	image	of	the	Clod	Preference	panel	here).In	the	section	headed	Subsurface	cloud	storage,	enter	an	email	address	that
Subsurface	can	use	for	user	registration.	This	is	the	only	step	that	requires	an	email	address.	Subsurface	will	never	use	this	email	address	again.Enter	a	novel	password	that	Subsurface	will	use	to	store	the	dive	log	in	the	cloud.	The	password	can	comprise	lower	case	letters,	numbers,	plus(+),	minus(-)	and	underscore(_).Click	Apply	to	send	the	above
email	address	and	password	to	the	(remote)	cloud	server.	The	server	responds	by	sending	a	verification	PIN	to	the	above	email	address	(This	is	the	only	occasion	that	Subsurface	uses	the	email	address	provided	above).	The	Cloud	Preferences	dialog	now	has	a	new	PIN	text	box,	not	visible	previously.Enter	the	PIN	in	the	corresponding	text	box	in	the
Cloud	Preferences	dialog	(this	field	is	only	visible	while	the	server	is	waiting	for	email	address	confirmation)Click	Apply	again.	The	Subsurface	cloud	storage	account	will	be	marked	as	verified	and	the	Subsurface	cloud	storage	service	is	initialized	for	use.Once	the	cloud	storage	has	been	initialized,	two	new	items	appear	in	the	File	menu	of	the	main
menu	system:	Open	cloud	storage	and	Save	to	cloud	storage.	These	options	let	you	load	and	save	data	to	the	Subsurface	cloud	storage	server.In	the	Dive	Log	Preferences	tab,	you	can	select	to	use	the	Subsurface	cloud	storage	data	as	the	default	data	file	by	checking	the	box	marked	Cloud	storage	default	file.	This	means	the	data	from	the	Subsurface
cloud	storage	is	loaded	when	Subsurface	starts	and	saved	there	when	Subsurface	closes.Subsurface	keeps	a	local	copy	of	the	data	and	the	cloud	facility	remains	fully	functional	even	if	used	while	disconnected	to	the	Internet.	Subsurface	simply	synchronizes	the	data	with	the	cloud	server	the	next	time	the	program	is	used	while	the	computer	is
connected	to	the	Internet.One	of	the	nice	side	benefits	of	using	Subsurface	cloud	storage	is	that	you	can	also	access	your	dive	data	from	any	web	browser.	Simply	open	,	log	in	with	the	same	email	and	password,	and	you	can	see	an	HTML	export	of	the	last	dive	data	that	was	synced	to	Subsurface	cloud	storage.	The	dive	information	shown	is	only	the
contents	of	the	recorded	dive	logs,	NOT	the	calculated	values	shown	in	the	Profile	panel,	including	some	cylinder	pressures,	deco	ceilings	and	O2/He/N2	partial	pressures.If	you	prefer	not	to	use	the	integrated	cloud	storage	of	dive	logs	(and	don’t	need	the	web	access),	it’s	simple	to	store	dive	logs	in	the	cloud	using	several	of	the	existing	facilities	on
the	Internet.	For	instance	Dropbox	offers	a	free	application	that	allows	files	on	the	Dropbox	servers	to	be	seen	as	a	local	folder	on	a	desktop	computer.The	Dropbox	program	creates	a	copy	of	the	Dropbox	Internet	Cloud	content	on	your	desktop	computer.	When	the	computer	is	connected	to	the	Internet,	the	Internet	content	is	automatically	updated.
Therefore	both	the	Open	and	Save	of	dive	logs	are	done	using	the	local	copy	of	the	dive	log	in	the	local	Dropbox	folder,	so	there’s	no	need	for	a	direct	internet	connection.	If	the	local	copy	is	modified,	e.g.	by	adding	a	dive,	the	remote	copy	in	the	Dropbox	server	in	the	Cloud	will	be	automatically	updated	whenever	Internet	access	is	available.A
frequent	need	is	for	two	or	more	persons	to	use	Subsurface	on	the	same	desktop	computer.	For	instance	members	of	a	household	may	use	the	same	computer	or	one	family	member	may	perform	dive	uploads	for	other	family	members/friends.	There	are	two	approaches	for	doing	this.A)	If	the	different	users	of	a	desktop	computer	do	not	log	onto	the
desktop/laptop	under	different	user	names	then	the	simplest	way	is	for	each	person	to	use	her/his	own	divelog	file	within	Subsurface.	In	this	case	John	would	work	with	the	Subsurface	file	johns-divelog	and	Joan	would	use	joans-divelog.	Select	the	appropriate	dive	log	by	selecting,	from	the	Main	Menu,	File	→	Open	logbook	and	then	select	your	own
dive	log	file	from	the	list	of	files	lower	down	in	the	menu.	However,	a	problem	arises	if	the	users	prefer	different	settings	for	Subsurface.	For	instance,	one	diver	may	prefer	to	see	the	dive	ceiling	in	the	Profile	Panel	and	media	icons	in	the	Dive	List,	while	the	other	may	not	have	these	preferences.	In	addition,	the	cloud	connection	is	normally	unique
for	each	Subsurface	installation	and	if	more	than	one	user	wishes	to	save	dive	data	on	the	cloud,	it	is	inconvenient	to	open	the	Preferences	and	change	the	user-ID	data	every	time	the	cloud	is	accessed.	To	solve	these	problems,	launch	Subsurface	with	a	--user=	command-line	option.	John	can	then	activate	Subsurface	with	this	command-line
instruction:while	Joan	can	launch	Subsurface	using:In	this	case,	each	user’s	preferences,	settings	and	cloud	access	information	are	stored	separately,	allowing	each	diver	to	interact	with	Subsurface	in	her/his	preferred	way	and	with	individual	cloud	access.	The	above	process	can	be	made	user-friendly	by	creating	a	link/shortcut	with	a	desktop	icon
that	executes	the	above	command-line	instruction.	Use	of	the	--user=	option	therefore	enables	each	user	to	create,	maintain	and	backup	a	separate	dive	log	within	a	personalized	user	interface.	This	way,	when	each	diver	launches	Subsurface,	it	opens	with	the	correct	dive	log	as	well	as	the	appropriate	display	and	backup	preferences,	and	each	diver
can	access	their	own	divelog	on	a	mobile	device	using	Subsurface-Mobile.B)	On	the	other	hand,	if	the	users	log	onto	the	same	computer	using	different	userIDs	and	passwords	(i.e.	users	each	have	a	separate	user	space),	Subsurface	is	available	independently	to	each	user	and	every	diver	automatically	has	a	separate	user	profile	and	settings,	including
unique	cloud	and	Subsurface-Mobile	access.Subsurface	provides	a	simple	and	flexible	way	to	print	a	whole	dive	log	or	only	a	few	selected	dives.	Pre-installed	templates	or	a	custom	written	template	can	be	used	to	choose	where	the	data	are	fitted	into	the	page.Some	decisions	need	to	be	made	before	printing:Should	the	whole	dive	log	be	printed	or
only	part	of	it?	If	only	part	is	required,	select	the	required	dives	from	the	Dive	List	panel.If	the	dive	profiles	are	printed,	what	gas	partial	pressure	information	should	be	shown?	Select	the	appropriate	toggle-buttons	on	the	button	bar	to	the	left	of	the	Dive	Profile	panel.If	File	→	Print	is	selected	from	the	Main	menu,	the	dialog	below	(image	A)	appears.
Three	specifications	are	needed	to	get	the	desired	information	and	page	layout:Under	Print	type	select	one	of	two	options:Dive	list	print:	Print	dives	from	the	Dive	List	panel	with	profiles	and	other	information.Statistics	print:	Print	yearly	statistics	of	the	dives.Under	Print	options	select:Printing	only	the	dives	selected	from	the	dive	list	before
activating	the	print	dialog	by	checking	the	box	Print	only	selected	dives.	If	this	check	box	is	not	checked	ALL	dives	in	the	Dive	List	panel	are	printed.Printing	in	color,	done	by	checking	the	box	with	Print	in	color.	If	this	check	box	is	not	checked,	printing	is	in	black	and	white.Under	Template	select	a	template	to	be	used	as	the	page	layout.	There	are
several	choices.	(see	image	B,	above).Table:	This	prints	a	summary	table	of	all	dives	selected	(see	below).Flow	layout:	Print	the	text	associated	with	each	dive	without	printing	the	dive	profiles	of	each	dive	(see	below):One	Dive:	Print	one	dive	per	page,	also	showing	the	dive	profile	(see	below)Two	Dives:	Print	two	dives	per	page,	also	showing	the	dive
profiles.Six	Dives:	Print	six	dives	per	page,	also	showing	the	dive	profiles.You	can	Preview	the	printed	page	by	selecting	the	Preview	button	on	the	dialog	(see	image	A	at	the	start	of	this	section).	After	preview,	you	can	change	the	options	in	the	print	dialog,	so	the	layout	fits	personal	taste.Next,	select	the	Print	button	(see	image	A	at	the	start	of	this
section).	This	activates	the	regular	print	dialog	used	by	the	operating	system,	letting	you	choose	a	printer	and	set	its	properties	(see	image	below):Set	the	print	resolution	of	the	printer	to	an	appropriate	value	by	changing	the	printer	Properties.	Finally,	select	the	Print	button	to	print	the	dives.	Below	is	a	(rather	small)	example	of	the	output	for	one
particular	page.Writing	a	custom	template	is	an	effective	way	to	produce	highly	customized	printouts.	Subsurface	uses	HTML	templates	to	render	printing.	You	can	create	a	template,	export	a	new	template,	import	an	existing	template	and	delete	an	existing	template	by	using	the	appropriate	buttons	under	the	Template	dropdown	list	in	the	print
dialog.	See	APPENDIX	E	for	information	on	how	to	write	or	modify	a	template.Subsurface	lets	you	configure	a	dive	computer.	Currently,	the	Heinrichs-Weikamp	(OSTC	2/2N/2C,	OSTC	3,	Sport)	and	Suunto	Vyper	(Stinger,	Mosquito,	D3,	Vyper,	Vytec,	Cobra,	Gekko	and	Zoop)	family	of	dive	computers	are	supported.	A	large	number	of	settings	of	these
dive	computers	can	be	read	and	changed	to	different	values.	To	begin,	be	sure	the	appropriate	hardware	driver	is	installed	for	the	dive	computer	(also	required	for	downloading	dives)	and	the	device	name	of	the	dive	computer	is	known.	See	APPENDIX	A	for	information	on	how	to	do	this.Once	the	dive	computer	is	connected	to	the	Subsurface
computer,	select	File	→	Change	settings	on	dive	computer	from	the	Main	Menu.	Select	the	appropriate	device	name	(or	mount	point)	in	the	dropdown	list	at	the	top	of	the	configuration	panel	and	select	the	appropriate	dive	computer	model	from	the	panel	on	the	left-hand	(see	image	below).Using	the	appropriate	buttons	on	the	configuration	panel,	the
following	actions	can	be	done:Retrieve	available	details.	This	loads	the	existing	configuration	from	the	dive	computer	to	Subsurface,	showing	it	in	the	configuration	panel.Save	changes	to	device.	This	changes	the	configuration	of	the	dive	computer	to	correspond	to	the	information	shown	in	the	configuration	panel.Backup.	This	saves	the	configuration
data	to	a	file.	Subsurface	asks	for	a	file	location	and	file	name	for	the	saved	information.Restore	backup.	This	loads	the	information	from	a	backup	file	and	displays	it	in	the	configuration	panel.Update	firmware.	If	new	firmware	is	available	for	the	dive	computer,	this	is	loaded	into	the	dive	computer.There	are	several	user-definable	settings	within
Subsurface,	found	by	selecting	File	→	Preferences,	mostly	affecting	the	way	in	which	Subsurface	shows	dive	information	to	the	user.	The	settings	are	in	twelve	panels:	Display,	Language,	Units,	Dive	Download,	Dive	log,	Equipment,	Media,	Tech	setup,	Georeference,	Cloud,	Network	and	Reset,	all	of	which	operate	on	the	same	principles:	specified
settings	can	be	applied	to	the	display	of	the	dive	log	by	selecting	Apply.	At	this	stage,	any	new	settings	only	apply	to	the	present	session	and	are	not	saved.	In	order	to	apply	new	settings	permanently,	select	the	Save	button.	If	you	do	not	wish	to	apply	the	new	preferences,	select	Cancel.These	settings	control	the	screen	display	of	Subsurface.Font	for
lists	and	tables:	Specify	the	font	type	and	font	size	of	the	tabular	data,	e.g.	Dive	Table	and	Cylinder:	decreasing	the	font	size	allows	one	to	see	more	information	on	a	screen.Animations:	Some	actions	in	showing	the	dive	profile	are	performed	using	animations.	For	instance,	the	axis	values	for	depth	and	time	change	from	dive	to	dive.	When	viewing	a
different	dive,	these	changes	in	axis	characteristics	do	not	happen	instantaneously,	but	are	animated.	The	Speed	of	animations	can	be	controlled	by	setting	this	slider	with	faster	animation	speed	to	the	left,	and	a	0	value	representing	no	animation	at	all.Choose	a	language	that	Subsurface	will	use.Check	the	System	Default	language	i.e.	the	language	of
the	underlying	operating	system	if	this	is	appropriate.	This	is	the	default	setting	in	Subsurface.	To	change	it,	uncheck	this	checkbox	and	pick	a	language	/	country	combination	from	the	list	of	locations.	The	Filter	text	box	to	list	similar	languages.	For	instance	there	are	several	system	variants	of	English	or	French.	This	particular	preference	requires	a
restart	of	Subsurface	to	take	effect.In	this	panel	also	specify	appropriate	date	and	time	formats	for	showing	dive	details.Choose	between	metric	and	imperial	units	of	depth,	pressure,	volume,	temperature	and	mass.	By	selecting	the	Metric	or	Imperial	radio	button	at	the	top,	you	can	specify	that	all	units	are	in	the	chosen	measurement	system.
Alternatively,	if	you	select	the	Personalize	radio	button,	units	can	be	selected	independently,	with	some	in	the	metric	system	and	others	in	imperial.Regardless	of	the	above	settings,	dive	time	measurements	can	be	either	in	seconds	or	minutes.	Choose	the	appropriate	option.	GPS	coordinates	can	be	represented	either	as	traditional	coordinates
(degrees,	minutes,	seconds)	or	as	decimal	degrees	Choose	the	appropriate	option.Subsurface	remembers	connections	that	are	made	with	dive	computers	for	downloading	dives,	shown	as	connection	buttons	in	the	Dive	download	panel.	This	enables	a	user	to	establish	a	previously-used	dive	computer	connection	by	simply	selecting	one	of	the
connection	buttons.	This	is	especially	useful	when	using	Bluetooth-equipped	dive	computers	that	need	to	establish	a	Bluetooth	connection	each	time	a	download	is	done.	However,	when	using	more	than	one	dive	computer,	several	connection	buttons	are	shown	and	this	can	be	confusing.	Delete	all	the	connection	buttons	by	selecting	the	button	marked
"Delete	all	dive	computer	connections'.	Clearing	the	connection	buttons	requires	that	when	the	next	download	is	done,	a	new	connection	needs	to	be	established	first.This	panel	controls	many	options	for	recording	information	in	the	log	and	for	displaying	the	log.Default	dive	log	file:	For	the	Default	Dive	Log	File	specify	the	directory	and	file	name	of
your	electronic	dive	log	book.	This	is	a	file	with	filename	extension	of	either	.xml	or	.ssrf.	When	launched,	Subsurface	will	automatically	load	the	specified	dive	log	book.	There	are	three	options:No	default	file:	When	checked,	Subsurface	does	not	automatically	load	a	dive	log	at	startup.Local	default	file:	When	checked,	Subsurface	automatically	loads	a
dive	log	from	the	local	hard	disk.	Specify	the	default	file	path	and	divelog	name	in	the	text	box.Cloud	storage	default	file:	When	checked,	Subsurface	automatically	loads	the	dive	log	from	the	cloud	device	that	was	initialized	using	the	_Cloud	tab	(see	below).Display	invalid	dives:	Dives	can	be	marked	as	invalid	(when	a	user	wishes	to	hide	dives	that
he/she	doesn’t	consider	valid	dives,	e.g.	pool	dives,	but	still	want	to	keep	them	in	the	dive	log).	This	controls	whether	those	dives	are	displayed	in	the	dive	list.Show	tools	for	recording	wave	height,	surge	and	chill	during	a	dive.	Some	divers	like	to	record	the	sea	conditions	during	a	dive.	Checking	this	checkbox	allows	these	tools	to	be	displayed	in	the
Information	tab	of	the	Info	panel.	The	tools	for	visibility	and	current	are	always	shown,	irrespective	of	whether	this	radio	button	has	been	checked	or	not.Allow	editing	of	water	salinity:	The	Information	tab	has	a	tool	for	displaying	the	water	salinity,	i.e.	the	type	of	water	dived	in	and	its	salinity.	In	the	case	of	manually-entered	dives,	editing	of	water
type	is	always	active.	In	some	cases	one	may	want	to	edit	the	water	type	of	a	dive	derived	from	a	dive	log.	For	instance	you	left	the	dive	computer	setting	as	"Salt	water"	while	actually	diving	in	an	inland	lake	with	fresh	water.	In	this	case	you	may	wish	to	edit	the	water	type	in	the	dive	log	and	change	it	to	Fresh	water.	Checking	this	checkbox	allows
editing	of	the	water	type	of	a	dive.	If	the	water	type	of	a	dive	differs	from	that	of	the	dive	computer	setting	during	the	dive,	a	warning	is	shown	to	alert	you.	This	does	not	indicate	an	error:	it	is	just	a	useful	indication	that	the	water	type	has	been	edited.	IMPORTANT:	Editing	the	water	type	does	not	change	the	information	of	depth,	partial	pressures
and	deco	ceiling	values	for	that	dive:	the	information	from	the	dive	computer	is	always	used.	However,	editing	the	water	type	gives	a	useful	indication	to	a	diver	of	what	the	water	type	really	was	during	the	dive.Show	mean	depth:	If	this	box	is	checked,	the	Dive	Profile	panel	contains	a	grey	line	that	shows	the	mean	depth	of	the	dive,	up	to	any	time
instant	during	the	dive.	Normally	this	is	a	u-shaped	line	indicating	the	deepest	mean	depth	just	before	ascent.This	tab	sets	some	default	values	relating	to	equipment.Default	cylinder:	From	the	dropdown	list,	select	the	default	cylinder	to	be	used	in	the	Equipment	tab	of	the	Notes	panel.	This	makes	it	quicker	to	enter	dive	equipment	specifications	in
the	Equipment	tab.Show	unused	cylinders:	Checking	this	checkbox	allows	showing	all	cylinders	entered	for	a	dive	in	the	Cylinder	Table	of	the	Equipment	tab,	even	if	one	or	more	cylinders	were	actually	not	used.This	tab	sets	some	defaults	relating	to	photos	or	videos	during	dives.Update	thumbnails:	Photographs	or	videos	are	sometimes	edited	after
being	uploaded	and	linked	to	Subsurface.	If	a	photo	is	therefore	more	recent	than	its	original	thumbnail,	checking	this	checkbox	allows	a	new	thumbnail	to	be	created	after	a	photo	or	video	has	been	edited.Video	thumbnails:	In	generating	thumbnails	for	videos	associated	with	dives,	Subsurface	needs	to	have	the	appropriate	information	(see	section
on	View	Images).	Three	preferences	need	to	be	set	as	explained	in	APPENDIX	F.	These	are:	a)	switch	on	thumbnails,	b)	specify	the	location	of	the	ffmpeg	program	and	c)	set	the	place	within	video	where	the	thumbnail	needs	to	be	obtained	from.This	tab	sets	common	variables	used	for	decompression	calculations	pertaining	to	technical	diving.Gas
pressure	display	setup.	Even	though	nitrogen	and	helium	pressures	are	also	included	here,	these	items	mainly	pertain	to	oxygen	management:Thresholds:	Subsurface	can	display	graphs	of	the	nitrogen,	oxygen	and	the	helium	partial	pressures	during	the	dive,	activated	using	the	toolbar	on	the	left	of	the	Dive	Profile	panel.	For	each	of	these	graphs,
specify	a	threshold	value.	If	any	of	the	graphs	go	above	the	specified	threshold,	the	graph	is	highlighted	in	red,	indicating	the	particular	partial	pressure	threshold	has	been	exceeded.	The	pO2	threshold	is	probably	the	most	important	one	and	a	value	of	1.6	is	commonly	used.pO2	in	calculating	MOD	is	used	for	calculating	the	maximum	operative	depth
for	a	particular	nitrox	or	trimix	gas	mixture.	A	value	of	1.4	is	commonly	used.CCR	Options:	These	options	determine	oxygen	management	for	CCR	dives:Dive	planner	default	setpoint:	Specify	the	O2	setpoint	for	a	CCR	dive	plan.	This	determines	the	pO2	maintained	during	a	particular	dive.	Setpoint	changes	during	the	dive	can	be	added	via	the	profile
context	menu.CCR:	Show	O2	sensor	values	when	viewing	pO2:	Show	the	pO2	values	associated	with	each	of	the	individual	oxygen	sensors	of	a	CCR	system.	See	the	section	on	Closed	Circuit	Rebreather	dives.CCR:	Show	setpoints	when	viewing	pO2:	With	this	checkbox	activated,	the	pO2	graph	on	the	dive	profile	has	an	overlay	in	red	which	indicates
the	CCR	setpoint	values.	See	the	section	on	Closed	Circuit	Rebreather	dives.pSCR	options.	These	preferences	determine	how	passive	semi-closed	circuit	(pSCR)	dives	are	planned	and	how	the	pSCR	deco	ceiling	is	calculated:Metabolic	rate:	this	is	the	volume	of	oxygen	used	by	a	diver	during	a	minute.	Set	this	value	for	pSCR	dive	planning	and
decompression	calculations.pSCR	ratio:	The	dilution	ratio	(or	dump	ratio)	is	the	ratio	of	gas	released	to	the	environment	to	that	of	the	gas	recirculated	to	the	diver.	A	1:10	ratio	is	commonly	used.Show	equivalent	OC	with	pSCR	pO2:	The	pO2	in	the	pSCR	loop	is	usually	lower	than	the	pO2	of	the	fresh	gas	from	the	cylinder.	Activating	this	checkbox
allows	the	pO2	graph	in	the	dive	profile	to	also	show	the	pO2	of	the	fresh	gas	entering	the	loop.Ceiling	display	setup.	These	settings	mostly	deal	with	nitrogen	and	helium	management	by	determining	how	the	decompression	ceiling	(ascent	ceiling)	is	calculated	and	displayed:Draw	dive	computer	reported	ceiling	red:	This	checkbox	does	exactly	what	it
says.	By	default	the	computer	reported	ceiling	is	shown	in	white.	Not	all	dive	computers	report	ceiling	values.	If	the	dive	computer	does	report	it,	it	may	differ	from	the	ceilings	calculated	by	Subsurface	because	of	the	different	algorithms	and	gradient	factors,	as	well	as	the	dynamic	way	a	dive	computer	calculates	ceilings	during	a	dive.Algorithm	for
calculating	ceiling.	Choose	between	the	Bühlmann	Z1H-L16	decompression	model	and	the	VPM-B	model:VPM-B:	Provide	a	conservatism	level	for	calculating	the	VPM-B	ceiling.	Values	between	0	(least	conservative)	and	4	(most	conservative)	are	valid.Bühlmann:	Set	the	gradient	factors	(GFLow	and	GFHigh)	for	calculating	the	deco	ceiling	following
the	ZH-L16	algorithm.	GF_Low	is	the	gradient	factor	at	depth	and	GF_High	is	used	at	the	surface.	At	intermediate	depths	gradient	factors	between	GF_Low	and	GF_High	are	used.	Gradient	factors	add	conservatism	to	nitrogen	and	helium	exposure	during	a	dive,	in	a	similar	way	that	many	dive	computers	have	a	conservatism	setting.	The	lower	the
value	of	a	gradient	factor,	the	more	conservative	the	calculations	are	with	respect	to	inert	gas	loading	and	the	deeper	the	ceilings	are.	Gradient	factors	of	20/60	are	considered	conservative	and	values	of	70/90	are	considered	harsh.	For	more	information	see:Understanding	M-values	by	Erik	Baker,	Immersed	Vol.	3,	No.	3.Gradient	factors	for	dummies,
by	Kevin	WattsSubsurface	provides	a	geo-lookup	service	(that	is,	given	the	coordinates	of	a	dive	site)	derived	from	a	click	on	the	Dive	Map	panel	at	the	bottom	right	of	the	Subsurface	window,	or	from	a	GPS	instrument	or	from	the	Subsurface-Mobile	app).	A	search	on	the	Internet	is	done	to	find	the	name	of	the	closest	known	location.	This	function
only	works	if	Subsurface	has	an	Internet	connection.	The	preference	of	the	dive	site	name	can	be	configured,	e.g.	Country/State/City	or	City/State/Country.These	setting	allow	storing	the	dive	log	in	the	digital	cloud.Subsurface	cloud	storage:	To	store	your	dive	log	in	the	cloud,	a	valid	email	address	and	password	are	required.	This	lets	Subsurface
email	security	information	regarding	cloud	storage	to	you,	and	to	set	up	cloud	storage	appropriately.	Detailed	instructions	for	registering	on	the	cloud	server	are	provided	in	the	Cloud	preference	panel	(see	above	image),	as	well	as	in	the	section	of	this	manual	dealing	with:	Keeping	a	Subsurface	dive	log	in	the	cloud.Save	password	locally:	This	allows
local	storage	of	the	cloud	storage	password.	Note	that	this	information	is	saved	in	raw	text	form,	not	encoded	in	any	way.This	panel	facilitates	communication	between	Subsurface	and	data	sources	on	the	Internet.	This	is	important,	for	instance,	when	Subsurface	needs	to	communicate	with	web	services	such	as	Cloud	storage,	or	when	you	want	to
communicate	through	a	proxy.Proxy	server:	A	proxy	server	is	a	computer	serving	as	a	link	between	a	user	and	the	Internet.	It	serves	to	protect	the	user	from	illegal	access	from	users	on	the	Internet	to	the	desktop	computer	of	the	user.	Proxy	servers	are	commonly	used	in	a	corporate	environment.	If	a	proxy	server	is	used	for	Internet	access,	the	type
of	proxy	needs	to	be	selected	from	the	dropdown	list,	after	which	the	IP	address	of	the	host	and	the	appropriate	port	number	should	be	provided.	If	the	proxy	server	uses	authentication,	the	appropriate	userID	and	password	are	required	so	that	Subsurface	can	automatically	pass	through	the	proxy	server	to	access	the	Internet.	This	information	is
usually	obtained	from	your	ISP	or	your	network	technician.Reset	all	preferences:	Selecting	the	button	in	this	panel	will	clear	all	the	preference	settings	in	Subsurface	and	set	them	to	default	values.	Since	there	are	many	settings,	this	is	an	action	that	is	not	lightly	done,	as	it	may	take	some	time	before	all	the	preferences	have	been	set	to	convenient
values	again.	Resetting	to	default	values	also	affects	Internet	and	cloud	access.This	brings	us	to	the	end	of	the	section	dealing	with	Subsurface	Preferences.Dive	planning	is	an	advanced	feature	of	Subsurface,	accessed	by	selecting	Log	→	Plan	Dive	from	the	main	menu.	It	allows	calculation	of	inert	gas	load	during	a	dive	by	using	the	Bühlmann	ZH-L16
algorithm	with	the	addition	of	gradient	factors	as	implemented	by	Erik	Baker,	or	using	the	VPM-B	model.Like	the	Subsurface	dive	log,	the	planner	screen	is	divided	into	several	sections	(see	image	below).	The	setup	parameters	for	a	dive	are	entered	into	the	sections	on	the	left	hand	and	bottom	side	of	the	screen.	They	are:	Available	Gases,	Rates,
Planning,	Gas	Options	and	Notes.At	the	top	right	hand	is	a	green	design	panel	on	which	the	profile	of	the	dive	can	be	manipulated	directly	by	dragging	and	clicking	as	explained	below.	This	feature	makes	the	Subsurface	dive	planner	unique	in	ease	of	use.At	the	bottom	right	is	a	text	panel	with	a	heading	of	Dive	Plan	Details.	This	is	where	the	details	of
the	dive	plan	are	provided	in	a	way	that	can	easily	be	copied	to	other	software.	This	is	also	where	any	warning	messages	about	the	dive	plan	are	printed.Towards	the	center	bottom	of	the	planner	(circled	in	blue	in	the	image	above)	is	a	dropdown	list	with	three	options.	Select	the	appropriate	one	of	these:Open	Circuit	(the	default)CCRpSCRChoose	the
Open	Circuit	option.In	the	top	left-hand	area	of	the	planning	screen,	be	sure	the	constant	dive	parameters	are	appropriate.	These	are:	Start	date	and	time	of	the	intended	dive,	Atmospheric	Pressure	and	Altitude	above	sea	level	of	the	dive	site.	The	atmospheric	pressure	can	also	be	entered	as	an	altitude	in	meters,	assuming	a	sea-level	atmospheric
pressure	of	1.013	bar.In	the	table	labelled	Available	Gases,	add	the	information	of	the	cylinders	to	be	used	as	well	as	the	gas	composition	within	that	cylinder.	This	is	done	in	a	similar	way	as	for	providing	cylinder	data	for	dive	logs.	Choose	the	cylinder	type	by	double	clicking	the	cylinder	type	and	using	the	dropdown	list,	then	specify	the	start
pressure	of	this	cylinder.	By	leaving	the	oxygen	concentration	(O2%)	field	empty,	the	cylinder	is	assumed	to	contain	air.	Otherwise	enter	the	oxygen	and/or	helium	concentration	in	the	boxes	provided	in	this	dialog.	Add	additional	cylinders	by	using	the	"+"	icon	to	the	top	right-hand	of	the	dialog.The	Available	Gases	table	includes	three	gas	depth
fields,	labelled:Deco	switch	at:	the	switch	depth	for	deco	gases.	Unless	overridden	by	the	user,	this	will	be	automatically	calculated	based	on	the	Deco	pO2	preference	(default	1.6	bar)Bot.	MOD:	the	gas	Maximum	Operating	Depth	(MOD)	if	it	is	used	as	a	bottom	mix.	Automatically	calculated	based	on	the	Bottom	pO2	preference	(default	1.4	bar).
Editing	this	field	will	modify	the	O2%	according	to	the	depth	set.	Set	to	'*'	to	calculate	the	best	O2%	for	the	dive	maximum	depth.MND:	the	gas	Maximum	Narcotic	Depth	(MND).	Automatically	calculated	based	on	the	Best	Mix	END	preference	(default	30m	/	98	ft).	Editing	this	field	will	modify	the	He%	according	to	the	depth	set.	Set	to	'*'	to	calculate
the	best	He%	for	the	dive	maximum	depth.	Depending	on	the	checkbox,	oxygen	is	considered	narcotic	(the	END	is	used)	or	not	(the	EAD	is	used).The	profile	of	the	planned	dive	can	be	created	in	two	ways:Drag	the	waypoints	(the	small	white	circles)	on	the	existing	dive	profile	to	represent	the	dive.	Additional	waypoints	can	be	created	by	double-
clicking	the	existing	dive	profile.	Waypoints	can	be	deleted	by	right-clicking	a	particular	waypoint	and	selecting	the	delete	item	from	the	resulting	context	menu.The	most	efficient	way	to	create	a	dive	profile	is	to	enter	the	appropriate	values	into	the	table	marked	Dive	planner	points.	The	first	line	of	the	table	represents	the	duration	and	the	final
depth	of	the	descent	from	the	surface.	Subsequent	segments	describe	the	bottom	phase	of	the	dive.	The	CC	setpoint	column	is	only	relevant	for	closed	circuit	divers.	The	ascent	is	usually	not	specified	because	this	is	what	the	planner	is	supposed	to	calculate.	Add	additional	segments	to	the	profile	by	selecting	the	"+"	icon	at	the	top	right	hand	of	the
table.	Segments	entered	into	the	Dive	planner	points	table	automatically	appear	in	the	Dive	Profile	diagram.Recreational	mode	is	intended	for	what	most	divers	would	call	"recreational",	"sports"or	"nontechnical"	dives,	remaining	within	no-deco	limits	(NDL).	It	computes	the	maximum	time	a	diver	can	stay	at	the	current	depth	without	needing
mandatory	decompression	stops	and	without	using	more	than	the	existing	gas	(minus	a	reserve).	The	planner	automatically	takes	into	account	the	nitrogen	load	incurred	in	previous	dives.	But	conventional	dive	tables	are	also	used	in	a	way	that	can	take	into	account	previous	dives.	Why	use	a	dive	planner	for	recreational	dives?	The	subsurface	dive
planner	provides	two	significant	advantages	over	the	use	of	recreational	dive	tables	for	dive	planning.Firstly,	using	recreational	dive	tables,	the	maximum	depth	of	each	previous	dive	is	taken	into	account.	But	few	dives	are	done	at	a	constant	depth	corresponding	to	the	maximum	depth	(i.e.	a	"square"	dive	profile).	This	means	dive	tables	overestimate
the	nitrogen	load	incurred	during	previous	dives.	The	Subsurface	dive	planner	calculates	nitrogen	load	according	to	the	real	dive	profiles	of	all	uploaded	previous	dives,	in	a	similar	way	as	dive	computers	calculate	nitrogen	load	during	a	dive.	This	means	that	the	diver	gets	credit,	in	terms	of	nitrogen	load,	for	not	remaining	at	maximum	depth	during
previous	dives,	so	a	longer	subsequent	dive	can	be	planned.	For	the	planner	to	work	it’s	therefore	crucial	to	log	previous	dives	in	Subsurface	before	doing	dive	planning.Secondly,	recreational	dive	tables	are	not	designed	to	build	additional	safety	features	into	a	dive.	NDL	times	derived	from	dive	tables	often	take	divers	close	to	the	limit	where
decompression	sickness	(DCS)	can	arise.	The	Subsurface	dive	planner	allows	a	diver	to	build	more	safety	features	into	a	dive	plan,	preventing	recreational	divers	from	getting	close	to	the	limits	of	getting	a	DCS	hit.	This	is	performed	by	specifying	appropriate	gradient	factors	for	a	dive	plan,	as	explained	below.To	plan	a	dive,	the	appropriate	settings
need	to	be	defined.Ensure	the	date	and	time	is	set	to	that	of	the	intended	dive.	This	allows	calculation	of	the	nitrogen	load	incurred	during	previous	dives.Immediately	under	the	heading	Planning	are	two	checkboxes	Recreational	and	Safety	Stop.	Check	these	two	boxes.Then	define	the	cylinder	size,	the	gas	mixture	(air	or	%	oxygen)	and	the	working
cylinder	pressure	in	the	top	left-hand	section	of	the	planner	under	Available	gases.The	planner	calculates	whether	the	specified	cylinder	contains	enough	air/gas	to	complete	the	planned	dive.	In	order	for	this	to	be	accurate,	under	Gas	options,	specify	an	appropriate	surface	air	consumption	(SAC)	rate	for	Bottom	SAC.	Suitable	values	are	between	15
l/min	and	30	l/min,	with	novice	divers	or	difficult	dives	requiring	SAC	rates	closer	to	30l/min.Define	the	amount	of	gas	the	cylinder	must	have	at	the	end	of	the	bottom	section	of	the	dive	just	before	ascent.	A	value	of	50	bar	is	often	used.	The	reason	for	this	reserve	gas	is	to	provide	for	the	possible	need	to	bring	a	buddy	to	the	surface	using	gas	sharing.
How	much	gas	is	used	in	sharing	depends	on	the	depth	of	the	ascent.	This	can	be	difficult	to	estimate,	so	most	agencies	assume	a	fixed	amount	of	gas,	or	actually	of	pressure	e.g.	40	or	50	bar	or	25%	or	33%	(rule	of	thirds).	But	Subsurface	can	do	better	because	it	knows	about	the	ascent	and	that	is	why	we	add	the	amount	of	gas	during	the
ascent.Define	the	depth	of	the	dive	by	dragging	the	waypoints	(white	dots)	on	the	dive	profile	or	(even	better)	defining	the	appropriate	depths	using	the	table	under	Dive	planner	points	as	described	under	the	previous	heading.	If	this	is	a	multilevel	dive,	set	the	appropriate	dive	depths	to	represent	the	dive	plan	by	adding	waypoints	to	the	dive	profile
or	by	adding	appropriate	dive	planner	points	to	the	Dive	Planner	Points	table.	Subsurface	will	automatically	extend	the	bottom	section	of	the	dive	to	the	maximum	duration	within	the	no-decompression	limits	(NDL).The	ascent	speed	can	be	changed.	The	default	ascent	speeds	are	those	considered	safe	for	recreational	divers.To	build	additional	safety
into	the	dive	plan	(over	and	above	those	of	recreational	dive	tables),	specify	gradient	factors	less	than	100%	(GFHigh	and	GFLow	under	the	Planning	heading	in	the	planner).	On	the	other	hand,	to	approximate	the	values	in	recreational	dive	tables,	set	the	gradient	factors	to	100.	By	reducing	the	values	of	GFHigh	and	GFLow	to	values	below	100,	one
can	build	more	safety	into	a	dive.	Decreasing	the	values	of	the	gradient	factors	below	100	will	shorten	the	duration	of	the	dive.	This	is	the	price	of	a	larger	safety	margin.	Reasons	for	using	gradient	factors	less	than	100	may	be	the	age	of	the	diver,	the	health	of	a	diver,	or	unusual	conditions	such	as	cold	water	or	strong	currents.	Realistic	conservative
values	for	the	gradient	factors	are	GFLow=40%	and	GFHigh=80%.	This	allows	you	to	create	a	custom	dive	plan,	suited	to	yourself	as	well	as	the	dive	conditions.Below	is	an	image	of	a	dive	plan	for	a	recreational	dive	at	30	meters	with	gradient	factors	of	100.	Because	the	no-deco	limit	(NDL)	is	22	minutes,	there	remains	a	significant	amount	of	air	in
the	cylinder	at	the	end	of	the	dive.The	dive	profile	in	the	planner	shows	the	maximum	dive	time	within	no-deco	limits	using	the	Bühlmann	ZH-L16	algorithm	and	the	gas	and	depth	settings	specified	as	described	above.	The	Subsurface	planner	allows	rapid	assessment	of	dive	duration	as	a	function	of	dive	depth,	given	the	nitrogen	load	incurred	during
previous	dives.	The	dive	plan	includes	estimates	of	the	amount	of	air/gas	used,	depending	on	the	cylinder	settings	specified	under	Available	gases.	If	the	start	cylinder	pressure	is	left	blank,	the	dive	duration	shown	is	the	true	no-deco	limit	(NDL)	without	taking	into	account	gas	used	during	the	dive.	If	the	surface	above	the	dive	profile	is	RED	it	means
that	recreational	dive	limits	are	exceeded	and	either	the	dive	duration	or	the	dive	depth	needs	to	be	reduced.Below	is	the	same	dive	plan	as	above,	but	with	a	safety	stop	and	reduced	gradient	factors	for	a	larger	safety	margin.Non-recreational	dive	planning	involves	exceeding	the	no-deco	limits	and/or	using	multiple	breathing	gases.	These	dives	are
planned	in	three	stages:a)	Nitrogen	management:	This	is	done	by	specifying	the	rates	for	descent	and	ascent,	as	well	as	the	deco	model	(GFLow,	GFHigh	or	Conservatism	level)	under	the	headings	Rates	and	Planning	to	the	bottom	left	of	the	planning	screen.	Two	deco	models	are	supported	the	Bühlmann	model	and	the	VPM-B	model.	Select	one	of	the
two	models.	When	selecting	the	Bühlmann	model,	the	gradient	factors	(GFHigh	and	GFLow	need	to	be	specified.	Initially,	the	GFHigh	and	GFLow	values	in	the	Tech	setup	preferences	panel	of	Subsurface	is	used.	If	these	are	changed	within	the	planner	(see	Gas	Options	within	the	planner),	the	new	values	are	used	without	changing	the	original	values
in	the	Preferences.	Gradient	Factor	settings	strongly	affect	the	calculated	ceilings	and	their	depths.	A	very	low	GFLow	value	brings	on	decompression	stops	early	during	the	dive.If	the	VPM-B	model	is	selected,	the	Conservatism_level	needs	to	be	specified	on	a	scale	of	0	(least	conservative)	to	4	(most	conservative).	This	model	tends	to	give	deco	stops
at	deeper	levels	than	the	Bühlmann	model	and	often	results	in	slightly	shorter	dive	durations	than	the	Bühlmann	model,	albeit	at	the	cost	of	higher	tissue	compartment	pressures	in	the	slow	tissues.	When	selecting	one	of	these	models,	keep	in	mind	they	are	NOT	exact	physiological	models	but	only	mathematical	models	that	appear	to	work	in
practice.Please	note	as	well	that	there	is	an	intrinsic	assumption	of	the	VPM-B	model	that	off-gassing	only	happens	during	the	ascent	phase	of	the	dive	(which	is	the	part	controlled	by	the	planner).	Thus	it	is	possible	to	get	misleading	results	if	you	manually	enter	waypoints	well	in	the	decompression	phase	of	your	dive.	This	is	particularly	relevant
when	editing	a	dive	read	from	disk	in	the	planner	since	that	will	have	waypoints	up	to	the	surface.	Thus	for	those	dives,	first	delete	all	waypoints	during	the	ascent	phase.	This	is	most	easily	done	by	holding	the	Ctrl-	or	Command-key	while	clicking	on	the	trash	can	icon	next	to	the	first	ascent	waypoint	in	the	table	on	the	left	hand	side.For	more
information	external	to	this	manual	see:The	ascent	rate	is	critical	for	nitrogen	off-gassing	at	the	end	of	the	dive	and	is	specified	for	several	depth	ranges,	using	the	mean	depth	as	a	yardstick.	The	mean	depth	of	the	dive	plan	is	shown	by	a	light	grey	line	on	the	dive	profile.	Ascent	rates	at	deeper	levels	are	often	in	the	range	of	8-12	m/min,	while	ascent
rates	near	the	surface	are	often	in	the	range	of	4-9	m/min.	The	descent	rate	is	also	specified.	If	the	option	Drop	to	first	depth	is	activated,	the	descent	phase	of	the	planned	dive	will	be	at	the	maximal	descent	rate	specified	in	the	Rates	section	of	the	dive	setup.b)	Oxygen	management:	In	the	Gas	Options	part	of	the	dive	specification,	the	maximum
partial	pressure	for	oxygen	needs	to	be	specified	for	the	bottom	part	of	the	dive	(bottom	po2)	as	well	as	for	the	decompression	part	of	the	dive	(deco	po2).	Commonly	used	values	are	1.4	bar	for	the	bottom	part	of	the	dive	and	1.6	bar	for	any	decompression	stages.	Normally,	a	partial	pressure	of	1.6	bar	is	not	exceeded.	The	depth	at	which	switching	to
a	gas	takes	place	can	be	edited	in	the	Available	Gases	dialog.	Normally,	the	planner	decides	on	switching	to	a	new	gas	when,	during	ascent,	the	partial	pressure	of	the	new	gas	has	decreased	to	1.6	bar.c)	Gas	management:	With	open-circuit	dives	this	is	a	primary	consideration.	Divers	need	to	keep	within	the	limits	of	the	amount	of	gas	within	the	dive
cylinder(s),	allowing	for	an	appropriate	margin	for	a	safe	return	to	the	surface,	possibly	sharing	with	a	buddy.	Under	the	Gas	Options	heading,	specify	the	best	(but	conservative)	estimate	of	your	surface-equivalent	air	consumption	(SAC,	also	termed	RMV)	in	liters/min	(for	the	time	being,	only	SI	units	are	supported).	Specify	the	SAC	during	the	bottom
part	of	the	dive	(bottom	SAC)	as	well	as	during	the	decompression	or	safety	stops	of	the	dive	(deco	SAC).	Values	of	15-30	l/min	are	common.	For	good	gas	management,	a	guess	is	not	sufficient	and	you	needs	to	monitor	gas	consumption	on	a	regular	basis,	dependent	on	different	dive	conditions	and/or	equipment.	The	planner	calculates	the	total
volume	of	gas	used	during	the	dive	and	issues	a	warning	if	you	exceeds	the	total	amount	of	gas	available.	Good	practice	demands	that	divers	not	dive	to	the	limit	of	the	gas	supply	but	that	an	appropriate	reserve	is	kept	for	unforeseen	circumstances.	For	technical	diving,	this	reserve	can	be	up	to	66%	of	the	total	available	gas.	In	addition	to	calculating
the	total	gas	consumption	for	every	cylinder	the	planner	provides	one	way	of	calculating	the	recommended	volume	of	bottom	gas	which	is	needed	for	safe	ascent	to	the	first	deco	gas	change	depth	or	the	surface.	This	procedure	is	called	the	"minimum	gas"	or	"rock	bottom"	consideration	and	it	is	used	by	various	(but	not	all)	technical	diving
organizations.	See	the	text	below	for	a	detailed	explanation.Now	you	can	start	the	detailed	time-depth	planning	of	the	dive.	Subsurface	offers	an	unique	graphical	interface	for	doing	planning.	The	mechanics	are	similar	to	hand-entering	a	dive	profile	in	the	dive	log	part	of	Subsurface.	Upon	activating	the	planner,	a	default	dive	of	depth	15	m	for	20
min	is	offered	in	the	blue	design	surface	in	the	top	right	hand	part	of	the	planner	window.	The	white	dots	(waypoints)	on	the	profile	can	be	dragged	with	a	mouse.	Create	more	waypoints	by	double-clicking	on	the	profile	line	and	ensuring	the	profile	reflects	the	intended	dive.	Drag	the	waypoints	to	represent	the	depth	and	duration	of	the	dive.	It	is
NOT	necessary	to	specify	the	ascent	part	of	the	dive	since	the	planner	calculates	this,	based	on	the	existing	settings.	If	any	of	the	management	limits	(for	nitrogen,	oxygen	or	gas)	are	exceeded,	the	surface	above	the	dive	profile	changes	from	BLUE	to	RED.Each	waypoint	on	the	dive	profile	creates	a	Dive	Planner	Point	in	the	table	on	the	left	of	the	dive
planner	panel.	Ensure	the	Used	Gas	value	in	each	row	of	that	table	corresponds	to	one	of	the	gas	mixtures	specified	in	the	Available	Gases	table.	Add	new	waypoints	until	the	main	features	of	the	dive	have	been	completed,	e.g.	the	bottom	time	segment	and	deep	stops	(if	these	are	implemented).	In	most	cases	Subsurface	computes	additional	way
points	in	order	to	fulfill	decompression	requirements	for	that	dive.	A	waypoint	can	also	be	moved	by	selecting	it	and	by	using	the	arrow	keys.	The	waypoints	listed	in	the	Dive	Planner	Points	dialog	can	be	edited	by	hand	in	order	to	get	a	precise	presentation	of	the	dive	plan.	In	fact,	it	is	sometimes	more	easy	to	create	the	whole	dive	profile	by	editing
the	Dive	Planner	Points	dialog.Show	any	changes	in	gas	cylinder	used	by	indicating	gas	changes	as	explained	in	the	section	hand-creating	a	dive	profile.	These	changes	should	reflect	the	cylinders	and	gas	compositions	defined	in	the	table	with	Available	Gases.	If	two	or	more	gases	are	used,	automatic	gas	switches	will	be	planned	during	the	ascent	to
the	surface.Cylinders	used	for	the	plan	need	to	be	entered	in	the	table	of	Available	gases.	In	the	column	Type	select	the	appropriate	cylinder	size	by	using	the	dropdown	list	that	appears	when	double-clicking	a	cell	in	this	column.	By	default,	a	large	number	of	sizes	are	listed,	and	a	new	cylinder	size	can	be	created	by	typing	this	into	the	text	box.	The
cylinder	size,	start	pressure	and	default	switch	depths	are	initialized	automatically.	Specify	the	gas	composition	(e.g.	helium	and	oxygen	content).	A	non-zero	value	in	the	"CC	setpoint"	column	of	the	table	of	dive	planner	points	indicates	a	valid	setpoint	for	oxygen	partial	pressure	and	that	the	segment	is	dived	using	a	closed	circuit	rebreather	(CCR).	If
the	last	manually	entered	segment	is	a	CCR	segment,	the	decompression	phase	is	computed	assuming	the	diver	uses	a	CCR	with	the	specified	set-point.	If	the	last	segment	(however	short)	is	on	open	circuit	(OC,	indicated	by	a	zero	set-point)	the	decompression	is	computed	in	OC	mode	and	the	planner	only	considers	gas	changes	in	OC	mode.Enter
dive	profile	segments	in	the	Dive	planner	points	table	by	providing	a	time	duration	for	a	segment	as	well	as	its	final	depth.	If	more	than	one	cylinder	is	used	during	the	dive,	ensure	that	the	appropriate	cylinder	is	selected	for	each	segment	of	the	dive	plan	by	double-clicking	the	cell	and	selecting	the	appropriate	cylinder	from	the	dropdown	list	in	the
Used	gas	column.	If	required,	insert	a	row	in	the	Dive	planner	points	table	by	adding	a	new	line	and	then	setting	the	Run	time	value	appropriately.	In	image	A	below,	a	segment	(using	an	EAN50	cylinder)	has	been	added	and	you	wish	to	use	this	gas	during	the	very	start	of	the	dive	(the	other	gas	is	not	breathable	at	the	surface).	Upon	pressing	Enter
on	the	keyboard,	that	segment	is	moved	to	the	top	of	that	table	and	the	plan	is	adjusted	automatically	to	take	into	account	this	new	segment	of	the	dive	plan	(image	B	below).Below	is	an	example	of	a	dive	plan	to	55m	using	Tx20/30	and	the	Bühlmann	algorithm,	followed	by	an	ascent	using	EAN50	and	using	the	settings	as	described	above.Once	the
above	steps	have	been	completed,	save	by	clicking	the	Save	button	towards	the	top	middle	of	the	planner.	The	saved	dive	plan	will	appear	in	the	Dive	List	panel	of	Subsurface.On	the	bottom	right	panel	of	the	dive	planner,	under	Dive	Plan	Details,	the	details	of	the	dive	plan	are	provided.	These	may	be	modified	by	checking	any	of	the	options	under	the
Notes	section	of	the	dive	planner,	immediately	to	the	left	of	the	Dive	Plan	Details.	If	a	Verbatim	dive	plan	is	requested,	a	detailed	sentence-level	explanation	of	the	dive	plan	is	given.	If	any	of	the	management	specifications	have	been	exceeded	during	the	planning,	a	warning	message	is	printed	underneath	the	dive	plan	information.If	the	option	Display
segment	duration	is	checked,	then	the	duration	of	each	depth	level	is	indicated	in	the	Dive	Plan	Details.	This	duration	INCLUDES	the	transition	time	to	get	to	that	level.	However,	if	the	Display	transition	in	deco	option	is	checked,	the	transitions	are	shown	separately	from	the	segment	durations	at	a	particular	level.Dive	plan	variations:	The	planner
has	a	check	box	Display	plan	variations.	By	checking	this	box,	the	planner	provides	information	about	a	dive	that	is	a	little	deeper	or	slightly	longer	than	the	planned	dive.	This	is	found	near	the	top	of	the	Dive	plan	details	where	the	dive	duration	is	indicated.	The	information	is	intended	to	be	used	if	it	is	necessary	to	modify	the	ascent	"on	the	fly"	in
the	case	of	unexpected	deviations	from	the	dive	plan	during	the	dive.	For	example,	if	it	says	"Runtime:	123min,	Stop	times	+	2:49	/m	+	1:30	/min"	this	means:	if	you	dive	deeper	than	planned,	you	should	add	almost	3	minutes	per	meter	you	go	deeper	to	your	decompression	(and	you	can	subtract	3	minutes	per	meter	that	you	stay	shallower).	If	you
overstay	your	bottom	time,	you	need	to	add	one	and	a	half	minutes	to	the	stops	for	each	minutes	you	overstay	and	similarly,	you	can	shorten	your	deco	time	by	one	and	a	half	minute	for	each	minute	you	stay	shorter.	These	variations	of	depth	and	time	are	based	on	the	last	manually	entered	segment	of	the	dive	(not	necessarily	the	deepest).	The
additional	minutes	should	be	distributed	over	the	different	stops	in	a	way	proportional	to	the	stop	length,	i.e.	add	more	of	the	additional	minutes	to	the	longer,	shallower	stops.	The	given	times	refer	to	the	duration	of	the	decompression	phase	and	do	not	include	the	extended	bottom	time!	This	way	of	altering	dive	plans	becomes	inaccurate	for	large
deviations	from	the	original	plan.	So	it	should	not	be	trusted	for	more	than	a	few	minutes	or	meters	of	deviations	from	the	planned	bottom	time.	Checking	this	option	creates	a	lot	of	additional	computation,	to	such	a	degree	that	the	planner	is	slower	than	otherwise.Minimum	gas	requirements:	The	planner	also	estimates	the	minimum	gas	pressure
required	for	safe	ascent	after	an	event	that	causes	the	dive	to	be	aborted.	The	calculation	assumes	that	in	worst	case	an	out	of	gas	(OoG)	situation	occurs	at	the	end	of	the	planned	bottom	time	at	maximum	depth,	requiring	additional	time	at	maximum	depth	to	solve	the	problem	and	forcing	the	buddy	pair	the	share	the	gas	of	one	diver.	In	addition	the
combined	SAC	of	both	divers	is	increased	by	an	estimated	factor	compared	to	the	SAC	of	a	single	diver	under	normal	conditions.	The	result	of	the	minimum	gas	calculation	for	the	bottom	gas	is	printed	to	the	planner	output.	There	are	two	selector	boxes	on	the	left	of	the	Dive	plan	details:SAC	factor.	This	is	an	estimate	of	the	degree	to	which	your	SAC
increases	if	a	critical	problem	arises	underwater,	e.g.	gas	sharing	or	entanglement.	Realistic	values	range	from	3	to	5,	reflecting	the	gas	use	of	two	divers	sharing	a	single	gas	cylinder	after	an	OoG	situation.Problem	solving	time.	This	is	an	estimate	of	how	long	you	would	take	to	solve	the	problem	before	starting	the	ascent	to	terminate	the	dive.	The
default	value	is	2	minutes.Using	the	above	information,	the	planner	then	estimates	what	the	minimum	bottom	gas	cylinder	pressure	needs	to	be	for	a	safe	ascent.	This	information	is	given	near	the	bottom	of	the	Dive	plan	details,	following	the	calculation	of	bottom	gas	used	during	the	dive	if	it	exactly	follows	the	plan.	the	minimum	gas	is	typically
given	as:Minimum	gas	(based	on	2.0xSAC/+1min@81m):	2130	l/90bar/Δ:+80barWithin	parentheses,	the	SAC	factor	and	Problem	solving	time	specified.The	number	of	liters	of	back	gas	required	for	a	safe	ascent	(2130	liters	in	the	example	above)The	number	of	bars	of	back	gas	required	for	a	safe	ascent	(90	bars	in	the	example	above).The	delta-value:
number	of	bars	of	back	gas	available	at	the	end	of	the	bottom	section	of	the	dive,	over	and	above	the	minimum	gas	requirement	(80	bars	in	the	above	example).	A	positive	delta	reflects	a	safe	plan;	a	negative	delta	indicates	insufficient	gas	for	a	safe	ascent.No	automatic	checks	are	performed	based	on	this	result.	The	feature	only	gives	valid	results	for
simple,	rectangular	shaped	single	level	dive	profiles.	For	multi	level	dives	one	would	need	to	check	every	leg	of	the	profile	independently.Isobaric	counterdiffusion	information:	For	gas	switches	during	the	ascent	in	hypoxic	open-circuit	trimix	dives	information	about	isobaric	counterdiffusion	(icd)	is	given	near	the	bottom	of	the	Dive	plan	details,	based
on	the	rule-of-fifths	(i.e.	during	a	gas	change,	the	increase	in	nitrogen	partial	pressure	should	not	exceed	one	fifth	of	the	corresponding	decrease	in	partial	pressure	of	helium).	For	each	gas	change,	two	lines	are	printed,	indicating	the	changes	in	gas	fractions	(%)	and	the	equivalent	changes	in	partial	pressures.	If	the	rule-of-fifths	is	not	met,	the
relevant	information	is	highlighted	in	red	and	a	warning	message	appears	at	the	bottom	of	that	table.	The	gas	change	events	on	the	dive	profile	also	provide	information	on	icd,	visible	at	the	bottom	of	the	Information	box	when	the	mouse	hovers	on	the	respective	gas	change	icon.	This	information	is	only	shown	for	gas	changes	relevant	with	respect	to
icd.	If	the	rule-of-fifths	is	not	met,	a	red	warning	exclamation	mark	is	shown	over	the	gas	change	icon.	When	relevant,	the	Information	box	contains	information	such	as:	ICD	ΔHe:-13%	ΔN₂+3%>2.6%.	This	means:	for	this	gas	change,	the	helium	decreased	with	13%	while	the	nitrogen	increased	with	3%	which	is	more	than	the	2.6%	maximum	increase
in	nitrogen	suggested	by	the	rule-of-fifths.To	plan	a	dive	using	a	passive	semi-closed	rebreather	(pSCR),	select	pSCR	rather	than	Open	circuit	in	the	dropdown	list.	The	parameters	of	the	pSCR	dive	can	be	set	by	selecting	File	→	Preferences	→	Tech	setup	from	the	main	menu,	where	the	gas	consumption	calculation	takes	into	account	the	pSCR	dump
ratio	(default	1:8)	as	well	as	the	metabolic	rate.	Specify	the	bottom	and	deco	SAC	rates.	Here	the	SAC	in	the	planner	is	the	volume	of	gas	per	minute	that	is	exhaled	into	the	loop	on	the	surface,	not	the	amount	of	gas	that	escapes	into	the	water.	The	calculation	takes	the	oxygen	drop	across	the	mouthpiece	of	the	rebreather	into	account.	If	the	pO2
drops	below	what	is	considered	safe,	a	warning	appears	in	the	Dive	plan	details.	A	typical	pSCR	cylinder	setup	is	very	similar	to	an	open	circuit	dive;	one	or	more	dive	cylinders,	possibly	with	different	bottom	and	decompression	gases,	including	gas	switches	during	the	dive	like	in	open	circuit	diving.	Therefore,	the	setup	of	the	Available	gases	and	the
Dive	planner	points	tables	are	very	similar	to	that	of	a	open	circuit	dive	plan,	described	above.	However,	no	oxygen	setpoints	are	specified	for	pSCR	dives.	Below	is	a	dive	plan	for	a	pSCR	dive.	The	dive	is	comparable	to	that	of	the	CCR	dive	below,	but	note	the	longer	ascent	duration	due	to	the	lower	oxygen	in	the	loop	due	to	the	oxygen	drop	across
the	mouthpiece	of	the	pSCR	equipment.Open	circuit	diving	is	often	part	of	a	pSCR	dive	because,	at	shallow	depths,	the	pO2	in	the	loop	is	often	too	low	for	breathing	and	the	shallow	parts	of	a	pSCR	dive	are	often	done	on	OC.	The	change	from	rebreather	mode	to	OC	or	vice	versa	is	indicated	using	bailout	events.	There	are	two	ways	to	plan	bailout	in
rebreather	dives:	1)	Check	the	Bailout	checkbox	in	the	Dive	mode	section	of	the	planner.	In	this	case,	bailout	requirements	will	be	calculated	starting	at	the	last	segment	of	the	dive	specified	in	the	Dive	planner	points	table.	2)	If	bailout	takes	place	at	another	point	in	the	dive	(see	example	of	cave	dive	below)	then	bailout	is	planned	by	manipulating	the
Dive	mode	column	of	the	Dive	planner	points	table.	The	image	on	the	left	shows	a	pSCR	dive	plan	(using	three	cylinders)	where	the	shallow	parts	of	the	dive	are	performed	using	EAN50	in	order	to	have	a	sufficient	pO2.	The	bottom	part	of	the	dive	is	performed	with	EAN31	(Cyl.	2	in	the	Available	gases	table,	also	indicated	in	the	Dive	planner	points
table).	The	third	cylinder,	also	EAN31,	is	a	bailout	cylinder	which	is,	initially,	not	used.	In	this	case	the	plan	is	for	a	cave	dive	with	a	bottom	time	of	20	minutes	and	the	turning	point	in	the	bottom	part	of	the	dive	is	at	16	minutes	(i.e.	ten	minutes	into	the	bottom	part	of	the	dive).	The	orange	pO2	graph	indicates	the	equivalent	OC	pO2	during	the	dive
and	the	green	pO2	indicates	the	estimated	pO2	in	the	loop,	the	whole	dive	being	performed	in	rebreather	mode.	We	wish	to	plan	for	a	worst-case	scenario	with	bailout	at	the	turning	point	(i.e.	the	furthest	point	into	the	cave).	In	the	Dive	planner	points	table,	change	the	Dive	mode	of	the	last	two	segments	to	OC	(indicated	in	the	left-hand	image,
labelled	A,	below).	In	this	case	the	existing	EAN31	cylinder	(Cyl.2	in	the	Dive	planner	points	table	is	used	for	bailout	(i.e.	the	bailout	cylinder	[Cyl.	3]	has	not	been	used	yet).	Note	that	the	pO2	graph	now	indicates	the	appropriate	pO2	values,	since	the	gas	breathed	now	has	the	pO2	of	an	OC	configuration.	In	order	to	switch	to	the	bailout	cylinder	(Cyl.
3),	indicate	this	by	selecting	the	appropriate	cylinder	in	the	Dive	planner	points	table	as	indicated	in	the	image	on	the	right,	below	(labelled	B).	The	icon	on	the	depth	profile	now	shows	an	overlapping	bailout	event	with	cylinder	change.	As	in	the	graph	on	the	left,	the	appropriate	pO2	values	are	shown	in	the	pO2	graphs.	The	volumes	of	gas	required
can	be	obtained	at	the	bottom	of	the	Dive	plan	details	panel.In	the	case	of	a	pSCR	dive	plan	for	open	water,	the	worst-case	scenario	is	probably	bailout	at	the	end	of	the	deepest	part	of	the	dive	and	this	could	be	achieved	using	the	Bailout	checkbox	of	the	planner.	Alternatively	create	a	1-minute	segment	at	the	end	of	the	deepest	part	of	the	dive	plan.
This	last	segment	(represented	by	the	bottom	row	of	the	Dive	planner	points	table)	is	then	manipulated	using	the	Dive	mode	and	Used	gas	columns,	as	in	the	cave	example,	above.	See	the	example	of	bailout	for	a	CCR	dive,	below,	that	uses	this	approach.To	plan	a	dive	using	a	closed	circuit	rebreather,	select	the	CCR	option	in	the	dropdown	list,
circled	in	blue	in	the	image	below.Available	gases:	In	the	Available	gases	table,	enter	the	cylinder	information	for	the	diluent	cylinder	and	for	any	bail-out	cylinders.	Do	NOT	enter	the	information	for	the	oxygen	cylinder	since	it	is	implied	when	the	CCR	dropdown	selection	is	made.Entering	setpoints:	Specify	a	default	setpoint	in	the	Preferences	tab,	by
selecting	File	→	Preferences	→	Tech	setup	from	the	main	menu.	All	user-entered	segments	in	the	Dive	planner	points	table	use	the	default	setpoint	value.	Then,	different	setpoints	can	be	specified	for	dive	segments	in	the	Dive	planner	points	table.	A	zero	setpoint	means	the	diver	bails	out	to	open	circuit	mode	for	that	segment.	Decompression	is
always	calculated	using	the	setpoint	of	the	last	manually	entered	segment.	So,	to	plan	a	bail	out	ascent	for	a	CCR	dive,	add	a	one-minute	dive	segment	to	the	end	with	a	setpoint	value	of	0.	The	decompression	algorithm	does	not	switch	deco-gases	automatically	while	in	CCR	mode	(i.e.	when	a	positive	setpoint	is	specified)	but	this	is	calculated	for	bail
out	ascents.If	you	want	the	setpoint	to	change	during	the	planned	ascent	at	a	specified	depth,	you	can	do	this	using	a	"fake"	cylinder	that	you	add	to	the	gas	list:	Give	that	cylinder	a	name	of	"SP	1.4"	(or	use	a	different	number)	and	set	the	"Deco	switch	value"	to	the	depth	at	which	you	want	to	set	the	new	setpoint.	This	will	make	the	planner	stop	at	the
specified	depth	and	use	the	new	setpoint	from	there	on.The	dive	profile	for	a	CCR	dive	may	look	something	like	the	image	below.Note	that,	in	the	Dive	plan	details,	the	gas	consumption	for	a	CCR	segment	is	not	calculated,	so	gas	consumptions	of	0	liters	are	the	norm.It	is	often	necessary	to	plan	for	a	worst-case	bailout	event	in	order	to	ensure
sufficient	bailout	gas	to	reach	the	surface,	taking	into	account	decompression.	This	is	done	by	1)	checking	the	Bailout	checkbox	of	the	dive	planner	(bailout	will	be	calculated	starting	at	the	last	segment	of	the	dive	specified	in	the	Dive	planner	points	table);	2)	defining	a	1-minute	segment	at	the	end	of	the	bottom	part	of	the	dive,	as	in	the	image	on	the
left	where	a	CCR	dive	to	40m	for	21	minutes	is	planned;	3)	changing	to	an	OC-gas	during	any	segment	in	the	Dive	planner	points	table.In	the	Dive	planner	points	table,	change	the	Dive	mode	of	this	1-minute	segment	to	OC.	This	signifies	bailout.	In	this	case	there	is	bailout	to	the	existing	diluent	cylinder	(assuming	this	cylinder	has	sufficient	gas).	The
appropriate	pO2	and	cylinder	pressure	graphs	are	shown	in	the	dive	profile,	as	in	the	image	on	the	left.	Note	that	the	setpoint	drops	to	zero	after	bailout,	since	this	value	does	not	apply	to	breathed	bailout	gas.In	order	to	plan	for	bailout	to	an	external	bailout	cylinder,	change	the	Used	gas	for	the	1-minute	segment	to	the	appropriate	cylinder,	as	in	the
example	on	the	left.	Note	that	the	cylinder	change	as	well	as	the	bailout	are	indicated	with	overlapping	icons.The	volumes	of	gases	required	for	bailout	can	be	found	at	the	bottom	of	the	Dive	plan	details	panel.Normally,	when	a	dive	plan	has	been	saved,	it	is	accessible	from	the	Dive	List,	like	any	other	dive	log.	Within	the	Dive	List	there	is	no	way	to
change	a	saved	dive	plan.	To	change	a	dive	plan,	select	it	on	the	Dive	List.	Then,	in	the	main	menu,	select	Log	→	Re-plan	dive.	This	will	open	the	selected	dive	plan	within	the	dive	planner,	allowing	changes	to	be	made	and	saved	as	usual.In	addition,	there	is	the	option	"Save	new".	This	keeps	the	original	planned	dive	and	adds	a	(possibly	modified,	-
earlier	dives	are	now	taken	into	account	-)	copy	to	the	dive	list.	If	that	copy	is	saved	with	the	same	start	time	as	the	original,	the	two	dives	are	considered	two	versions	of	the	same	dive	and	do	not	influence	other	each	during	decompression	calculation	(see	next	section).Repetitive	dives	can	easily	be	planned	if	the	dates	and	start	times	of	the	repetitive
dive	set	are	specified	appropriately	in	the	top	left-hand	Start	Time	field.	Subsurface	calculates	the	gas	loading	figures	and	the	affect	of	the	first	dive	is	evaluated	on	later	dives.If	you	have	just	completed	a	long/deep	dive	and	are	planning	another	dive,	then	highlight,	in	the	Dive	List,	the	dive	that	has	just	been	logged	then	activate	the	planner.
Depending	on	the	start	time	of	the	planned	dive,	the	planner	takes	into	account	the	gas	loading	during	the	completed	dive	and	plans	accordingly.If	only	a	few	standard	configurations	are	used	(e.g.	in	GUE),	then	a	template	dive	can	be	created	conforming	to	one	of	the	configurations.	If	you	want	to	plan	a	dive	using	this	configuration,	highlight	the
template	dive	in	the	Dive	List	and	activate	the	planner:	the	planner	takes	into	account	the	configuration	in	the	highlighted	dive.Selecting	the	Print	button	in	the	planner	allows	printing	of	the	Dive	Plan	Details	for	wet	notes.	You	can	also	cut	and	paste	the	Dive	Plan	Details	to	include	in	a	text	file	or	word	processing	document.However,	after	the	plan
has	been	saved,	it	is	represented	in	a	way	very	similar	to	a	dive	log	and	the	gas	calculations	cannot	be	accessed	in	the	same	way	as	during	the	planning	process.	The	only	way	to	print	the	dive	plan	is	to	use	the	File	→	Print	function	on	the	main	menu	in	the	same	way	as	for	dive	logs	or	by	copy	and	paste	to	a	word	processor.In	the	section	dealing	with
dives	using	more	than	one	dive	computer	we	discussed	the	way	in	which	multiple	profiles	for	a	single	dive	can	be	viewed	using	the	left-arrow	and	right-arrow	keyboard	keys.	A	similar	method	can	be	used	for	saving	a	dive	plan	with	the	profile	of	the	actual	dive,	once	this	has	been	uploaded	into	Subsurface.	In	order	to	do	this:Do	the	dive	planning	and
save	the	final	plan	in	the	Dive	List.After	diving,	upload	the	dive	data	from	the	dive	computer.Change	the	date	and	time	of	the	dive	plan	to	coincide	with	that	of	the	real-life	dive	from	the	dive	computer.In	the	Dive	List,	highlight	the	dive	plan	as	well	as	the	data	for	the	real	dive	and	merge	the	two	dives,	making	use	of	the	Dive	List	Context	Menu
(available	by	right-clicking	a	dive).The	text	version	of	the	dive	plan	is	appended	to	the	Notes	in	the	Notes	Tab.	With	this	merged	dive	highlighted	in	the	Dive	List,	switch	between	the	planned	profile	and	the	real-life	profile	using	the	right-arrow/left-arrow	keyboard	keys.Subsurface	can	be	launched	from	the	command-line	to	set	some	specialized
settings	or	as	part	of	an	script-based	automated	process	for	manipulating	a	dive	log.	The	format	for	launching	Subsurface	from	the	command-line	is:subsurface	[options]	[logfile	...]	[--import	logfile	...]Command-line	optionDescription--helpPrint	a	summary	of	the	command-line	options-hPrint	a	summary	of	the	command-line	options--import	logfileA	file
name	before	this	option	is	treated	as	an	existing	dive	log,	everything	after	is	imported	into	the	existing	dive	log--verbosePrint	debug	information	while	running	Subsurface-vPrint	debug	information	while	running	Subsurface-v	-vPrint	even	more	debug	information	while	running	Subsurface--versionPrints	the	current	version	of	Subsurface--user=Choose
the	configuration	space	of	user	--cloud-timeout=Set	the	timeout	for	cloud	connection	(0	<	duration	<	60).	This	enables	longer	timeouts	for	slow	Internet	connectionsThis	section	describes	the	functions	and	operation	of	the	items	in	the	Main	Menu	of	Subsurface.	Several	of	the	items	below	are	links	to	sections	of	this	manual	dealing	with	the
appropriate	operations.New	Logbook	-	Close	the	currently	open	dive	logbook	and	clear	all	dive	information.Open	logbook	-	Open	the	file	manager	to	select	a	dive	logbook	to	open.Save	-	Save	the	dive	logbook	currently	open.Save	as	-	Save	the	current	logbook	under	a	different	file	name.Open	cloud	storage	-	Open	the	dive	log	previously	saved	in	Cloud
storage.Save	to	cloud	storage	-	Save	the	current	dive	log	to	Cloud	storage.Cloud	storage	online	-	Switch	between	the	online	version	of	the	logbook,	and	the	locally	stored	one.Close	-	Close	the	dive	logbook	currently	open.Export	-	Export	the	currently	open	dive	logbook	(or	the	selected	dives	in	the	logbook)	to	one	of	several	formats.Print	-	Print	the
currently	open	logbook.Preferences	-	Set	the	Subsurface	preferences.Find	moved	media	-	If	photos/videos	taken	during	dives	have	been	moved	to	a	different	disk	or	directory,	locate	them	and	link	them	to	the	appropriate	dives.Change	settings	on	dive	computer	-	Edit	the	configuration	of	a	dive	computer.Quit	-	Quit	Subsurface.The	Edit	option	allows
one	to	undo	or	redo	an	action,	e.g.	deleting	dives.Add	Dive	-	Manually	add	a	new	dive	to	the	Dive	List	panel.Plan	Dive	-	Plan	dives.Edit	dive	in	planner	-	Edit	a	dive	plan	that	has	been	saved	into	the	Dive	List.Copy	dive	components	-	Copy	information	from	several	fields	of	a	dive	log	onto	the	clipboard.Paste	dive	components	-	Paste,	into	the	selected
dives	in	the	Dive	List,	the	information	copied	using	the	Copy	dive	components	option.Renumber	-	Renumber	the	dives	listed	in	the	Dive	List	panel.Auto	Group	-	Group	the	dives	in	the	Dive	List	panel	into	dive	trips.Edit	Device	Names	-	Edit	the	names	of	dive	computers	to	coordinate	your	logs.Filter	divelist	-	Select	only	some	dives,	based	on	specific	tags
or	dive	criteria.About	Subsurface	-	Show	a	panel	with	the	version	number	of	Subsurface	as	well	as	licensing	information.Check	for	updates	-	Find	out	whether	a	newer	version	of	Subsurface	is	available	on	the	Subsurface	web	site.User	manual	-	Open	a	window	showing	this	user	manual.The	operating	system	of	the	desktop	computer	needs	the
appropriate	drivers	in	order	to	communicate	with	the	dive	computer,	the	way	the	dive	computer	prefers	(e.g.	Bluetooth,	USB,	infra-red).On	Linux	users	need	to	have	the	correct	kernel	module	loaded.	Most	distributions	will	do	this	automatically,	so	the	user	does	not	need	to	load	kernel	modules.	However,	some	communication	protocols	require	an



additional	driver,	especially	for	rarely	used	technology	such	as	infra-red.On	Windows,	the	OS	should	offer	to	download	the	correct	driver	once	the	user	connects	the	dive	computer	to	the	USB	port	and	operating	system	sees	the	equipment	for	the	first	time.	In	some	instances	this	seems	to	fail,	but	regardless,	every	USB	device	(with	the	exception	of
HID	devices	like	the	Suunto	EON	Steel	family)	needs	a	driver.	For	many	divecomputer	this	means	downloading	a	cable	specific	driver	(these	tend	to	be	for	example	FTDI,	Silicon	Labs,	or	Prolific	drivers).	In	other	cases	(for	example	for	dive	computers	with	a	"real"	USB	interface	like	the	Atomics	Cobalt)	it	is	sufficient	to	have	the	WinUSB	(or	the
libusbK)	driver	installed.	In	current	Windows	versions	the	WinUSB	binary	is	already	part	of	Windows	and	the	"driver"	is	a	simple	inf	file	that	tell	Windows	to	use	the	WinUSB	driver.	But	it	still	needs	to	be	"installed".	Often	it	is	sufficient	to	install	the	dive	log	app	that	is	provided	by	the	dive	computer	vendor	to	trigger	the	driver	installation.	But	in
cases	where	that	doesn’t	work,	some	googling	to	find	the	correct	driver	for	a	specific	download	cable	may	be	necessary.On	a	Mac	users	sometimes	have	to	manually	hunt	for	the	correct	driver.	For	example	the	correct	driver	for	the	Mares	Puck	devices	or	any	other	dive	computer	using	a	USB-to-serial	interface	based	on	the	Silicon	Labs	CP2101	or
similar	chip	can	be	found	as	Mac_OSX_VCP_Driver.zip	at	the	Silicon	Labs	document	and	software	repository.When	connecting	a	dive	computer	by	using	a	USB	connector,	usually	Subsurface	will	either	propose	a	drop	down	list	with	the	correct	device	name	or	it	will	disable	the	device	select	drop	down	if	no	device	name	is	needed	at	all.	In	the	rare
cases	where	this	doesn’t	work,	here	are	some	ways	to	find	out	what	the	device	name	is:Simply	try	COM1,	COM2,	etc.	The	drop	down	list	should	contain	all	connected	COM	devices.The	drop	down	box	should	find	all	connected	dive	computers.There	is	a	definitive	way	to	find	the	port:Disconnect	the	USB	cable	from	the	dive	computerOpen	a
terminalType	the	command:	dmesg	and	press	enterPlug	in	the	USB	cable	of	the	dive	computerType	the	command:	dmesg	and	press	enterA	message	similar	to	this	one	should	appear:usb	2-1.1:	new	full	speed	USB	device	number	14	using	ehci_hcd	usbcore:	registered	new	interface	driver	usbserial	USB	Serial	support	registered	for	generic	usbcore:
registered	new	interface	driver	usbserial_generic	usbserial:	USB	Serial	Driver	core	USB	Serial	support	registered	for	FTDI	USB	Serial	Device	ftdi_sio	2-1.1:1.0:	FTDI	USB	Serial	Device	converter	detected	usb	2-1.1:	Detected	FT232BM	usb	2-1.1:	Number	of	endpoints	2	usb	2-1.1:	Endpoint	1	MaxPacketSize	64	usb	2-1.1:	Endpoint	2	MaxPacketSize	64
usb	2-1.1:	Setting	MaxPacketSize	64	usb	2-1.1:	FTDI	USB	Serial	Device	converter	now	attached	to	ttyUSB3	usbcore:	registered	new	interface	driver	ftdi_sio	ftdi_sio:	v1.6.0:USB	FTDI	Serial	Converters	DriverThe	third	line	from	the	bottom	shows	that	the	FTDI	USB	adapter	is	detected	and	connected	to	ttyUSB3.	This	information	can	now	be	used	in	the
import	settings	as	/dev/ttyUSB3	which	directs	Subsurface	to	the	correct	USB	port.Ensuring	the	user	has	write	permission	to	the	USB	serial	port:On	Unix-like	operating	systems	the	USB	ports	can	only	be	accessed	by	users	who	are	members	special	group	that	can	be	e.g.	dialout	or	uucp.	This	can	be	verified	by	listing	the	appropriate	device	permissions
e.g.	by	ls	-l	/dev/ttyUSB0.	Note	that	the	number	in	the	file	name	depends	on	how	many	USB	devices	you	have	connected,	and	must	be	adjusted	appropriately.	If	you	are	not	root,	you	may	not	be	a	member	of	that	group	and	won’t	be	able	to	use	the	USB	port.	Let	us	assume	your	username	is	johnB.As	root,	type:	usermod	-a	-G	dialout	johnB	(Ubuntu
users:	sudo	usermod	-a	-G	dialout	johnB)	This	makes	johnB	a	member	of	the	dialout	group.Type:	id	johnB	This	lists	all	the	groups	that	johnB	belongs	to	and	verifies	that	the	appropriate	group	membership	has	been	created.	The	dialout	group	should	be	listed	among	the	different	IDs.Under	some	circumstances	this	change	takes	only	effect	(e.g.	on
Ubuntu)	after	you	log	out	and	then	log	in	again.With	the	appropriate	device	name	(e.g.	dev/ttyUSB3)	and	with	write	permission	to	the	USB	port,	the	dive	computer	interface	can	connect	and	you	should	be	able	to	import	dives.For	dive	computers	communicating	through	Bluetooth	like	the	Heinrichs	Weikamp	Frog	or	the	Shearwater	Predator,	Petrel
and	Nerd	there	is	a	different	procedure	to	get	the	device’s	name	to	communicate	with	Subsurface.	Follow	these	steps:For	the	dive	computer,	after	enabling	Bluetooth,	be	sure	it	is	in	Upload	mode.For	Bluetooth	pairing	of	the	dive	computer,	refer	to	the	manufacturer’s	user	guide.	When	using	a	Shearwater	Predator/Petrel/Nerd,	select	Dive	Log	→
Upload	Log	and	wait	for	the	Wait	PC	message.Pair	the	Subsurface	computer	with	the	dive	computer.Bluetooth	is	most	likely	already	enabled.	For	pairing	with	the	dive	computer	choose	Control	Panel	→	Bluetooth	Devices	→	Add	Wireless	Device.	This	should	bring	up	a	dialog	showing	your	dive	computer	(which	should	be	in	Bluetooth	mode)	and
allowing	pairing.	Right	click	on	it	and	choose	Properties→	COM	Ports	to	identify	the	port	used	for	your	dive	computer.	If	there	are	several	ports	listed,	use	the	one	saying	"Outgoing"	instead	of	"Incoming".For	downloading	to	Subsurface,	the	Subsurface	drop-down	list	should	contain	this	COM	port	already.	If	not,	enter	it	manually.Note:	If	there	are
issues	afterwards	when	downloading	from	the	dive	computer	using	other	software,	remove	the	existing	pairing	with	the	dive	computer.Click	on	the	Bluetooth	symbol	in	the	menu	bar	and	select	Set	up	Bluetooth	Device….	The	dive	computer	should	then	show	up	in	the	list	of	devices.	Select	it	and	go	through	the	pairing	process.	This	step	should	only	be
needed	once	for	initial	setup.Once	the	pairing	is	complete,	the	correct	device	is	shown	in	the	Device	or	Mount	Point	drop-down	in	the	Subsurface	Import	dialog.Be	sure	Bluetooth	is	enabled	on	the	Subsurface	computer.	On	most	common	distributions	this	should	be	true	out	of	the	box	and	pairing	should	be	straightforward.	For	instance,	Gnome3	shows
a	Bluetooth	icon	on	the	right	of	the	toolbar	at	the	top	of	the	screen.	Users	have	reported	difficulties	with	some	Bluetooth	controllers.	If	you	have	an	onboard	controller,	try	that	first.	It	is	simplest	if	you	remove	any	USB	Bluetooth	dongles.	If	you	have	a	USB	dongle	that	came	with	your	dive	computer,	try	that	before	any	others.Setting	up	a	connection	to
download	dives	from	your	Bluetooth-enabled	device,	such	as	the	Shearwater	Petrel,	is	not	yet	an	automated	process	and	will	generally	require	the	command	prompt.	It	is	essentially	a	three	step	process.Enable	the	Bluetooth	controller	and	pair	your	dive	computerEstablish	an	RFCOMM	connectionDownload	the	dives	with	SubsurfaceEnsure	the	dive
computer	is	in	upload	mode.	On	the	Shearwater	Petrel,	Petrel	2	and	Nerd	cycle	through	the	menu,	select	Dive	Log,	then	Upload	Log.	The	display	will	read	Initializing,	then	Wait	PC	3:00	and	will	countdown.	Once	the	connection	is	established,	the	display	reads	Wait	CMD	…	and	the	countdown	continues.	When	downloading	the	dive	from	Subsurface,
the	display	reads	Sending	then	Sent	Dive.To	establish	the	connection,	establish	root	access	through	sudo	or	su.	The	correct	permission	is	required	to	download	the	dives	in	the	computer.	On	most	Linux	systems	this	means	becoming	a	member	of	the	dialout	group	(This	is	identical	as	for	many	dive	computers	using	a	Linux	USB	port,	described	in	the
previous	section).	On	the	command	terminal,	enter:sudo	usermod	-a	-G	dialout	usernameThen	log	out	and	log	in	for	the	change	to	take	effect.Attempt	to	set	up	the	Bluetooth	controller	and	pair	your	dive	computer	using	the	graphical	environment	of	the	operating	system.	After	setting	the	dive	computer	to	upload	mode,	click	the	Bluetooth	icon	in	the
system	tray	and	select	Add	new	device.	The	dive	computer	should	appear.	If	asked	for	a	password,	enter	0000.	Write	down	or	copy	the	MAC	address	of	your	dive	computer	-	this	needed	later	and	should	be	in	the	form	00:11:22:33:44:55.If	the	graphical	method	doesn’t	work,	pair	the	device	from	the	command	line.	Open	a	terminal	and	use	hciconfig	to
check	the	Bluetooth	controller	status.$	hciconfig	hci0:	Type:	BR/EDR	Bus:	USB	BD	Address:	01:23:45:67:89:AB	ACL	MTU:	310:10	SCO	MTU:	64:8	*DOWN*	RX	bytes:504	acl:0	sco:0	events:22	errors:0	TX	bytes:92	acl:0	sco:0	commands:21	errors:0This	indicates	a	Bluetooth	controller	with	MAC	address	01:23:45:67:89:AB,	connected	as	hci0.	Its	status
is	DOWN,	i.e.	not	powered.	Additional	controllers	will	appear	as	hci1,	etc.	If	there	is	not	a	Bluetooth	dongle	plugged	in	upon	booting	the	computer,	hci0	is	probably	the	onboard.	Now	power	on	the	controller	and	enable	authentication:sudo	hciconfig	hci0	up	auth+	(enter	password	when	prompted)	hciconfig	hci0:	Type:	BR/EDR	Bus:	USB	BD	Address:
01:23:45:67:89:AB	ACL	MTU:	310:10	SCO	MTU:	64:8	*UP	RUNNING	PSCAN	AUTH*	RX	bytes:1026	acl:0	sco:0	events:47	errors:0	TX	bytes:449	acl:0	sco:0	commands:46	errors:0Check	that	the	status	now	includes	UP,	RUNNING	AND	AUTH.If	there	are	multiple	controllers	running,	it’s	easiest	to	turn	off	the	unused	controller(s).	For	example,	for
hci1:Next	step	is	to	trust	and	pair	the	dive	computer.	On	distros	with	Bluez	5,	such	as	Fedora	22,	you	can	use	a	tool	called	blutootctl,	which	will	bring	up	its	own	command	prompt.bluetoothctl	[NEW]	Controller	01:23:45:67:89:AB	localhost.localdomain	[default]	[bluetooth]#	agent	on	Agent	registered	[bluetooth]#	default-agent	Default	agent	request
successful	[bluetooth]#	scan	on
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